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1 INn This Release

What’s New in Transports and Interfaces: Siebel Enterprise
Application Integration, Version 7.8, Rev. A

Table 1 lists changes described in this version of the documentation to support Release 7.8 of the
software.

Table 1. New Features in Transports and Interfaces: Siebel Enterprise Application Integration,
Version 7.8, Rev. A

Description

“Configuring Against IBM References to TIBCO have been removed from this section
WebSphere MQ” on page 75 and throughout the chapter.

What’s New in Transports and Interfaces: Siebel Enterprise
Application Integration, Version 7.8
Table 2 lists changes described in this version of the documentation to support Release 7.8 of the

software.
Table 2. New Features in Transports and Interfaces: Siebel Enterprise Application Integration,
Version 7.8
Topic Description
“Enabling Authentication and Security enhancements added for use with the Siebel Java
Authorization for the EAlI JMS Message Service Transport.

Transport” on page 73

“Detailed Input and Output Information about input and output arguments for the EAI
Specifications” on page 59 JMS Transport added to the guide.
Transports and Interfaces: Siebel Enterprise Application Integration 9
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2 )rts and Interfaces

Siebel Enterprise Application Integration (EAI) provides mechanisms for exchanging data between
Siebel Business Applications and external systems.

This chapter includes the following topics on these mechanisms:

B “About EAI Transports” on page 11

B “Using Named Subsystems for Transport Parameters” on page 13
B “About Object Interfaces and EAI” on page 17
|

“Database Level Interfacing” on page 18

About EAIl Transports

Transports allow Siebel applications to exchange data with external applications using standard
technologies for both synchronous and asynchronous communication protocols.

Transports handle all data as binary data, because the IsTextData parameter that was available in
previous releases is no longer supported. If you want to use character conversion on the transport,
you use the CharSetConversion parameter. Handling the data as binary defers any character set
conversion until needed and avoids conversion at the transport level to prevent data corruption. For
example, treating a UTF-8 XML as text when the conversion executes leads to an XML string in the
local code page, while its header still describes UTF-8. You should treat all self-describing data
including XML as binary.

Character conversion argument is available in a number of business services. These business
services are:

B EAI Transport business services (MQ Series, DLL, File, HTTP, MSMQ)

B XML Converter business services

B Transcode business service

When business services are invoked from a workflow process, the valid set of encodings is controlled
by a picklist. If the business services are invoked through scripting or similar mechanisms, the
character set name is supplied textually.

NOTE: For data validation or conversion from one encoding to another, you can use the Transcode
business service if needed. For details on the Transcode business service, its method and supported
character sets, see the Global Deployment Guide.

Transports and Interfaces: Siebel Enterprise Application Integration 11
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EAI Transports and Interfaces Overview i About EAI Transpo

Transports provide connectivity to virtually any communication protocol that can represent data as
text or binary messages, including MQSeries from IBM, MSMQ from Microsoft, and HTTP. EAI
Transports allow Siebel Business Applications to integrate with Web-based applications as well as
legacy systems that are encapsulated using middleware. Transports are interchangeable. If you
change technologies at any point, you can reuse existing workflow processes and logic by switching
the transport adapter.

Transports can:

Support bidirectional exchange of messages.

Run within the Siebel Object Manager.

Invoke and be invoked by Workflow Process Manager and EAI Dispatch Service.

Be invoked within an eScript or VBScript.

Send and receive messages in XML format.
Pass messages through, or convert messages into, property sets for XML and MIME messages.
Available transports include:

B EAI MQSeries Server Transport. For information on these transports, see Chapter 3, “EAI
MQSeries Transport.”

EAl MSMQ Transport. For information on this transport, see Chapter 4, “EAl MSMQ Transport.”
EAI HTTP Transport. For information on this transport, see Chapter 7, “EAl HTTP Transport.”

EAIl DLL Transport and EAI File Transport. For information on these transports, see Chapter 8,
“EAIl DLL and EAI File Transports.”

NOTE: EAlI MQSeries Server Transport, EAl MSMQ Transport, and EAI File Transport business
services are not re-entrant. For more information on transport re-entrance, see “About the EAI
MQSeries Transport Re-Entrance” on page 25.

About Transport Methods

The method on a transport adapter’s business service controls the action to be performed by the
transport. There are two outbound methods and three inbound methods available for EAl Transports.
Not every method is available on every transport.

For each method, there are a number of common parameters, as shown on Table 4 on page 16, as
well as transport-specific parameters that are discussed in the respective chapter for each transport.

Outbound Methods for a Transport Business Service

Available outbound methods depend on the transport business service in use, such as EAl MSMQ
Transport. The business service sends messages from the Siebel application using the appropriate
communications protocol, such as MQSeries, MSMQ, HTTP, and so on. There are two outbound
methods that you use to send requests from a Siebel application to another application:

12 Transports and Interfaces: Siebel Enterprise Application Integration
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Parameters

B Send. Sends a message from a Siebel application when the Siebel application does not need a
response. This is an asynchronous request method (with the exception of the EAlI HTTP Transport,
which expects a correct HTTP response), because the Siebel application does not need to wait
for a response before continuing with the process.

B Send and Receive. Sends a message from the Siebel application when the Siebel application
needs to receive a response before continuing. This is a synchronous request and response
method, because it requires a response before the Siebel application can continue.

Inbound Methods for a Transport Business Service

Available inbound methods depend on the transport business service in use, such as EAl MSMQ
Transport. The inbound methods monitor a specified queue and upon receipt of a message, dispatch
it to another service.

There are three inbound methods that can be used to receive requests from another application:

Receive Receives an inbound request message and returns it to the caller of the
transport.

Receive and Execute Receives an inbound request message and calls another service with the

(ReceiveDispatch) inbound message as input. This called service is known as the Dispatch

Service, and the method that is called is known as the Dispatch Method.

Receive, Execute, Send This is a request/response method. It receives an inbound request

(ReceiveDispatchSend) message, calls another service with the inbound message as input, and
then sends the output of the called service as a response. To suppress
the response, you can create an output property, on the dispatch
service, of type EmptyResponse and set it to True.

NOTE: There are server components (called receivers) on top of the inbound methods that run as
Siebel Server tasks. When running an EAI receiver such as the SAP IDOC Receiver, MQSeries Server,
or MSMQ Receiver—using the methods ReceiveDispatch or ReceiveDispatchSend—if the dispatch
service has an error, the receiver shuts down. Check the Status column on the Component Tasks for
details about the cause of the error.

Using Named Subsystems for Transport
Parameters

Named subsystems are groupings of defined enterprise parameters that are stored in the Siebel

Gateway Name Server. You use named subsystems to specify methods and parameters for EAI
Transports. Transport business services take two subsystem names as parameters, which you define
using the Siebel Server Manager:

B Transport Connection Subsystem (ConnectionSubsystem)

B Transport Data Handling Subsystem (DataHandlingSubsystem)

Transports and Interfaces: Siebel Enterprise Application Integration 13
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Parameters

Values for parameters in a named subsystem are common to every user of the subsystem across the
enterprise. Subsystem names themselves are parameters for server components. You can logically
group parameters into various subsystems.

For the two EAI Transport named subsystem parameters, ConnectionSubsystem and
DataHandlingSubsystem, two parameters exist for the EAI receivers—
ReceiverConnectionSubsystem and ReceiverDataHandlingSubsystem. The EAI Receiver looks up
these parameters from the server component parameters and copies the corresponding properties
(ConnectionSubsystem and DataHandlingSubsystem) to the input property set of the transport
business service.

NOTE: Parameters specified in business service user properties no longer work as is. You need to
create named subsystems and specify the parameters for the subsystems. Then, you need to specify
the named subsystems you created as business service user properties in a workflow or through an
eScript, or the other usual means. Note that business service user properties work for the SAP
Connector and the Oracle Connector business services.

Rules of Precedence for Parameter Specification

You can specify the two named subsystem parameters, Connection Subsystem and Data Handling
Subsystem, as either business service user properties or as run-time arguments. If you specify the
parameters in both locations, the business service user property takes precedence over the run-time
arguments.

NOTE: For additional information on named subsystems, see the Siebel System Administration
Guide.

You specify every other parameter in one of the two named subsystems or as run-time arguments.
Siebel EAI looks for the parameter in the ConnectionSubsystem or the DataHandlingSubsystem,
depending on which parameter it is. If you specified the appropriate named subsystem, Siebel EAI
will always look for the parameter there.

If you do not specify the parameter in this named subsystem, even if you specified it as a run-time
argument, the run-time specification will be ignored. Siebel EAI looks for the parameter in a run-
time specification only if no appropriate named subsystem is specified.

14 Transports and Interfaces: Siebel Enterprise Application Integration
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s Overview & Using Named Subsystems for Transport
Parameters

Common EAI Transport Parameters

To configure the EAI Transports, you need to create named subsystems for data handling and
connection parameters, as presented in Table 3. The data handling parameters are presented in
Table 4. These parameters are common to every Transport method. After you create the named
subsystems, you then need to specify these named subsystems as parameters in the service method
argument or the business service user property.

Table 3. Dispatch Parameter Usage

When You Need to...

Use This Parameter...

...call any Business Service

DispatchService. This parameter must be used in
conjunction with DispatchMethod.

...call any Business Service

DispatchMethod. This parameter must be used in
conjunction with DispatchService.

...call the Dispatch Rule Set Business
Service

DispatchRuleSet.

...call any Workflow

DispatchWorkflowProcess.

Transports and Interfaces: Siebel Enterprise Application Integration 15
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Parameters

Table 4. Common Data Handling Parameters for Transport Methods

Parameter Name Description

CharSetConversion

I Defaultis None. The default value for this parameter should be
used for self-describing content such as XML and MIME.

I CharSetConversion specifies if and how a character set
conversion needs to occur before or after sending or receiving
data from the external system. Legal values are None, UTF-8,
and UTF-16.

When used with a Receive method, CharSetConversion implies
that the external data being read is in whatever charset
specified by this setting and must be converted to String.
Therefore, the output <Value> is a String whenever
CharSetConversion is specified. If no CharSetConversion is
specified, the output <Value> is in binary and retains its
original encoding.

When used with a Send method, CharSetConversion defines
the character set for the output data. The data in <Value> is
converted to the character set specified by CharSetConversion.

Depending on the value of this parameter, transport business
services do implicit character set conversions, if necessary. Note
that same CharSetConversion is assumed for requests and
responses.

ConverterService

Default is EAl XML Converter. This is the name of the business
service to use for serializing property sets to a buffer and
unserializing buffers to property sets. This parameter receives
arguments through business service user properties if the
converter service can accept them. Note that not any arbitrary
service may be designated to be a converter service.

DispatchMethod

DispatchMethod parameter specifies the dispatch method.
Specification of DispatchService is mutually exclusive with
specification of a DispatchRuleSet or a DispatchWorkflowProcess.
This parameter is only applicable for the ReceiveDispatch and
ReceiveDispatchSend methods.

DispatchRuleSet

DispatchRuleSet specifies the name of the dispatch rule set for the
Dispatcher Service. Specification of DispatchRuleSet is mutually
exclusive with specification of DispatchWorkflowProcess or
Dispatch Service. This parameter is only applicable for the
ReceiveDispatch and ReceiveDispatchSend methods.

DispatchService

DispatchService specifies the dispatch service. Specification of
DispatchService is mutually exclusive with specification of a
DispatchRuleSet or DispatchWorkflowProcess. This parameter is
only applicable for the ReceiveDispatch and ReceiveDispatchSend
methods.
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Table 4. Common Data Handling Parameters for Transport Methods

Parameter Name Description

DispatchWorkflowProcess DispatchWorkflowProcess specifies the name of the workflow
process to dispatch to. Specification of DispatchWorkflowProcess is
mutually exclusive with specification of DispatchRuleSet or
Dispatch Service. This parameter is only applicable for the
ReceiveDispatch and ReceiveDispatch Send methods.

IgnoreCharSetConvErrors Default is False. This parameter specifies whether character set
conversion errors should be ignored. If False, with any such errors,
the transport service propagates the error.

Impersonate Default is False. This parameter indicates whether or not the
receiver will execute the incoming request using the default
credentials of the receiver or those provided in the incoming XML
document. If this parameter is set to True, the receiver will
introspect the incoming XML document (<SiebelMessage>
element) for the eaiusername and eaipassword credential
attributes. If these credentials are found, the receive will attempt
to relogin with the credential. If the Impersonate parameter is set
to True and the credentials are not found or are not a valid Siebel
username or password, an error message will be returned.

RollbackOnDispatchError Default is True. This parameter indicates whether or not to roll
back transport transaction if a Dispatch Method fails. This
parameter is only available for the transactional transports
MQSeries Server and MSMQ.

SiebelTransactions Default is True. This parameter indicates whether or not to nest the
Siebel transaction within the transport transaction. This parameter
is only available for the transactional transports MQSeries Server
and MSMQ. If this parameter is set to False, the transaction
support is turned off at the transport level. This setting means that
if the transaction fails, then there will not be a rollback at the
Siebel transaction level.

About Object Interfaces and EAI

Object Interfaces allow integration between the Siebel application and external applications. Object
Interfaces can be called by eScripts and VB or used within a workflow. The workflow can use other
business services and transports as needed. For example, the BizTalk Adapter might use MSMQ
Transport as part of its workflow.

Available object interface support includes:

B Siebel Business Applications as a Microsoft OLE DB Provider. For information, see Chapter 9,
“Using Siebel OLE DB Provider.”

B Siebel Business Applications interfacing with Microsoft BizTalk. For information, see Chapter 10,
“Interfacing with Microsoft BizTalk Server.”

Transports and Interfaces: Siebel Enterprise Application Integration 17
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B Siebel Business Applications that produce Java Data Beans to support J2EE applications. For
information, see Chapter 11, “Integrating with Java.”

Database Level Interfacing

In addition to Transports and Object Interfaces, Siebel applications provide Enterprise Integration
Manager (EIM) for high-volume data exchange and batch loading. You use the set of interface tables
that serve as intermediate tables between your external data source and the Siebel Database.

NOTE: See the Siebel Enterprise Integration Manager Administration Guide for details.

Transports and Interfaces: Siebel Enterprise Application Integration
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3 S Transport

This chapter discusses the Siebel EAl MQSeries Transport and includes the following topics:
B “About Siebel EAl MQSeries Transport” on page 19
B “About Message Id Tracking for an Inbound Message” on page 26

B “Invoking a Workflow Process Using MQSeries Server Receiver” on page 26

About Siebel EAl MQSeries Transport

This section assumes that you understand the architecture and operation of IBM MQSeries. Siebel
EAI provides the EAl MQSeries Server Transport that uses the Message queuing APl (MQI). For more
information, consult the IBM MQSeries documentation.

NOTE: The Siebel business service EAl MQSeries Transport, which was provided in Siebel 6.x
releases, is not available in the Siebel 7.x release. Customers of previous Siebel versions using the
name EAl MQSeries Transport should upgrade their workflows to use the EAl MQSeries Server
Transport name.

EAl MQSeries Transport Named Subsystem

The EAl MQSeries Transport can read parameters from a named subsystem. For the EAl MQSeries
Server Transport, the named subsystem type is MgSeriesServerSubsys.

Following is an example of the EAl MQSeries Server Transport and the commands to create a named
subsystem and start a receiver.

create named subsystem MyMgSrvrSubsys for subsystem MQSeriesServerSubsys with
MgPhysicalQueueName=Receiver ,MqRespPhysicalQueueName=Sender ,MgQueueManagerName=myQ
ueueMgr

create named subsystem SiebelEcho for subsystem EAlTransportDataHandlingSubsys with
DispatchService="Workflow Utilities",DispatchMethod=ECHO

start task for comp MgSeriesSrvRcvr with
ReceiverConnectionSubsystem=MyMgSrvrSubsys,ReceiverDataHandl ingSubsystem=SiebelEch
0,ReceiverMethodName=ReceiveDispatchSend

B For a discussion of named subsystems for Siebel EAIl, see Chapter 2, “EAIl Transports and
Interfaces Overview.”

B For more information on named subsystems, see the Siebel System Administration Guide.

Transports and Interfaces: Siebel Enterprise Application Integration 19
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About the EAl MQSeries Server Transport

Before using the EAl MQSeries Server Transport, you need to install and configure IBM MQSeries
software. Contact your IBM sales representative for details.

Configuring the EAI MQSeries Server Transport

The Siebel EAl MQSeries Server Transport is designed to provide a messaging solution to help you
integrate data between Siebel Business Applications and external applications that can interface with
the IBM MQSeries. The EAl MQSeries Server Transport transports messages to and from IBM
MQSeries queues.

NOTE: The EAl MQSeries Server Transport can connect only to IBM MQSeries Server software. The
IBM MQSeries server must be running on the same system with your Siebel Server.

The EAl MQSeries Server Transport supports the inbound and outbound methods described in the
“Outbound Methods for a Transport Business Service” on page 12 and “Inbound Methods for a Transport
Business Service” on page 13.

Using the SendReceive Method with MQSeries

The SendReceive method on the EAI MQSeries Server Transport sends a message and waits for a
response from the target application on a response queue. This response message corresponds to
the original message using the correlation ID in MQSeries.

NOTE: It is the responsibility of the external application to set the correlation ID of the response to
the Siebel Business Application to the message ID of the original message.

Using the EAI MQSeries Server Transport on AlX

When you use the EAlI MQSeries Server Transport on AlX, the shared memory segment required by
the EAI MQSeries Server process can collide with the shared memory segment required by the queue
manager. By default, the EAl MQSeries queue manager tries to use shared memory segment number
8. The EAIl MQSeries Server Transport does not rely on any specific number and uses whatever
segment is given to the process by the AlIX operating system.

However, if you are using the default configuration, there is a possibility that the EAlI MQSeries Server
process gets segment number 8 from the operating system first, and as a result the queue manager
cannot get its segment. In this case, the MQSeries Server Transport service fails with an error code
of 2059 because it cannot connect to the queue manager.

To fix a shared memory segment conflict with the EAl MQSeries Server Transport 5.2
on AIX

1 Shut down any queue manager connected to the EAl MQSeries Transport.
2 Edit the file /var/mgm/mgs.ini. In the QueueManager section, for each queue manager of

interest, add an additional line explicitly specifying the shared memory segment to use. For
example:

20 Transports and Interfaces: Siebel Enterprise Application Integration
Version 7.8, Rev. A



Transport & About Siebel EAlI MQSeries Transport

QueueManager :
Name=myQueueManager
Prefix=/var/mgm
Directory=myQueueManager
IPCCBaseAddress=12

3 Restart each queue manager.

NOTE: This example shows shared number 12 used as the memory segment number. Possible legal
values for the IPCCBaseAddress are 4, 5, 8, 9, 10, 11, and 12, although 8 has been found to be
problematic. It is possible to run into this error even with the memory segment number set as 12 if
the operating system has non-deterministically allocated segment 12 to the EAl MQSeries Server
process ahead of the queue manager. If this is the case, a different segment number may need to
be specified.

If the EAl MQSeries Server Transport business service on AlX continues to fail even after you have
followed the previous procedures, you can configure the AIX environment to run Siebel Server with
less memory using environment variable LDR_CNTRL. After you have finished, follow the procedures
in the preceding section.

To configure the AIX environment to run Siebel Server with less memory
1 Shut down Siebel Server.

2 In the shell that you use to bring up Siebel Server, set the environment variable LDR_CNTRL.
Using csh:

setenv LDR_CNTRL MAXDATA=0x30000000
NOTE: You can save the setting in the siebenv.sh or siebenv.csh.

3 Restart Siebel Server with this environment variable.
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EAI MQSeries Server Transport Parameters

In addition to supporting the common transport parameters presented in Table 4 on page 16, the EAI
MQSeries Server Transport also uses the parameters shown in Table 5. These can be specified as
either service method arguments, subsystem parameters, or user properties.

NOTE: In order to send to a model queue, the model queue must have a definition type of
PERMANENT and the following arguments must be supplied in the workflow process: Model Queue,

Physical Queue, Queue Manager, and Message Text.

Table 5.
Argument

MgAcknowledgements

Display Name

Receive
Acknowledgements

EAI MQSeries Server Transport Specific Parameters

Description

Default is False. This parameter specifies
whether or not delivery and arrival
acknowledgements are to be received.

MgAckPhysicalQueueName

Acknowledgement
Physical Queue
Name

If the MgAcknowledgements is set to True,
this parameter contains the name of the
physical queue for acknowledgements to
responses.

MgAckQueueManagerName

Acknowledgement
Queue Manager
Name

Defaults to MgQueueManagerName if
unspecified. If MgAcknowledgements set to
True, this parameter contains the name of the
queue manager for acknowledgements to
responses.

MgModelQueueName

Model Queue Name

Name of the MQSeries model queue.

MgPhysicalQueueName

Physical Queue
Name

Name of the MQSeries physical queue. You
can also create an alias queue which points to
a target queue and use the alias queue name
as the input argument physical queue name
and send messages to the target queue.

NOTE: Using an alias queue will work.
However, since the alias queue does not have
a backout queue defined, the receiver cannot
roll back to the backout queue.

MgQueueManagerName

Queue Manager
Name

Name of the MQSeries queue manager. If this
parameter is not specified, the default Queue
Manager Name, as specified in the MQSeries
configuration, is used. The Response Queue
Manager is the same as
MgQueueManagerName.

MgRespModelQueueName

Response Model
Queue Name

Name of model queue for response
connection.

MgRespPhysicalQueueName

22

Response Physical
Queue Name

Name of physical queue for response
connection.
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Table 5. EAI MQSeries Server Transport Specific Parameters
Argument Display Name Description
MgFormat MQSeries Format The format of the message from the Siebel

application to the outbound queue.

MqgSleepTime Sleep Time Default is 20000 milliseconds. The timeout
interval on receive calls, in milliseconds.

In addition to the EAl MQSeries Server Transport, you can run the MQSeries Server Receiver, which
is a server component that periodically checks the MQSeries queues you specify, for inbound
messages.

NOTE: The persistence of the message is the same as the persistence of the queue itself.

Dispatch Error Handling for the EAI MQSeries Server Transport

When using ReceiveDispatch and ReceiveDispatchSend methods, you need to be aware of specific
MQSeries behavior that might affect your messages.

NOTE: The transaction does not end when the message is received from the queue because it waits
for the entire dispatch process to either complete successfully for commit or fail for rollback.

If all the following conditions are met, the message is sent to the Backout Requeue Queue of the
current queue manager:

B A dispatch error has occurred.
B The RollbackOnDispatchError property is set to TRUE.
B The message has been rolled back by a count exceeding the Backout Threshold of the queue.

NOTE: If the Backout Requeue Queue has not been specified for the Queue Manager, then the
message is sent to the Dead Letter Queue of the current queue manager. If there is no specified Dead
Letter Queue for the current queue manager, then the queue defaults to the
SYSTEM.DEAD.LETTER.QUEUE.

Exposing MQMD Headers as Properties

The EAI MQSeries Server Transport feature exposes all the MQMD headers as properties of a property
set.

You can set any MQMD message header for the Siebel application by specifying it as property in a
property set on the outbound side. Whereas on the inbound side, the MQMD message header of the
response is exposed to the user as property on the output property set.

On the inbound side you can have all the MQMD message headers as part of the output property set
without having to do extra steps to see these MQMD message headers.

On the outbound side, you can set the MQMD message headers using the EAl MQSeries Server
Transport. In order to modify the MQMD message headers on the outbound side, the property value
for FullMQMDControl needs to be set to TRUE.
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During the sending business service step (EAlI MQSeries Server Transport.Send) within the workflow
process, input arguments are added that can modify MQMD headers. Once the property
FullMQMDControl is set to TRUE, you can modify other MQMD headers as the examples reflect in
Table 6:

Table 6. Input Arguments for Certain MQMD Headers
Property Type Values
MQMD_S_In_MsgType Literal TestMsgHeader
MQMD_S_In_CodedCharSetld Literal 1208
MQMD_S_In_Encoding Literal MQENC_NATIVE
MQMD_S_In_Expiry Literal MQEI_UNLIMITED
MQMD_S_In_Encoding Literal MQENC_NATIVE
MQMD_S_In_Persistence Literal MQPER_PERSISTENT
MQMD_S_In_Priority Literal MQPRI_PRIORITY_AS_Q_DEF

NOTE: When using the Message Type header (MQMD_S_In_MsgType), make sure that the message
type set makes sense in context. For example, if the Send method is used to send a message to
MQSeries, the MsgType should not be set to MQMT_REQUEST. If the SendReceive method is used to
send and request a response from MQSeries, then the MsgType of MQMT_REQUEST is applicable (this
is automatically set by the Siebel application). In Table 6, MsgType is set to TestMsgHeader.

Table 7 summarizes the MQMD message headers that are exposed as properties in a property set.

Table 7. MQMD Message Headers
Input/Output
Field DataType Description Property
Strucld MQCHAR4 Structure Ildentifier. Not exposed.
Version MQLONG Structure version number. Output.
Report MQLONG Options for report messages. Output.
MsgType MQLONG Message type. Input and output.
Expiry MQLONG Message lifetime. Input and output.
Feedback MQLONG Feedback or reason code. Output.
Encoding MQLONG Numeric encoding of message data. Input and output.
CodedCharsSetid MQLONG Character set identifier of message Input and output.
data.
Format MQCHARS8 Format name of message data. Input and output.
Priority MQLONG Message priority. Input and output.
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Table 7. MQMD Message Headers
Input/Output

Field DataType Description Property
Persistence MQLONG Message persistence. Input and output.
Msgld MQBYTE24 Message identifier. Output.
Correlld MQBYTE24 Correlation identifier. Output.
BackCount MQLONG Backout counter. Output.
ReplyToQ MQCHAR48 Name of reply queue. Input and output.
ReplyToQMgr MQCHAR48 Name of reply queue manager. Output.
Userldentifier MQCHAR12 User identifier. Output.
AccountingToken MQBYTE32 Accounting token. Output.
ApplldentityData MQCHAR32 Application data relating to identity. Output.
PutApplType MQLONG Type of application that put the Output.

message.
PutApplName MQCHAR28 Name of application that put the Output.

message.
PutDate MQCHARS8 Date when message was put. Output.
PutTime MQCHARS8 Tine when message was put. Output.
ApplOriginData MQCHAR4 Application data relating to origin. Output.
Groupld MQBYTE24 Group ldentifier. Output.
MsgSeqNumber MQLONG Sequence number of logical message | Output.

within group.
Offset MQLONG Offset of data in physical message Output.

form start of logical message.
MsgFlags MQLONG Offset of data in physical message Output.

from start of logical message.
OriginalLength MQLONG Length of original message. Output.

About the EAI MQSeries Transport Re-Entrance

The EAIl MQSeries Server Receiver uses the EAl MQSeries Server Transport business service but
cannot dispatch to a workflow process that either uses this business service as one of its steps or
dispatches directly to this business service. While in-process re-entrance is not supported, you can
indirectly invoke the EAl MQSeries Server Transport as one of the steps out of process by calling the
Synchronous Server Requests business service.
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About Message Id Tracking for an
Inbound Message

You can keep track of Message Ids of inbound messages by creating a process property, Msgld, of
type String and adding an output argument with the following configuration to the Send step of your
process:

Type = Output Argument
Output Argument = MQSeries Message ldentifier

This captures the Message Ids that the Queue Manager assigned to the messages in the Msgld
process property.

Invoking a Workflow Process Using
MQSeries Server Receiver

Following are examples of commands to create named subsystems and start a MQSeries Server
Receiver to invoke a workflow process.

NOTE: If there is either an exception step or an error process in your workflow, the workflow
assumes that the error step or the error process will handle the error and the workflow will not send
the error out. In order to capture the error, you need to insert a stop step into your workflow. Note
that by putting in a stop step, the caller gets the generic workflow stop error and not the original
error, but the original error is stored in the Error Code and Error Message process properties.

Command to create EAI Transport Data Handling Subsystem

create named subsystem MYDataSubSys for subsystem EAlTransportDataHandlingSubsys with
DispatchWorkflowProcess=""MQ Inbound Workflow"

Command to create EAI Transport Connection Subsystem

create named subsystem MYSubSys for subsystem mgseriesserversubsys with
MQQueueManagerName=QueueMgr, MQPhysicalQueueName=LocalQueue

Command to start a MgSeriesSrvrRcvr

start task for component MgSeriesSrvRcvr with ReceiverConnectionSubsystem=MYSubSys,
ReceiverDataHandl ingSubsystem=MYDataSubSys, ReceiverMethodName=ReceiveDispatch

When calling your workflow process by the MQSeries Server Receiver, it is not necessary to include
a step to pull the messages off the queue and pass them to the next step. The MQSeries Server
Receiver automatically pulls the messages off the queue and passes them on if:

B You have created a new process property of data type String and a default string of <Value>.
This process property stores the inbound message text picked up by the MgSeriesSrvRcvr.
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B In your workflow process step, where you handle the inbound messages from IBM MQSeries, you
insert an input argument of <Value> with type Process Property. The Property Name will be the
name of the process property you created in the previous step.

NOTE: When you type in <Value>, the display name may change to Message Text or XML
Document.
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This chapter discusses Siebel Systems’ implementation of Microsoft MSMQ support with EAl MSMQ
Transport and includes the following topics:

B “About MSMQ” on page 29
B “Configuring the EAl MSMQ Transport Servers” on page 31

B “Configuring EAl MSMQ Transport for Various Send and Receive Scenarios” on page 32

About MSMQ

Today, many large organizations are integrating various enterprise business applications into
application networks. These networks allow applications to communicate with each other and share
data, either automatically or by request. Technologies such as Microsoft Message Queuing (MSMQ)
provide a messaging infrastructure for transporting data from one application to another, without the
need for programming.

MSMQ allows applications running at different times to communicate across heterogeneous networks
and systems, even when one or many of those systems are temporarily offline. Because applications
send messages to queues and read messages from queues, the messages are always available and
remain in the queue for as long as required. For example, the messages will still be there when a
system that was offline comes back online to retrieve them. Optionally, messages can be sent to a
dead letter queue after a predetermined amount of time has passed to help make sure that only
timely, relevant messages are received.

About EAI MSMQ Transport

EAlI MSMQ Transport is a Siebel business service that can be customized using Siebel Tools. With
Siebel Tools, you define integration objects to be transported across the EAl MSMQ Transport
business service. EAl MSMQ Transport is responsible for sending and receiving messages between a
Siebel application and MSMQ queues. EAl MSMQ Transport allows you to:

B Send a message to an external system

B Send and receive synchronous messages between a Siebel application and an external system
B Receive a message and perform an action based on that message within a Siebel application
|

Receive a message, perform an action within a Siebel application, and then send a synchronous
response to the external system
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Methods for Sending and Receiving Messages

EAI MSMQ Transport supports two transport modes: Sending Messages and Receiving Messages.
Each supports the following methods.

B Send B Receive
B Send and Receive B Receive and Execute Service
Response

B Receive, Execute, Send Response

Messages from a Siebel Application to an External System

You configure EAl MSMQ Transport using the Siebel Business Process Designer, where you specify
various parameters, such as the queue where Siebel outbound messages should be sent. You
configure the message itself using the integration object feature within Siebel Tools. The message
can be in any text or binary format, including XML. The default format is XML, where the integration
object defines the XML Schema Definition (XSD) or the Document Type Definition (DTD) associated
with the XML document.

You configure the EAl MSMQ Transport at design time to specify the MSMQ queue machine name and
the queue name. You use the EAl MSMQ Transport along with the Siebel Business Process Designer
Manager to model business processes for sending messages to the external system.

You can configure the EAl MSMQ Transport to send messages to external systems when an event
occurs in a Siebel application. For example, suppose that one of your sales representatives enters a
new opportunity for an account into a Siebel application. This information needs to be sent to other
business units that may or may not be using a Siebel application. The message can be sent using
EAI MSMQ Transport as the transport mechanism to inform these external systems.

EAI MSMQ Transport can also be used synchronously to send a message and receive a response back
from an external system in a single session. For example, suppose that one of your customers calls
your Call Center requesting information on an account. The sales agent initiates a process to send a
request with the account name from a Siebel application to an external mainframe system using the
EAI MSMQ Transport. In response, the sales agent then receives a list of transaction details for that
customer displayed within a Siebel application form.

Messages to a Siebel Application from an External System

External applications can send messages to a Siebel application using EAl MSMQ Transport. These
messages are received and routed by the EAl MSMQ Receiver in conjunction with the MSMQ system.

The EAl MSMQ Receiver is a Siebel Server component that waits for messages in a specified queue.
If you select the Receive, Execute, Send Response method, the EAl MSMQ Receiver waits for a
response from a Siebel application and places the output into a response queue.
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EAlI MSMQ Transport Named Subsystems

The EAlI MSMQ Transport can read parameters from a named subsystem. For this transport, the
named subsystem type is MSMQSubsys.

B For a discussion of named subsystems for Siebel EAI, see Chapter 2, “EAIl Transports and
Interfaces Overview.”

B For more information on named subsystems, see the Siebel System Administration Guide.

Configuring the EAl1 MSMQ Transport
sServers

The instructions in this section are for configuring the EAl MSMQ Transport servers. You should use
a two-server setup, configured as listed in the following section. However, you can implement a
single server or multiple servers.

MSMQ Primary Enterprise Controller

You configure the MSMQ Primary Enterprise Controller with the following components.
B One of the following Servers:

®  Microsoft Windows NT Server Enterprise Edition

®m  Windows 2000 Server

B  Windows 2000 Advanced Server

MSMQ Server

As many MSMQ Queues as needed

Relevant ODBC driver

Siebel Server

Siebel Gateway Name Server

Siebel Web Client

Siebel Tools

Regional Enterprise Server and MSMQ Client

You configure the Regional Enterprise Server and MSMQ Client with the following components.
B One of the following servers:
m  Microsoft Windows NT Server Enterprise Edition

®  Windows 2000 Server
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®  Windows 2000 Advanced Server
The MSMQ Client

As many MSMQ Queues as needed
The relevant ODBC driver

Siebel Server

Siebel Gateway Name Server
Siebel HTML Connected Client

NOTE: The MSMQ Server can reside on either machine. This functionality is independent of the
underlying database platform. You can use any of the supported database platforms, including IBM
DB2, DB2 UDB for z/0S, Oracle, and Microsoft SQL Server.

Configuring EA1 MSMQ Transport for
Various Send and Receive Scenarios

The EAlI MSMQ Transport and the Siebel Business Process Designer Manager work in tandem to
transfer data using MSMQ from one Siebel application to another Siebel application or to an external
application. You can set up a workflow and choose attributes and values to define the transport for
a particular send or receive scenario.

EAlI MSMQ Transport Prerequisites

You must set up both Microsoft SQL Server and MSMQ before configuring the EAl MSMQ Transport.
In addition, the Siebel Business Process Designer Manager functionality should be available within
Siebel Tools and Siebel Web Client.

EAl MSMQ Transport Parameters
Table 8 presents the parameters used for configuring EAl MSMQ Transport.

Table 8. EAI MSMQ Transport Parameters

Parameter Description

EndOfData Should be set to True to indicate end of data.

MsmqPhysicalQueueName Name of the MSMQ Queue. Can be used for both sending and
receiving messages.

MsmqgQueueMachineName Machine that owns the queue specified by the physical queue
name.

MsmqgRespQueueMachineName Machine that owns the queue specified by
MsmgRespQueueName.
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Table 8. EAlI MSMQ Transport Parameters

Parameter Description

MsmgRespQueueName Name of the response queue.

MsmqSleepTime Default is 20000 milliseconds. The amount of time that the EAI
MSMQ Transport business service waits to receive a message.

TimedOut If no message is received in seconds specified in SleepTime,
the TimedOut argument in the Output Property set will be set
to True.

IgnoreCorrelationid Default is False. Set to ignore Correlation Id value on the

inbound messages. If this flag is True, the message is picked
up from the queue regardless of the correlation Id on the
message. This parameter is ignored for the SendReceive
Method because Correlation Id is required to match the
response with the original message.

This parameter must be set to True to support BizTalk
integration.

LargeMessageSupport Default is True. Set to enable or disable Large Messages
(messages over 4MB) Support. IgnoreCorrelationld should be
flagged False for Large Message Support.

Defining Integration Objects

Before you use the EAlI MSMQ transport, define integration objects for use with the transport. The
various methods explained in the following pages assume that this integration object has already
been defined. You define your Siebel messages as integration objects using Siebel Tools. These
messages correspond to the information that you want to exchange between the Siebel application
and an external application. An example of an integration object would be an order, an account, a
quote, or a contact.

The following procedure provides you with the general flow for creating integration objects for use
with the EAlI MSMQ transport.

NOTE: For more detailed information on creating integration objects, see the Integration Platform
Technologies: Siebel Enterprise Application Integration guide.

To define an integration object
1 Start Siebel Tools.

Lock the project you want in Tools, such as Contact Project.
Click New and choose Integration Object.

Select Contact as the project and EAI Siebel Wizard as the source system.

a b W N

Select Contact as the source object and give a unique name for this integration object. Click Next,
deactivate the components that are not needed, and click Finish.
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6 Compile the .srf file.

After you have created an integration object, you can then send the message corresponding to this
integration object through EAlI MSMQ transport, either as part of a business process flow (using
Siebel Business Process Designer Manager), or as a custom business service.

Sending Outbound Messages with EAl MSMQ Transport

With the Siebel application as the sender (outbound messaging), you design a workflow process that
queries for a record (such as a contact) and then converts that record to an XML document. The XML
document is then sent to an MSMQ queue.

Because MSMQ imposes a limit of four megabytes on the size of the messages it can handle, the EAI
MSMQ Transport separates outbound Siebel messages larger than four megabytes into smaller
messages acceptable to MSMQ. The message is then reassembled after it has left MSMQ and arrived
at your partner’s system.

There are two methods for sending messages from a Siebel application to MSMQ:
B Send

B Send and Receive Response (SendReceive)

Sending Messages with EAlI MSMQ Transport
The following procedure describes how to set up your system to send a message to an external
system using EAl MSMQ Transport.

To send messages from a Siebel application to MSMQ

1 Access the Windows Computer Management tool by choosing Start > Programs > Administrative
Tools > Computer Management.
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2 Set up an MSMQ gueue to receive messages from the Siebel application. Give the queue an easy-
to-identify name, such as fromsiebel, as shown in the following illustration.

The MSMQ queue you
create will appear in the
list of queues.
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3 Set the queue to be Transactional.

NOTE: This flag allows Siebel applications to group a number of Send or Receive messages. This
is critical when large data sets are being used because it allows a commit or a rollback to be
executed without failure.

From the Site Map choose Administration - Business Process > Workflow Processes.

5 Set up a workflow process for sending a message to MSMQ. Define the flow as shown in the
following figure:

Siebel XML Conwverter EAl MERID
Start Adapter - [FropSet = Transport
[Quend TaoXML) [Send)

NOTE: For details on the Business Process Designer, see the Siebel Business Process Designer
Administration Guide.

6 Create the following process properties in the Process Property applet:

Name Data Type In/0ut Value
Employee Message Hierarchy In/Out -
Employee XML Binary In/Out -
Error Code String In/Out -
Error Message String In/Out -
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Name Data Type In/0ut Value
Object Id String In/Out Row Id of an Employee record
Siebel Operation Object Id String In/Out -

7 Set up the first step of the workflow, after Start, to use EAI Siebel Adapter with the Query method
to query the information from the Siebel Database using the following input and output

arguments:
Property Property Data
Input Arguments Type Value Name Type
Output Integration Literal Sample - -
Object Employee
Object Id Process - Object Id String
Property
Property Name Type Value Output Argument
Employee Message Output Argument - Siebel Message

8 Set up the second step to use XML Converter with the PropSetToXML method to convert the data
extracted from the Siebel Database to XML format using the following input and output

arguments:
Input Property Data
Arguments Type Value Property Name Type
Siebel Message Process Property - Employee Message Hierarchy
Property Name Type Value Output Argument
Employee XML Output Argument - XML Document

9 Set up the third step to use EAlI MSMQ Transport with the Send method to send the information
to the external system, using the following input arguments:

Property
Property Data
Input Arguments Name Type
Message Text Process - Employee Binary
Property XML
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Property
Property Data
Input Arguments Name Type
MsmqgPhysicalQueueName Literal private$\FromSiebel - -
MsmqgQueueMachineName Literal Siebel7 - -

10 Save the workflow and run it from the Workflow Process Simulator.

Confirm that a message was sent to the queue using the MSMQ Explorer. In this example, a
message should be in the fromSiebel queue and should contain an XML file with employee
information.

Sending and Receiving Messages with EAl MSMQ Transport
The procedure below describes how to set up your system to send a message to an external system

using EAl MSMQ Transport and receive a synchronous message back from the external system using
EAI MSMQ Transport.

To send a literal to MSMQ and receive a response

1 Access the Windows Computer Management tool by choosing Start > Programs > Administrative
Tools > Computer Management.

2 Set up an MSMQ queue to receive messages from the Siebel application, and give the queue an
easy to identify name, such as fromsiebel.

3 Set up another queue to send messages to the Siebel application, and give the queue an easy-
to-identify name, such as tosiebel.

4 From the Site Map choose Administration - Business Process > Workflow Processes.
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5 Set up a workflow process for sending a message out and receiving a message in response using

EAl MSMQ Transport. Define the flow as shown in the following figure:

i E&l ML EA| MSME HhL
Start Eilfleml _| Converter Tranzport _| Converter
a @amer * (PropSet to (Send L to
[y ML) Receive) FropSet)

k J

Siebel
Adapter
[Up=ert)

k J

Encl

NOTE: For details on the Business Process Designer, see the Siebel Business Process Designer

Administration Guide.

6 Create the following process properties in the Process Property applet:

Name Data Type In/0ut Value
Test Message Hierarchy In/Out -
Test XML Binary In/Out -
Error Code String In/Out -
Error Message String In/Out -
Object Id String In/Out -
Siebel Operation Object Id String In/Out -
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7 Set up the first step of the workflow after Start to use EAI Siebel Adapter with the Query method
to query the information from the Siebel Database using the following input and output

arguments:
Property Property
Input Arguments Type Value Name Data Type
Output Integration Object Literal Sample Employee - -
Object Id Process - Object Id String
Property
Output
Property Name Type Value Argument
Test Message Output Argument - Siebel Message

8 Set up the second step to use XML Converter with the PropSetToXML method to convert the data
extracted from the Siebel Database to XML format using the following input and output

arguments:
Property Property
Input Arguments | Type Value Name Data Type
Siebel Message Process - Test Message Hierarchy
Property
Output
Property Name Type Value Argument
Test XML Output Argument - XML Document
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9 Set up the third step of the workflow process, after Start, to use EAl MSMQ Transport with the
SendReceive method to receive the incoming XML message, using the following input and output

arguments:
Property
Property Data
Input Arguments Name Type
MsmqPhysicalQueueName Literal fromsiebel - -
MsmgQueueMachineName Literal Siebel2001 - -

Machine name
where the Siebel
MSMQ Transport is

running.
MsmqgRespQueueMachineName Literal Siebel2001A - -
MsmqgRespQueueName Literal tosiebel - -
Property Name Type Value Output Argument
Test XML Output Argument - XML Message

10 Set up the fourth step to use XML Converter with the XMLToPropSet method to convert the XML
message to a Siebel property set using the following input and output arguments:

Input Property Property
Arguments Type Value Name Data Type
XML Document Process Property - Test XML Binary
Output
Property Name Type Value Argument
Test Message Output - Siebel
Argument Message

11 Set up the last step to use the EAI Siebel Adapter with the Insert or Update method to update
the Siebel Database, using the following input argument:

Input Property Property
Arguments Type Value Name Data Type
Siebel Process - Test Hierarchy
Message Property Message
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12 Save the workflow and run a test using the Workflow Process Simulator.

The Output Property set should have a message in the Value field. Additionally, the EndOfData
argument in the property set should be set to True.

NOTE: In order to test this scenario adequately, you must have a partner application that can
accept the message and return a response. The correlation ID of the response message must be
set to the message ID of the message originally sent by the Siebel application.

Receiving Inbound Messages with EAlI MSMQ Transport

With the Siebel application as the receiver (inbound messaging), you design a workflow process that
reads from the queue and converts the XML messages found there into Siebel message format. Then,
the EAI Siebel Adapter updates the appropriate tables within the Siebel Database.

NOTE: EAl MSMQ Transport must run on the same machine where you have defined the receiving
queue.

There are three methods for receiving messages for a Siebel application:
B Receive
B Receive and Execute Service (ReceiveDispatch)

B Receive, Execute, Send Response (ReceiveDispatchSend)

Receiving Messages from MSMQ

The following procedure describes how to set up your system to receive inbound messages from
MSMQ.

To receive messages from MSMQ

1 Access the Windows Computer Management tool by choosing Start > Programs > Administrative
Tools > Computer Management.

2 Set up a queue to send messages to the Siebel application.
a2 Name the queue an easy-to-identify name, such as tosiebel.
b Create a message in the queue.

NOTE: In order to test this scenario adequately, you must have a partner application that can
put a valid message for the Siebel application in the queue.

3 From the Site Map choose Administration - Business Process > Workflow Processes.
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4 Set up a workflow for receiving a message from MSMQ as shown in the following figure:

EAl MShit EnﬁTeLrter Siebel
Start Transport N (XMLto Adapter
[Recaive] [In=zert)

FropSet)

L
¥

NOTE: For details on the Business Process Designer, see the Siebel Business Process Designer
Administration Guide.

5 Create the following process properties in the Process Property applet:

Name Data Type In/0ut Value
Test Message Hierarchy In/Out -
Test XML Binary In/0Out -
Error Code String In/0Out -
Error Message String In/Out -
Object Id String In/Out -
Siebel Operation Object Id String In/0Out -

6 Set up the first step of the workflow process after Start to use the EAl MSMQ Transport with the
Receive method. This step receives the incoming XML message, using the following input and
output arguments:

Property Property

Input Arguments Type Value Name Data Type
MsmqPhysicalQueueName Literal tosiebel - -
MsmgQueueMachineName Literal Siebel2001 - -

Machine name where
the Siebel MSMQ
Transport is running.

Output
Property Name Type Value Argument
Test XML Output - Message Text
Argument
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Set up the second step to use the XML Converter with the XMLToPropSet method to convert the
XML message to a Siebel property set, using the following input and output arguments:

Input Property Property

Arguments Type Value Name Data Type

XML Document Process - Test XML Binary
Property

Output
Property Name Type Value Argument
Test Message Output - Siebel
Argument Message

Set up the third object to use the EAI Siebel Adapter with the Insert or Update method to update
the Siebel Database, using the following input arguments:

Input Property Data
Arguments Type Value Property Name Type
Siebel Message Process Property - Test Message Hierarchy

NOTE: In order to test this scenario adequately, you must have a partner application that can
put a valid message for the Siebel application in the queue.

Save the workflow process and run a test using the Workflow Process Simulator.

Confirm that the message is removed from the queue using the MSMQ Explorer. In this example,
if the message on the fromSiebel is valid, the Siebel Database should be updated with the
message in the fromSiebel queue.

Receiving a Message from MSMQ and Acting On It
This procedure describes how to set up your system to receive an inbound message from MSMQ and
perform an action based on that message within the Siebel application.

To receive and execute messages using EAI MSMQ Transport

1

2

Access the Windows Computer Management tool by choosing Start > Programs > Administrative
Tools > Computer Management.

Set up a queue to send messages to the Siebel application.
a  Name the queue an easy-to-identify name, such as toSiebel.
b Create a message in the queue.

NOTE: In order to test this scenario adequately, you must have a partner application that can
put a valid message for the Siebel application in the queue.
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3 From the Site Map choose Administration - Business Process > Workflow Processes.

4 Set up a workflow process for receiving and dispatching a message from MSMQ as shown in the
following figure:

EAl MSMI EDﬁTﬂ"der Siebel
Start Transport I CXMLto |  Adapter
[Recaive] FropSet) [In=zert)
NOTE: For details on the Business Process Designer, see the Siebel Business Process Designer
Administration Guide.
5 Create the following process properties in the Process Property applet:
Name Data Type In/0ut Value
Test Message Hierarchy In/Out -
Test XML Binary In/Out -
Error Code String In/Out -
Error Message String In/Out -
Object Id String In/Out -
Siebel Operation Object Id String In/Out -

6 Set up the first step of the workflow process after Start to use the EAl MSMQ Transport with the
ReceiveDispatch method. This step receives the incoming XML message, using the following input
and output arguments:

Property Property

Input Arguments Type Value Name Data Type
MsmqPhysicalQueueName Literal tosiebel - -
MsmgQueueMachineName Literal Siebel2001 - -

Machine name where

the Siebel MSMQ

Transport is running.
DispatchService Literal Workflow Utilities - -
DispatchMethod Literal Echo - -
Property Name Type Value Output Argument
Test XML Output Argument - Message Text
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Set up the second step to use the XML Converter with the XMLToPropSet method to convert the
XML message to a Siebel property set using the following input and output arguments:

Input Property
Arguments Type Value Property Name Data Type

XML Document Process Property - Test XML Binary

Property Name Type Output Argument

Test Message Output Argument

Siebel Message

Set up the third object to use the EAI Siebel Adapter with the Insert or Update method to update
the Siebel Database, using the following input arguments:

Property Data

Input Arguments Type Value Property Name Type

Siebel Message Process Property - Test Message Hierarchy

NOTE: In order to test this scenario adequately, you must have a partner application that can
put a valid message for the Siebel application in the queue.

Save the workflow process and run a test using the Workflow Process Simulator.

The contents of the output property set depend on the business service and method specified in
the DispatchService and DispatchMethod arguments. Also, the Output Arguments applet should
automatically populate and EndOfData should be set to True.

Receiving, Dispatching, and Sending MSMQ Messages

The following procedure shows you how to set up your system to receive an inbound message from
MSMQ, perform an action within a Siebel application based on that message, and then send a
synchronous response back to the external system.

To receive, dispatch, and send messages using EAl MSMQ Transport

1

Access the Windows Computer Management tool by choosing Start > Programs > Administrative
Tools > Computer Management.

Set up an MSMQ queue to receive messages from the Siebel application.
Give the queue an easy-to-identify name, such as fromSiebel.
Set up another queue to send messages to the Siebel application.

a2 Name the queue an easy-to-identify name, such as toSiebel.
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b Create a message in the queue.

NOTE: In order to test this scenario adequately, you must have a partner application that
can put a valid message for the Siebel application in the queue.

4 From the Site Map choose Administration - Business Process > Workflow Processes.

5 Set up a workflow process for receiving and dispatching a message from MSMQ as shown in the

following figure:

E&l MShii

Start Tran=spoart

[Receive
Dispatchzend)

*hiL
Converter
[(XMLto
PropSet)

Siebel
Adlapter
[Up=ert)

End

NOTE: For details on the Business Process Designer, see the Siebel Business Process Designer

Administration Guide.

6 Create the following process properties in the Process Property applet:

Name Data Type In/Out Value

Test Message Hierarchy In/Out -

Test XML Binary In/Out Test Message from Siebel
Error Code String In/Out -

Error Message String In/Out -

Object Id String In/Out -

Siebel Operation Object Id String In/Out -
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7 Set up the first step of the workflow process after Start to use EAlI MSMQ Transport with the
ReceiveDispatchSend method to receive the incoming XML message, using the following input
and output arguments:

Property
Property Data
Input Arguments Name Type
MsmqPhysicalQueueName Literal tosiebel - -
MsmgQueueMachineName Literal Siebel2001 - -

Machine name where
the Siebel MSMQ
Transport is running.

MsmqgResponseMachineName Literal Siebel2001A - -

Name of the machine
where the queue
receiving messages
from Siebel application

is located.
MsmqgRespQueueName Literal fromsiebel - -
DispatchService Literal Workflow Utilities - -
DispatchMethod Literal DispatchReceiveMethod - -
Property Name Type Value Output Argument
Test XML Output Argument - Message Text

NOTE: For illustration purposes, Workflow Utilities Echo method is used as dispatch service
method. This could be changed to any dispatch service method as per your business
requirements.

8 Set up the second step to use the XML Converter with the XMLToPropSet method to convert the
XML message to a Siebel property set using the following input and output arguments:

Input Property Property
Arguments Type Value Name Data Type
XML Document Process Property = Test XML Binary
Property Name Type Value Output Argument
Test Message Output Argument - Siebel Message
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9 Set up the third object to use the EAI Siebel Adapter with the Insert or Update method to update
the Siebel Database, using the following input arguments:

Input Property Property

Arguments Type Value Name Data Type

Siebel Message Process Property - Test Message Hierarchy

NOTE: In order to test this scenario adequately, you must have a partner application that can
put a valid message for the Siebel application in the queue.

10 Save the workflow process and run a test using the Workflow Process Simulator.

The contents of the output property set depends on the business service and method specified in the
DispatchService and DispatchMethod arguments. Confirm that the message is removed from the
queue using the MSMQ Explorer. In this example, the Siebel Database should be updated with the
message in the fromSiebel queue. Also, a response message will be in the queue specified by the
MSMQRespQueueName and MSMQRespQueueMachineName arguments.
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This chapter includes the following topics:

About the EAIl Java Business Service

The EAI Java Business Service is a service framework that allows custom business services to be
implemented in Java and run from a Siebel application. The framework consists of the following:

“About the EAIl Java Business Service” on page 49
“Prerequisites for Implementing a JBS” on page 49
“Creating a Java Business Service” on page 51

“About the Lifecycle of a Java Business Service” on page 53
“Example of a Java Business Service” on page 53

“About Restrictions for Implementing JBS” on page 54

“Troubleshooting the Java Business Service” on page 54

B A template Business Service, EAIl Java Business Service, defined in the repository.

B An abstract Java class, com.siebel.eai.SiebelBusinessService, that defines the interface of the
Java class that implements the business service.

The EAI Java Business Service works by creating a Java Virtual Machine (JVM) in-process with the
Siebel application and invoking Java implementations using JNI. Each Siebel process (component)
has at most one JVM. JVMs are not shared across components.

Prerequisites for Implementing a JBS

In order to implement a Java business service, the following software must be installed and properly
configured on each Siebel Server or Siebel Mobile and Developer Web Clients:

B A Java Runtime Environment.

B All necessary Java code.

B A configured named subsystem of type JVMSubSys.

The named subsystem supplies the parameters to the JBS. There are three parameters:

B DLL. The complete path of the Java Runtime Environment library. On Windows, it is jvm.dll; on
AlX, libjvm.a; on HP-UX, libjvm.sl; and on Solaris, libjvm.so.
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B CLASSPATH. The classpath used by the Java virtual machine.

The classpath must include the following Siebel JAR files as well as all Java code implementing
the desired business service.

The required Siebel JAR files are:
m  Siebel.jar
m  Siebelll_lang.jar (lang corresponds to the default language for your installation).

B VMOPTIONS. Java virtual machine options. On all platforms, except AlX, itis recommended that
the option -Xusealtsigs be used to make sure that the signal handlers used by the Siebel Server
do not conflict with those of the JVM.

NOTE: The option -Xusealtsigs is mandatory for use on the Sun Solaris platform. The JVM options
will not load successfully into the object manager without the use of this option.

The following example shows how to create a named subsystem using the Siebel Server Manager:

create named subsystem JAVA for subsystem JVMSubSys with
DLL="D:\j2sdkl.4_2\jre\bin\server\jvm.dll",
CLASSPATH=""c:\cp\Siebel _jar;c:\cp\SiebelJl_enu.jar;c:\cp\myJARs.jar;.",
VMOPTIONS ="-Xrs -Djava.compiler=NONE"

Alternatively, the parameters to the Java Business Service may be specified in the application
configuration file instead of a named subsystem. This should only be used in conjunction with the
Siebel Mobile and Dedicated Web clients, and not the Siebel Server.

[JAVA]

DLL = D:\j2sdkl.4._2\jre\bin\server\jvm.dll

CLASSPATH = c:\cp\Siebel.jar;c:\cp\SiebelJl_enu.jar;c:\cp\myJARs._jar;.
VMOPTIONS = -Xrs -Djava.compiler=NONE

Creating a Java Subsystem by Using the Siebel Web Client

The following is an alternative procedure for creating a Java subsystem by using the Siebel Web
Client.

To create a Java subsystem by using the Siebel Web Client

1 Start any Siebel Business Application and navigate to Site Map > Administration - Server
Configuration > Enterprises.

In the top list applet, select the Enterprise Server that you want to configure.
In the middle applet, click the Profile Configuration tab.

Click New to create a new component profile and set the following parameters:
a  Profile = JAVA

b Alias = JAVA

C  Subsystem Type = JVMSubsys

5 In the Profile Parameters list applet (the bottom applet), set the following values:
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a  Set the Value of the JVM Classpath parameter to one of the following:
1 The location of the JNDI.properties file (if using the JMS Transport).
4 The JMS provider JAR files (if using the JMS Transport).

4 The Siebel.jar and SiebelJl_enu.jar files. These files can be installed by using either
Siebel Tools or the Siebel Server. An example of these files for Microsoft Windows follows:

c:\bea\weblogic.jar;c:\siebel\Jndi;c:\siebel\siebsrvr\CLASSES\Siebel . jar;
c:\siebel\siebsrvr\classes\SiebelJl_enu.jar

b  Set the Value of the JVM DLL Name parameter to the path where you have the jvm.dll file
installed. For example, DLL= D:\j2sdkl1l.4._.2\jre\bin\server\jvm.dll.

C  Set the Value of the JVM Options record to any JVM-specific options that you would like to enable.

About Platform-Specific Configurations for the JVM
Depending on the platform, it is necessary to set certain environment variables to make sure of the
proper loading of the JVM:

B AIX. Make sure that you have the environment variable LIBPATH set to include the JVM's /lib and
classic directories. For example:

setenv LIBPATH /usr/j2sdkl4/lib:/usr/j2sdkl4/classic:${LIBPATH}
Also, make sure that the LD_LIBRARY_PATH is set correctly.

B HP-UX. Make sure that you have the environment variable SHLIB_PATH set to include the JVM's
/jre and /bin directories and the server directory. For example:

setenv SHLIB_PATH
/opt/javal.4/jre/lib/PA_RISC2.0:/opt/javal.4/jre/lib/PA_RISC2.0/server :${SHLIB_PATH}

Set the variable LD_PRELOAD to the full path of the Java library.
B Solaris, Windows. No additional settings are needed.

When a Java business service is invoked on UNIX from a server component (for example, the JMS
Receiver; see Chapter 6, “Java Message Service Transport” for more information), the necessary
settings must be done in the script that creates the component.

For the receiver, the script is siebshw; for the application object managers, it is siebmtshw. These
scripts are present in the /bin directory where the Siebel Server is installed.

Creating a Java Business Service

Implement a business service in Java by:
B Defining a new business service in the repository using Siebel Tools.

B Specifying the necessary Java classes.
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To define and specify a new Java business service in Siebel Tools
1 Copy the EAIl Java Business Service (using the Copy Record command in Siebel Tools).

NOTE: Checking the Cache column when you are creating the new Java business service will
cause the same Java object to be reused by subsequent invocations within the same session.
(See “About the Lifecycle of a Java Business Service” on page 53.)

2 Add a Business Service User Property named @class, whose value is the fully qualified name of
the Java class (for example, com.mycompany.siebelBusinessService.lmportCustomer).

Implementing a Business Service in Java

Once the Java business service has been defined in Siebel Tools, the Java class must be implemented.
The Java class implementing the business service must extend
com.siebel.eai.SiebelBusinessService.

SiebelBusinessService is an abstract Java class found in Siebel.jar. It declares three methods:

B destroy. This method is called when the Java object is released by the Siebel application. It has
a default empty implementation and can be overridden for the purpose of performing any
cleanup.

B invokeMethod. This method contains a default implementation that calls dolnvokeMethod and
catches any exceptions that are thrown by it. It does not declare any exceptions. It is invoked
by means of JNI in the Siebel application’s native process. This method is not intended to be
overridden.

B dolnvokeMethod. This method must be implemented by the subclass that implements the
business service. It takes as arguments the methodName, input property set, and output
property set. The property sets are instances of com.siebel.data.SiebelPropertySet. This method
throws SiebelBusinessServiceException.

About Exception Handling for the Java Business Service

Errors are handled by throwing a com.siebel.eai.SiebelBusinessServiceException class. The
constructor for this class takes two String arguments, an error code and an error message. The error
code may be used for programmatic handling in Siebel eScript when the business service is called.
Both the error code and the error message will be displayed as an ordinary Siebel error message.

It is strongly recommended that proper error handling be employed when implementing the Java
Business Service class. By invoking a SiebelBusinessServiceException, the standard Siebel error
handling facilities will be employed.

If any other exception is received from dolnvokeMethod, an error is produced with the details of the
exception.
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About the Lifecycle of a Java Business
Service

A JVM is created in-process with the Siebel process the first time a Java business service is invoked.
Thereafter, the same JVM is used for all invocations of any Java business services.

An instance of the Java class implementing a business service is created the first time that business
service is invoked. This instance is released through JNI when the native business service is
destroyed. For business services that are not cached, this occurs whenever the caller (workflow
process, script) releases the native business service. For business services that are cached, this
occurs when the session is destroyed (for example the user logs out). For a business service marked
as cached in the repository, repeated invocations by a user during a single session will invoke
methods on the same Java object.

Example of a Java Business Service

Following is an example of a Java class implementing a business service:

package com.mycompany. jbs;
import com.siebel.data.SiebelPropertySet;
import com.siebel_eai.SiebelBusinessServiceException;

public class AddBusinessService extends com.siebel.eai.SiebelBusinessService {

public void dolnvokeMethod(String methodName, SiebelPropertySet input,
SiebelPropertySet output) throws SiebelBusinessServiceException {
String X = input.getProperty("X");
String Y = input.getProperty("Y");

if (X == null || X.equalsC"™) |l (¥ == null) || Y.equals("))
throw new SiebelBusinessServiceException("'NO_PAR", "Missing param™);

if (ImethodName.equals ("Add'™))
throw new SiebelBusinessServiceException(*'NO_SUCH_METHOD”, *""No such method');

else {
int x = 0;
inty = 0;
try {
x = Integer.parselnt(X);
y = Integer.parselnt(Y);
}

catch (NumberFormatException e) {
throw new SiebelBusinessServiceException("NOT_INT", "Non-integer passed™);

3
int z = x +vy;
output.setProperty("Z", new Integer(z).toString());
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About Restrictions for Implementing
JBS

When implementing a Java business service, keep in mind the following recommendations:
B Each business service method invocation should be atomic and stateless.

B The explicit creation of Threads is discouraged. It is not recommended that customers invoke a
multi-threaded component from a Java business service.

B All data and context required to perform the necessary business functions must be provided as
input to the class. The external Java class cannot call back into the Siebel application to obtain
additional context.

Troubleshooting the Java Business
Service

A common source of errors is the Java CLASSPATH.
Remember the following conventions of the Java CLASSPATH:
B On UNIX, CLASSPATH entries are separated by a colon (:); on Windows, by a semicolon (;).

B If .class files are to be used instead of .jar files, the root directory (for example, the one
containing the com folder) must be listed in the CLASSPATH.

If the Java business service states that the com.siebel.data.SiebelPropertySet class is not found,
then the Siebel.jar files are not correctly specified in the CLASSPATH.

If the Java business service implementation cannot be found, then the .class or .jar file containing
its code is not properly specified in the CLASSPATH.

54 Transports and Interfaces: Siebel Enterprise Application Integration
Version 7.8, Rev. A



e Service Transport

This chapter discusses the Siebel EAl Java Message Service (JMS) Transport and includes the
following topics:

B “About the Siebel EAlI JMS Transport” on page 55

“About Synchronous and Asynchronous Invocation” on page 56

“About the JMS Publish-and-Subscribe Model” on page 56

“About Operations of the JMS Transport” on page 56

“Features Not Supported for Use with the Siebel JMS Transport” on page 57
“About JMS Message Types” on page 57

“About Sending and Receiving XML” on page 58

“About Multi-Step Operations Within a JMS Session” on page 58
“Undeliverable Messages in JMS Transport” on page 59

“Detailed Input and Output Specifications” on page 59

“Configuring the JMS Transport” on page 64

“Receiving, Dispatching, and Sending JMS Messages” on page 70

“Enabling Authentication and Authorization for the EAl JMS Transport” on page 73

“Troubleshooting for the JMS Transport” on page 76

“About Logging for the JMS Transport” on page 77

About the Siebel EAl JMS Transport

The EAI JMS Transport is an APl for accessing enterprise messaging systems. It supports the ability
to send and receive messages by way of JMS servers. JMS defines two messaging models: point-to-
point (by way of JMS queues) and publish-and-subscribe (by way of JMS topics). Both are supported
by the Siebel EAlI JMS Transport.

JMS queues and topics are identified by their INDI names. A JNDI naming service is required in order
to use the EAIl JMS Transport. It should contain entries for the desired queues and topics.

The API of EAI JMS Transport is very similar to other Siebel messaging APIs such as the MQ Transport
and MSMQ Transport.

The EAI JMS Transport is built using the Java Business Service and therefore inherits all the
requirements of that business service. This includes the independent installation of a Java virtual
machine (JVM) and the configuration of the Siebel application to identify and create the VM.
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About Synchronous and Asynchronous
Invocation

Like the MQ Transport, the JMS Transport has two modes of execution—synchronous and
asynchronous. Synchronous execution involves invoking individual methods of the JMS Transport
directly, just like any other business service. Because the caller waits for the method to return, such
invocation is synchronous. Asynchronous execution means listening for messages arriving on a
particular queue and taking action whenever one arrives. This involves the creation of a separate
Siebel component, called a JMS Receiver. Like the MQ Receiver, whenever a message arrives on the
queue, the JMS Receiver dispatches to a business service (or workflow) and optionally sends a reply
message.

About the JMS Publish-and-Subscribe
Model

The traditional message model, where a message is sent to a queue and later removed by a single
receiver, is called point-to-point messaging. In addition to this familiar model, JMS also supports the
publish-and-subscribe messaging model. Here, messages are published to topics, rather than sent
to queues. Interested receivers subscribe to individual topics and receive a copy of each message
published to the topic. In order to subscribe, a subscriber registers with the topic, providing a unique
identifier. For more information about the JMS publish/subscribe model, refer to the specification that
is available from Sun at http://java.sun.com/products/jms.

About Operations of the JMS Transport

This section describes the operations (methods) of the JMS Transport.

JMS queues and topics are identified by their INDI names. A JNDI naming service is required in order
to use the JMS Transport. The JNDI naming service contains entries for the desired JMS Queues
(implementers of javax.jms.Queue) and Topics (implementers of javax.jms.Topic) as well as the
necessary JMS ConnectionFactories (implementers of either javax.jms.QueueFactory or
javax.jms.Topic).

All methods that receive messages automatically time out if no message is available. The timeout
length is three seconds by default and can be specified by the ReceiveTimeout argument. A value of
zero for this argument disables the timeout, causing the method to wait indefinitely for a message
to arrive. Whether a call to Receive or Subscribe timed out is provided as the TimedOut property of
the output property set.

Subscriptions to JMS topics are always durable subscriptions.

The term dispatch is used to refer to the operation of calling a business service or workflow, passing
as input, the content of a newly received message.

The arguments to these methods and their exact semantics (along with valid values, default values,
and so on) are described in the section “Detailed Input and Output Specifications” on page 59. All
methods require the JNDI name of JMS ConnectionFactory and the JNDI name of Queue or Topic.
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The following is a summary of supported operations for use with the JMS Transport:
B Receive. Receive a message from a JMS queue.
B ReceiveDispatch. Receive a message from a JMS queue, then dispatch.

B ReceiveDispatchSend. Receive a message from a JMS queue, dispatch, and then send the
result to a (possibly different) JMS queue.

The reply is sent to the SendQueue specified in the input to this method. (The JMSReplyTo header
of the received message is ignored.)

Send. Send a message to a JMS queue.

SendReceive. Send a message to a JMS queue then receive a message from a (possibly
different) JMS queue.

The JMSCorrelationID header of the reply message must be equal to the JMSCorrelationlID of the
message sent, unless it is null (if none was provided as an input to SendReceive), in which case
it must be the JMSMessagelD of the message sent.

B Subscribe. Receive a message from a JMS topic. The subscriber identifier must be supplied as
an input to this method.

B SubscribeDispatch. Receive a message from a JMS topic, then dispatch. The subscriber
identifier must be supplied as an input to this method.

B Publish. Publish a message to a JMS topic.

Features Not Supported for Use with the
Siebel JMS Transport

JMS has a feature called Message Selection, by which a receiver or subscriber may filter the
messages it receives by specifying certain criteria. This feature is not supported by Siebel's IMS
Transport.

Also, it is not recommended that JMS messaging be used concurrently (for a single queue) with non-
JMS messaging. For example, it is not recommended that a message be sent by way of JMS and later
read using native tools. JMS vendors do not typically support such usage; it may result in the
appearance of additional headers or additional obscure data in the body of the message.

About JMS Message Types

JMS defines five types of messages: TextMessage, BytesMessage, ObjectMessage, MapMessage, and
StreamMessage. The Siebel JMS Transport supports only the types TextMessage and BytesMessage.
If the JMS Transport receives an ObjectMessage, MapMessage, or StreamMessage from the JMS
server, a Unsupported Message Type error is produced.

Like all Siebel business services, the output of any method is a property set. If a BytesMessage is
received, then the value of the property set has Binary type. If a TextMessage is received, then the
value has String type.
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Conversely, the input to any method is also a property set. For methods that involve sending or
publishing a message, the type of message sent or published depends on the type of the value of
the input property set. If the type is Binary, then a BytesMessage is sent and published. If the type
is String, then a TextMessage is sent and published.

NOTE: The Siebel Business Service Simulator in the Siebel Call Center always creates the input with
a value type of String.

About Sending and Receiving XML

Messages whose content is XML are generally best treated as binary data and sent as
BytesMessages. For example, the output of the Siebel business service EAl XML Converter is binary;
therefore, if this is passed as the input to Send, then a BytesMessage will be sent.

If XML is sent as a TextMessage, the characters will be encoded as UTF-16. Therefore, the XML
document should declare its encoding to be UTF-16.

Typically, when a message containing an XML document is received by the Siebel application, it is
desirable to convert the document to a property set representation before processing it. This is
accomplished automatically during the Dispatch step by specifying the ConverterService argument
to be either XML Converter or EAl XML Converter. For more details about these converter services
see the XML Reference: Siebel Enterprise Application Integration guide.

About Multi-Step Operations Within a
JMS Session

All JMS operations are performed in the context of a transactional JMS QueueSession. If a send or
receive operation throws an exception, the session is immediately rolled back. If the operation is
successful, then the session is committed, unless the operation is part of a larger multi-step
operation. In the case of multi-step operations, the transaction is handled as follows:

B SendReceive. If the send operation succeeds, then the JMS session is committed and a receive
operation is performed. This is necessary because the receive operation may depend on a
response to the first message.

B ReceiveDispatch. If the receive operation fails, then the JMS session is rolled back, and the
dispatch operation is not attempted. If the receive operation succeeds, then the dispatch
operation is attempted. If the dispatch succeeds, then the JMS session is committed; otherwise,
both the Siebel transaction and the JMS session are rolled back.

SubscribeDispatch. Same as ReceiveDispatch.

B ReceiveDispatchSend. If the receive operation fails, then the JMS session is rolled back, and
further operations are not attempted. If the receive operation succeeds, then the dispatch
operation is attempted. If the dispatch operation fails, then the JMS session and the Siebel
transaction are rolled back; otherwise, the send operation is attempted. If the send operation
fails, then the JMS session and the Siebel transaction are rolled back; otherwise, both are
committed.
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Each Dispatch operation is performed within a Siebel transaction.

NOTE: ReceiveDispatch and ReceiveDispatchSend should not be attempted from within an existing
Siebel transaction, as nested transactions are not supported.

Also, as with all Siebel EAI receivers, if an operation fails during the execution of the JMS Receiver,
the JMS Receiver component terminates. (A timeout is not a failure.)

Undeliverable Messages in JMS
Transport

If a message is undeliverable, in the sense that repeated attempts by the Siebel JMS Transport to
receive the message fail, then the message must be removed from the queue. Most JMS vendors
provide some mechanism for dealing with such “poison messages.” Weblogic, for example, can be
configured to limit the number of times it will attempt to deliver a message before redirecting the
message to an error queue or deleting the message altogether.

Detailed Input and Output Specifications

This section provides detailed information about the exact semantics of all input arguments and
output values for each method of the JMS Transport.

JMS Headers and Properties

Every JMS message has a set of standard headers. Some of these headers can be specified as
arguments to the methods of the JMS Transport that involve sending or publishing, and some are
available as properties of the output property set of methods that involve receiving or subscribing.
These are detailed in the tables below.

A JMS message may also be assigned properties. These may be user-defined properties specific to
a particular application, or JMS-defined properties (for example JMSXProducerTXID) that are
optionally supported by the JMS vendor. A property may be an instance of any Java class or any of
the primitive Java types. All properties of a message received by the Siebel JMS Transport are
available as properties of the output property set.

The name of the property is the original name with the eleven characters SIEBEL_JMS: prepended;
the value is the string obtained by converting the original value to a Java String. Conversely, when
sending a message, any property of the input property set whose name begins with SIEBEL_JMS: is
added to the message being sent as a JMS Message string property with the prefix SIEBEL_JMS:
removed. For example, the property SIEBEL_JMS:foo is added to the message as the string property
foo.
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Input Arguments Used by the Dispatch Step

Table 9 reflects the optionality of each input argument except user-defined properties and arguments
used by the Dispatch step. An asterisk (*) denotes a required argument, OPT denotes an optional
argument, and a dash (-) denotes an argument that is ignored.

Table 9. Dispatch Step Input Arguments

Send Receive giggzxih Subscribe
Publish Receive Receive Subscribe Dispatch Send Dispatch
ConnectionFactory €3 & * * * * * *
ReceiveQueue - - * * - * * -
ReceiveTimeout = = OPT OPT OPT OPT OPT OPT
SendQueue * - * - - - *1 -
Topic - & = = * - - *
ConnectiionUsername OPT OPT OPT OPT OPT OPT OPT OPT
ConnectionPassword OPT OPT OPT OPT OPT OPT OPT OPT
SendUsername OPT - OPT - - OPT = -
SendPassword OPT - OPT - - OPT = -
ReceiveUsername - - OPT - = = OPT -
ReceivePassword - - OPT - = = OPT -
TopicUsername - OPT - - OPT - - OPT
TopicPassword - OPT = = OPT - - OPT
Subscriberldentifier | - - - - * = = *

JMS Headers

JVMSPriority OPT OPT OPT - - = OPT2 -
JMSDeliveryMode OPT OPT OPT - - - OPT2 -
JMSExpiration OPT OPT OPT - - - OPT2 -
JMSReplyTo OPT OPT -4 - - - OPT2 -
+JIMSType OPT OPT OPT - = = OPT2 -
+JMSCorrelationlD OPT OPT OPT - - - -3 -
Dispatch

++ConnectionSubsyste | OPT OPT OPT OPT OPT OPT OPT OPT
m

+++DataHandlingSubsy | - - - = = OPT OPT OPT
stem
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Table 9. Dispatch Step Input Arguments

Receive
send Receive Dispatch Subscribe
Publish Receive Receive Subscribe Dispatch Send Dispatch

DispatchService - - - = - OPTS OPT5 OPT5
DispatchMethod - - - - - OPTS OPT5 OPTS
DispatchWorkflowProc | - - - = - OPTS OPT5 OPTS
ess

DispatchRuleSet - - - - - OPTS OPTS OPTS
++++ConverterService | - - - = = OPT OPT OPT

Some special notes regarding particular values in Table 9:
B OPT2: These values are assigned to the reply message during the Send step.

B OPT5: One of 3 combinations is required for these method arguments: (DService && Dmethod),
DWProcess, or DRuleSet.

m *1: The JMSReplyTo header of the received message is ignored. The reply is always sent to the
configured SendQueue. The JMSReplyTo header of the reply will be set to this value.

B -3: The JMSCorrelationID of the reply message cannot be set directly. The JMSCorrelationID of
the reply message is set to the JMSCorrelationID of the received message, unless empty, in which
case it is set to its JIMSMessagelD.

B -4: The JMSReplyTo header of the sent message is set to the value of the ReceiveQueue
argument.

+: An input argument that can also be used as an output argument.

++: For this input argument, a subsystem may be provided instead of the connection
parameters. However, it must contain the same required method arguments as used for the
connection parameters.

B +++: For this input argument, a subsystem may be provided instead of the dispatch parameters.
However, it must contain the same required method arguments as used for the dispatch
parameters.

B ++++: This input argument is used to process the output of the received message before
dispatching.

The ConnectionUsername and ConnectionPassword input parameters apply to IBM MQ only.

The SendUsername, SendPassword, ReceiveUsername, ReceivePassword, TopicUsername, and
TopicPassword input parameters apply to BEA WebLogic only.

In lieu of providing the arguments individually, the single argument ConnectionSubsystem may be
provided. Its value must be the name of a valid named subsystem of type JMSSubsys, and it must
include all of the arguments that are required by the method to which it is passed. See “About the
JMS Receiver” on page 65 for more information about that named subsystem.
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JMS message properties are also supported as input arguments (properties) as described in “JMS
Headers and Properties” on page 59.

Table 10 provides details for each input argument about the allowable values, default

special values, as well as the behavior if an invalid value is passed.

Table 10.

Values for Input Arguments

Default

Allowable Values

Special

Values

values, and

1T Value
Invalid

ConnectionFactory NONE JNDI connection ERROR
factory name
ReceiveQueue NONE JNDI queue name ERROR
ReceiveTimeout 3000 ANY INTEGER x >= 0O 0: Wait Non-int =
indefinitely | 3000
<0=0
ConnectionUsername NONE Valid username
ConnectionPassword NONE Valid password
SendQueue NONE JNDI queue name ERROR
SendUsername NONE Valid username
SendPassword NONE Valid password
ReceiveUsername NONE Valid username
ReceivePassword NONE Valid password
TopicUsername NONE Valid username
TopicPassword NONE Valid password
Topic NONE JNDI topic name ERROR
Subscriberldentifier NONE ANY STRING N/A
JMS Headers
JMSCorrelationlD NOT SET ANY STRING N/A
JMSPriority Javax.jms._Message.DEFAUL | ANY INTEGER O <= x <= (O lowest; DEFAULT
T_PRIORITY 9 9 highest)
=4
JMSDeliveryMode Javax.jms.DeliveryMode.P | PERSISTENT, DEFAULT
ERSISTENT NON_PERSISTENT
JMSExpiration Javax.jms._Message.DEFAUL | ANY INTEGER x >= O 0: Message DEFAULT
T_TIME_TO_LIVE never
=0 expires
JMSReplyTo NOT SET JNDI queue name ERROR
IMSType SiebelJMSMessage ANY STRING N/A
Dispatch
ConnectionSubsystem NONE A JIMSSubsys named ERROR
subsystem
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Table 10. Values for Input Arguments

Special 1T Value
Default Allowable Values Values Invalid
DataHandl ingSubsystem NONE An ERROR
EAlTransportDataHand
l1ingSubsys named
subsystem
DispatchService NONE Business service ERROR
name
DispatchMethod NONE Business service ERROR
method
DispatchWorkflowProcess | NONE Workflow process ERROR
DispatchRuleSet NONE Rule set name ERROR
ConverterService NONE Business service ERROR
name

About Output of the JMS Transport

The output of the JMS Transport methods includes the following parts:

B The content of the received message (if the method involves receiving a message). See the
previous section, “Input Arguments Used by the Dispatch Step” on page 60 for details about

typing.

B JMS properties of the received message (if the method involves receiving a message), as
described in the section “JMS Headers and Properties” on page 59.

B Certain JMS headers of the message sent or received, as described in Table 11.

The special properties TimedOut (if the method involves receiving a message) and DispatchError
(if the method involves dispatching), as described in Table 11. Each property is either True or
False.

Table 11 enumerates for each method of JMS Transport the JMS headers and other distinguished
properties that appear as properties of the output property set of the method. An asterisk (*) means
the argument is present; a dash (-) means the argument is absent.

Table 11. Dispatch Step Input Arguments

send Receive g?:ﬁézih Subscribe
Publish Receive Receive Subscribe Dispatch Send Dispatch
TimedOut = = * * * * * *
+JMSType - - * * * - - -
+JMSCorrelationlD - - € * * = - -
JMSRedelivered - - 2 * * = - -
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Table 11. Dispatch Step Input Arguments

send Receive g(ia::il:ih Subscribe
Output Publish Receive Receive Subscribe Dispatch Send Dispatch
JMST imestamp = = * * * = - -
JMSMessagelD *1 *1 *2 *2 *2 - *1 -
DispatchError = = = - - * * *

Some special notes regarding the information in this table:
m  *1: JMSMessagelD, the value assigned by the JMS server of the sent (or published) message.

B *2: JMSMessagelD, the value assigned by the JMS server of the received (or subscribed)
message.

B +: An output argument that can also be used as an input argument.

All other message properties (user-defined; not JMS headers) are provided as output properties with
SIEBEL_JMS: prepended to the original property name, and the value is converted to a String.

For the multi-step methods ReceiveDispatch, ReceiveDispatchSend, and SubscribeDispatch,
properties are passed between the individual steps according to the following rules:

B All outputs of the Receive (or Subscribe) step are passed as inputs to the subsequent Dispatch
step.

In the case of an error during the Dispatch step, its output is returned.

The input to the Dispatch step includes all properties in the original input as well as properties
returned by the Receive (or Subscribe) step.

Configuring the JMS Transport

The JMS Transport is built using the Java Business Service and therefore inherits all the requirements of
that business service. This includes the independent installation of a Java virtual machine (JVM) and the
configuration of the Siebel application to identify and create the VM. Configuration of the Siebel
application requires creating a named subsystem of type JVMSubSys with the necessary properties.
Refer to the Java Business Service documentation for instructions on how to configure the JVM named
subsystem.

JMS Transport requires the CLASSPATH property of the JVM subsystem must include the following
packages or classes:

B Siebel.jar.
B Siebelll_lang.jar (where lang corresponds to the default language for your installation).
B A directory containing the location of the jndi.properties file.

The jndi.properties file contains the necessary name value pairs required to perform a JNDI
lookup and bind to the remote queue.
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B Necessary classes and JAR files as required by the JMS provider.

To verify that the CLASSPATH and jndi.properties are properly configured, refer to “Troubleshooting
for the JMS Transport” on page 76.

About the JMSSubsys Named Subsystem

The arguments to any method of JMS Transport may be supplied individually as properties of the
input property set or as part of a named subsystem of type JMSSubsys. When invoking the JMS
Transport asynchronously by starting a JMS Receiver component, the arguments must be supplied
by way of a named subsystem.

This subsystem supplies all of the necessary parameters for any one of the three methods
ReceiveDispatch, ReceiveDispatchSend, or SubscribeDispatch. The parameters for the three
methods are ConnectionFactory, ReceiveQueue, SendQueue, Topic, Subscriberldentifier,
ReceiveTimeout, JMSType, JMSPriority, JMSExpiration, JMSDeliveryMode.

In addition, this subsystem has a property JVMSubsys, which can be given the name of the JVM
subsystem instance to use. The default value is JAVA. Therefore, if the property JVMSubsys is not
explicitly given a value, there must be a properly configured instance of the type JVMSubSys named
JAVA.

About the JMS Receiver

The JMS Receiver is a Siebel Server component that makes it possible for the JMS Transport to be
invoked asynchronously. The JMS Receiver listens for messages arriving on a JMS Queue or Topic and
takes action whenever a message arrives. The JMS Receiver repeatedly invokes a single method of
the JMS Transport, either ReceiveDispatch, ReceiveDispatchSend, or SubscribeDispatch.

An instance of the JMS Receiver is configured with the parameters of a IMSSubsys named subsystem,
which fix the queue or topic to listen to, as well as the action to be taken.

The following is an example of how an instance of the JMS Receiver could be configured and run by
using the Siebel Server Manager command-line interface:

create named subsystem MyJMSConnSubsys_SR for subsystem JMSSubsys with
ConnectionFactory="weblogic.examples. jms.QueueConnectionFactory",
ReceiveQueue="weblogic.examples. jms.exampleQueueReceive",
SendQueue="weblogic.examples. jms.exampleQueueSend",
ReceiveTimeout=3000

create named subsystem SiebelEcho for subsystem EAlTransportDataHandlingSubsys with
DispatchService="Workflow Utilities",
DispatchMethod=""ECHO"

start task for comp JMSReceiver with
ReceiverConnectionSubsystem=MyJMSConnSubsys_SR,
ReceiverDataHandl ingSubsystem=SiebelEcho,
ReceiverMethodName=ReceiveDispatchSend
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For a discussion of named subsystems for the Siebel EAI, see Chapter 2, “EAl Transports and
Interfaces Overview.”

For more information on administering named subsystems, see the Siebel System Administration
Guide.

Creating a JMS Subsystem by Using the Siebel Web
Client

The following is an alternative procedure for creating a JMS Subsystem by using the Siebel Web
Client and then configuring the JMS Transport.

To configure the JMS Transport by using the Siebel Web Client

1 Start any Siebel Business Application and navigate to Administration - Server Configuration >
Enterprises.

2 In the top list applet, select the desired Enterprise Server that you want to configure.
In the middle applet, click the Profile Configuration tab.
4 Click New to create a new component profile and set the following parameters:
a  Profile = JMS_Q1ReceiveDispatchSend
b  Alias = JMS_Q1ReceiveDispatchSend
C  Subsystem Type = JMSSubsys

5 In the Profile Parameters list applet (the bottom applet), specify the parameters required for the
type of operations the subsystem will need to support (for example, Receive or
ReceiveDispatchSend).

For example, if this subsystem needed to support the ReceiveDispatchSend operation, at least
the following values must be set:

a  ConnectionFactory name = examples.jms.QueueConnectionFactory

b JVM Subsystem name = JAVA
Cc ReceiveQueue name = examples.jms.fromSiebel
d SendQueue name = examples.jms.toSiebel
e Receive Timeout = 1000
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Sending and Receiving Messages with the JMS
Transport

The procedure below describes how to set up the Siebel application to send a message to an external
system using the EAl JMS Transport and receive a corresponding reply from the external system.

To send and receive messages with the JMS Transport

1 Setup a JMS queue to receive messages from the Siebel application and give the queue an easy-
to-identify name, such as fromSiebel.

Refer to your JMS provider documentation on how to administer, monitor, and define new
persistent queues.

2 Set up a JMS queue to send messages to the Siebel application.

Refer to your JMS provider documentation on how to administer, monitor and define new
persistent queues.

a  Give the queue an easy-to-identify name, such as toSiebel.
b Create a message in the queue.

NOTE: In order to test this scenario adequately, you must have a partner application that can
place a valid message for the Siebel application in the queue.

3  From the Site Map choose Administration - Business Process > Workflow Processes.

4 Configure and deploy a workflow process for sending a message out and receiving a message in
response using the EAl JMS Transport.

Define the flow as shown in the following figure.

MLDoc)

(SendReceive)

EAl XML EALJMS EAl XML
Start Siebel Order N Converter N Transport | Converter(XML
(Query By ID) 7| (IntObjHierToX o P | DocTolntObjHi

er)

Siebel Order
(Syncronize)

End

For details on the Business Process Designer, see the Siebel Business Process Designer
Administration Guide.
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5 Create the following process properties in the Process Properties applet:

In/

Name Data Type Out Default String Comments

OrderxXML Binary In

JMSConnectionFactory String In examples.jms.ConnectionFactory JNDI name of
the JMS
connection
factory

JMSReceiveQueue String In examples. jms.toSiebel JNDI name of
the queue

JMSSendQueue String In examples. jms.fromSiebel JNDI name of
the queue

JVMSReceiveTimeout String In 180000

Order Message Integration In

Object

6 Set up the first step of the workflow to use the Siebel Order ASI with the QueryByld method to
query the information from the Siebel database using the following input and output arguments:

Input Argument Type Value Property Name
PrimaryRowld Process Property Object Id
Property Name Type Value Output Argument
Order Message Output Argument SiebelMessage

7 Set up the second step of the workflow to use the EAl XML Converter with the
IntObjHierToXMLDoc method to convert the data extracted from the Siebel database to XML
using the following input and output arguments:

Input Argument Type Value Property Name
GenerateProcessinglnstructions Literal False
SiebelMessage Process Property Order Message
Property Name Type Value Output Argument
OrderxXML Output Argument <Value>
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8 Set up the third step of the workflow process, after Start, to use the EAl JMS Transport with the
SendReceive method using the following input and output arguments:

Input Argument Type Value Property Name
<Value> Process Property OrderxXML
ConnectionFactory Process Property JMSConnectionFactory
ReceiveQueue Process Property JMSReceiveQueue
ReceiveTimeout Process Property JMSReceiveTimeout
SendQueue Process Property JMSSendQueue
Property Name Type Value Output Argument
OrderXML Output Argument <Value>

9 Set up the fourth step to use the EAl XML Converter with the XMLDocTolntObjHier method to
convert the XML message to an Integration Object using the following input and output

arguments:
Input Argument Type Value Property Name
<Value> Process Property OrderxML
Property Name Type Value Output Argument
Order Message Output Argument SiebelMessage

10 Set up the last step to use the Siebel Order ASI with the Synchronize message to update the
Siebel database using the following input and output arguments:

Input Argument Type Value Property Name
SiebelMessage Process Property Order Message
Property Name Type Value Output Argument
Order Message Output Argument SiebelMessage
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11 Save and deploy the workflow process.
It is recommended that the Workflow Simulator be used for testing purposes.

NOTE: In order to test this scenario adequately, you must have a partner application that can
accept the message and return a response. The correlation ID of the response message must be
set to the message ID of the message originally sent by the Siebel application.

Receiving, Dispatching, and Sending
JMS Messages

The procedure below describes how to set up your system to receive inbound messages from JMS,
perform an action within the Siebel application based upon the message, and send a synchronous
response back to the external system.

To receive, dispatch, and send messages using EAl JMS Transport

1 Set up a JMS queue to receive messages from the Siebel application and give the queue an easy
to identify name, such as fromSiebel.

Refer to your JMS provider documentation on how to administer, monitor, and define new
persistent queues.

2 Set up a JMS queue to send messages to the Siebel application.

Refer to your JMS provider documentation on how to administer, monitor and define new
persistent queues.

a  Give the queue an easy-to-identify name such as toSiebel.
b Create a message in the queue.

NOTE: In order to test this scenario adequately, you must have a partner application that can
place a valid message for the Siebel application in the queue.

3 Navigate to Administration - Business Process > Workflow Processes.
4 Configure and deploy a workflow process to process the incoming XML request.

The following workflow process receives the incoming XML document and converts it to an
integration object, executes a query using Siebel Order application service, and converts the
response to an XML document as shown in the following figure:

EAI XML Siebel Order EAI XML
Converter N ASI N Converter
Sl (MLDocTolnt [ ™| (QueryByExam [ ™| (IntObjHierTaX il
ObjHier) ple) MLDoc)
70 Transports and Interfaces: Siebel Enterprise Application Integration

Version 7.8, Rev. A



t I Receiving, Dispatching, and Sending JMS Messages

5 Create the following process properties in the Process Properties applet:

Default
Name Data Type In/Out String Comments
<Value> Binary In/0ut <Value> Order Integration
Object
Order Message Hierarchy In/0ut XML representation
of the integration
object

6 Set up the first step of the workflow process, after Start, to use the EAl XML Converter with the
XMLDocTolntObjHier method.

This step will convert the incoming XML document to an integration object representation using
the following input and output arguments:

Input Argument Type Value Property Name
<Value> Process Property <Value>

Property Name Type Value Output Argument
Order Message Output Argument SiebelMessage

7 Set up the second step to use the Siebel Order ASI with the QueryByExample method.

This step will query the Order business object based upon the provided XML document using the
following input and output arguments:

Input Argument Type Value Property Name
SiebelMessage Process Property Order Message
Property Name Type Value Output Argument
Order Message Output Argument SiebelMessage
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Set up the third step to use the EAl XML Converter with the IntObjHierToXMLDoc method.

This step will convert the integration object to a well-formed XML document using the following
input and output arguments:

Input Argument Type Value Property Name
SiebelMessage Process Property Order Message
Property Name Type Value Output Argument
<Value> Output Argument <Value>

Save and deploy the workflow process.

For details on deploying workflow processes, see the Siebel Business Process Designer
Administration Guide.

Define a JMS Connection subsystem using SrvrMgr (command line utility) or the Server
Administration screen.

NOTE: The Siebel Server needs to be restarted in order for the new subsystem to be available.
Following is an example using SrvrMgr.

NOTE: ConnectionFactory, ReceiveQueue and SendQueue require JNDI names, which will vary
depending upon the JMS provider and your implementation.

create named subsystem JMSToFromSiebel for subsystem JMSSubsys with
ConnectionFactory="jndiName.ConnectionFactory",
ReceiveQueue=""jndiName.toSiebel ",

SendQueue=""jndiName.fromSiebel",

ReceiveTimeout=3000

Define a data handling subsystem to dispatch the message from the toSiebel queue to the
workflow process defined as previously defined (JMS Query Order).

NOTE: The Siebel Server needs to be restarted in order for the data handling subsystem to be
available.

create named subsystem QueryOrder for subsystem EAlTransportDataHandlingSubsys with
DispatchWorkflowProcess="JMS Query Order"

After restarting the Siebel Server, start a new JMS Receiver from the SrvrMgr command line.

Following is an example that instructs the receiver to use the JMSToFromSiebel connection
subsystem defined in Step 10, the QueryOrder data handling subsystem defined in Step 11, and
instructs the receiver to use the ReceiveDispatchSend method of the EAlI JMS Transport.

start task for comp JMSReceiver with
ReceiverConnectionSubsystem= JMSToFromSiebel,
ReceiverDataHandl ingSubsystem=QueryOrder,
ReceiverMethodName=ReceiveDispatchSend
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13 Place a message resembling the following on the toSiebel queue.

NOTE: A third-party product such as Hermes (available from Sourceforge.net) is required in
order to place a message on a queue. In the following sample document, the Siebel Order ASI
will query for all orders associated with the Hibbings Manufacturing account.

<?xml version="1.0" encoding=""UTF-16"?>
<SiebelMessage IntObjectName="Order Interface'>
<ListOfOrderInterface>
<Orders>
<Account>Hibbings Manufacturing</Account>
</Orders>
</ListOfOrderiInterface>
</SiebelMessage>

Enabling Authentication and
Authorization for the EAI JMS Transport

Authentication and authorization can be configured on JMS servers to protect JMS destinations.
Siebel Systems supports the following scenarios for use in the Siebel application:

B Require username and password to perform a JNDI look up.
B Require username and password to create connections to the JMS server.

B Require username and password to send, receive, publish, subscribe from, or subscribe to JMS
destinations that have the authorization enforced by a JMS server.

The responsibility of the Siebel EAlI JMS Transport business service as a JMS client is twofold:

B Provide configuration mechanism and read credentials from the Siebel application configuration
file.

B Establish proper security context for executing privileged operations.

About JMS Credential Specification

The following method arguments are added to the EAl JMS Transport business service methods to
use when completing the JMS credential specification:

B ConnectionUsername and ConnectionPassword. The credentials used to create JMS
connections.

B SendUsername and SendPassword. The credentials used to send messages to SendQueue
(applicable for use with BEA WebLogic only, see “Configuring Against BEA WebLogic” on page 74).

B ReceiveUsername and ReceivePassword. The credentials used to receive messages from
ReceiveQueue (applicable for use with BEA WebLogic only, see “Configuring Against BEA
WebLogic” on page 74).

B TopicUsername and TopicPassword. The credentials used to publish/subscribe to/from Topic
(applicable for use BEA WebLogic only, see “Configuring Against BEA WebLogic” on page 74).
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Send and receive credentials are specified separately because some JMS business service methods
(SendReceive and ReceiveDispatchSend) contain both send and receive operations, and it is possible
that SendQueue and ReceiveQueue are protected by different credentials.

Configuring Credentials in JNDI

JNDI credentials are specified in the jndi.properties file by setting java.naming.security.principal to
username and java.naming.security.credentials to password. For more details, refer to the JNDI
specification. The construction of the naming context will automatically read the credentials from the
jndi.properties file and use those credentials to connect to a JNDI server if authentication is required
to perform JNDI lookup.

Configuring Credentials in IMS

JMS-related credentials (those listed in the JMS credential specification) are passed in through a
Siebel application-defined configuration mechanism. For configuring JMS-related credentials, see
“Configuring the JMS Transport” on page 64.

JMS Password Encryption

When passwords are provided through service input properties (ConnectionPassword,
SendPassword, ReceivePassword, or TopicPassword), they are encrypted manually using the Siebel
encryptstring utility. The EAl JMS Transport business service will try to decrypt the password before
using it. Passwords supplied using the name server have already been encrypted by the server
manager, thus you do not need to encrypt it again with encryptstring.

The encryptstring utility is located in the BIN directory of your installation of the Siebel Web Server
Extension plug-in.

Configuring Against BEA WeblLogic

The following instructions let you configure the EAl JMS Transport business service against the BEA
WebLogic JMS server.

To configure the EAIl JMS Transport business service against the BEA WeblLogic JMS
server

1 Authorize a user to send from SendQueue using SendUsername and SendPassword.
2 Authorize a user to receive from ReceiveQueue using ReceiveUsername and ReceivePassword.

3 Authorize a user to publish and subscribe to and from Topic using TopicUsername and
TopicPassword.

By default, the BEA WebLogic server does not require a username or password to connect to or
lookup JNDI objects. If the server does require this, configure the EAl JMS Transport business
service following Step 4 and Step 5.
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4 ConnectionUsername and ConnectionPassword are set to a user that can connect to the JMS
server, but the user has no privileges for any JMS destinations.

ConnectionUsername and ConnectionPassword can also be left blank if the JMS server accepts
anonymous connections.

5 If JNDI lookup is protected, then jndi.properties file should contain the
java.naming.security.principal and the java.naming.security.credentials parameters that are
used to perform the JNDI lookup.

NOTE: The JNDI principal and credentials are set to a user who can only perform the JNDI
lookup, but has no privileges for any JMS destinations.

Configuring Against IBM WebSphere MQ

For the IBM Websphere MQSeries client, no separate security context is needed for each operation.
Once a connection is established, all requests sent through the same connection will use the same
connection context.

NOTE: The MQ server does not perform authentication by default. By default, passwords are not
validated. Setup authentication for MQ is a task for the MQ administrator, not the Siebel application
administrator.

For the ReceiveDispatchSend method, the implication is that the receive credentials must be the
same as the send credentials. Receive and send must be executed on the same session or connection
to remain a single transaction.

To configure Siebel JMS business service against MQSeries

1 Set the ConnectionUsername and ConnectionPassword to the proper credentials to execute the
JMS operations specified by the JMS business service method. For example, in the Send method,
both ConnectionUsername and ConnectionPassword must be set to the credentials that are
authorized to send messages to SendQueue.

2 In the ReceiveDispatchSend method, set the ConnectionUsername and ConnectionPassword to
the credentials that can both send to SendQueue and receive from ReceiveQueue.

3 Make sure the jndi.properties file contains the java.naming.security.principal and
java.naming.security.credentials properties that are used to connect to the EMS server and to
look up JNDI objects.

NOTE: These JNDI credentials are set separately from ConnectionUsername and
ConnectionPassword.

Security Configuration on the JMS Server

For information on how to protect JMS resources on the JMS server, see the specific vendor
documentation.
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Troubleshooting for the JMS Transport

Several diagnostic methods are present in the EAl JMS Transport to assist in troubleshooting
CLASSPATH, JNDI, and problems connecting to the JMS server.

B CheckClasspath. Iterates through the JVM's classpath, checking for the existence of each in the
file system.

B CheckJNDIContext. Creates a JNDI InitialContext based on parameters (context factory class,
URL) in resource file jndi.properties.

Lists the parameters and the entries found in the context, the names and classes of the
administered objects.

B CheckJNDIObjects. Retrieves administered objects (connection factory, queue, topic) from
JNDI.

B CheckJMSServer. Invokes JMS methods directly and simply.

If SendQueue is specified, it sends a message and then receives a message. If SendQueue is not
specified and Topic is, it then creates a durable subscriber, publishes a message, receives it, and
then unsubscribes.

B CheckAll. Executes all checks: CheckClasspath, CheckJNDIContext, CheckJNDIObjects,
CheckJMSServer.

Table 12 contains more details of the arguments for use with the JMS Transport. The arguments listed
are used by all three methods.

Table 12. Arguments to Use with the JMS Transport for Certain Methods

Method Argument Display Name Type Description
CheckJNDIObjects | ConnectionFactory Connection Factory | Input The JNDI name for the
JMSConnectionFactory.
CheckJMSServer
SendQueue Send Queue Input The JNDI name for the
Checkall queue (optional).
Topic Topic Input The JNDI name of the topic
(optional).
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About Logging for the JMS Transport

The JMS Transport will log messages to a file if the Java system property jms.log is set. This property
is specified among the VMOPTIONS in the JVM subsystem. An example of such a log follows:

VMOPTIONS=""-Djms. log=C:\temp\mylog.txt"
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This chapter discusses EAlI HTTP Transport, its methods, and workflow examples illustrating using
EAI HTTP Transport with different methods.

This chapter consists of the following topics:

“About the EAI HTTP Transport” on page 79

“Using POST and GET” on page 80

“EAIl HTTP Transport Named Subsystems” on page 81

“General Information on How to Send a Message” on page 81
“Using the EAI HTTP Transport for Inbound Integration” on page 84
“EAIl HTTP Transport for Inbound Messages” on page 90

“Handling EAlI HTTP Transport Business Service Errors” on page 93
“Processing and Sending Outbound XML Documents” on page 93
“Sending and Receiving Messages with the EAI HTTP Transport” on page 95
“Examples Using HTTP Request” on page 98

“About Transport Headers and HTTP Response Headers” on page 100

“EAl HTTP Transport Method Arguments” on page 101

About the EAlI HTTP Transport

The use of the Internet protocols and technologies for business—such as HTTP, HTML, and XML—has
given rise to a need to automatically send Siebel data to external sites either on the Internet, or
outside the enterprise firewall to external Web sites. To meet this need, the technologies built into
Siebel EAI provide a way to send and receive messages over HTTP. Siebel EAl HTTP Transport
business service lets you send XML messages over HTTP to a target URL (Web site). The Siebel Web
Engine (SWE) serves as the transport to receive XML messages sent over the HTTP protocol to a
Siebel application.

The EAI HTTP Transport business service is based on the CSSHTTPTransService class. You can use
one of the following two methods with this transport:

B Send. This method supports outbound messages (XML documents sent from a Siebel application
to an external system). The Send method means that the response coming back from the
external application is not interpreted by the Siebel application, but the Web server should be
sending back a correct HTTP response.

B SendReceive. This method supports outbound messages (XML documents sent to a Siebel
application from an external system). This method is called Send and Receive a Response and
the HTTP response body is the response for the request.
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Each method has its own arguments, techniques, and applications. The EAlI HTTP Transport allows
you to send messages across the Internet using the standard HTTP protocol. Using this transport,
you can send messages to any URL. The XML document sent can then be acted upon by any Web-
based application, including those written in Java, JavaScript, VBScript, or any other Web-enabled
technology.

System Requirements for Using the EAlI HTTP Transport

Using the EAI HTTP Transport requires that the following components of Siebel application be
installed, configured, and operational:

B Siebel Web Engine. To provide the necessary HTTP listening services and invoke the requisite
workflow process through a business service method.

B Workflow Processes. To accept incoming XML documents and pass them through an
integration object into the business object to update Siebel data.

B Business Services. To execute the necessary actions.

Selecting the Appropriate Business Service for HTTP

The business service you need to initialize to process a given XML document that is received from an
external system using the EAI HTTP Transport depends on the processing you need to do on the data.
The way to approach this is to accept the output of the EAl HTTP Transport and store it as a process
property that you define, and process it later in the workflow based on the format of the data.

For example, you could pass the string into a custom business service that you build to parse the
input, query some data in a Siebel application based on the data, and then update the appropriate
field in the Siebel application. If the data is formatted as a SiebelMessage, you could use the EAI
XML Converter business service with the XMLDocTolntObjHier method to pass an integration object
to EAI Siebel Adapter for further processing.

Using POST and GET

The HTTP protocol supports GET and POST methods. You might be familiar with these methods if you
have ever built a Web-based CGI form.
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The EAI HTTP Transport imposes certain restrictions on your use of transport features when using
POST or GET method. Table 13 identifies restrictions on these HTTP methods.

Table 13. Restrictions on GET and POST Methods with EAl HTTP Transport

Method Restriction

Get The HTTP Body has no significance when using GET. During a GET process, only the
universal resource locator (URL) is used for the request.

Post The HTTP Body is relevant only when using POST. The HTTP Body is encoded with a
default mechanism used to encode URLs.The HTTP Content-Type application/xxx-
form-urlencoded is the default content type used for request bodies. The content is
sent as it is without any special content encoding, such as Base64.

EAI HTTP Transport Named Subsystems

The EAI HTTP Transport, like every other Siebel transport, reads required parameters from a named
subsystem instead of the configuration file .cfg. The eai.cfg file entries should list the external service
name and the name of the named subsystem to be used. For example:

SiebelQuery = SiebelQueryDispatch

There is no [Properties] section for SiebelQueryDispatch in the .cfg file. The name is used to look up
the named subsystem list and dispatch accordingly. Use named subsystems for property
specification. Predefined named subsystems have been created for you already, such as:

B SiebelQueryDispatch
B SiebelExecuteDispatch
B SiebelUpsertDispatch

NOTE: You previously specified properties by means of .cfg file entries. You can continue to do so,
but you should switch over to using named subsystems because *.cfg file entries will not be
supported in future releases. Only named subsystems will work for new functionality such as
Dispatch Service and Character Set Conversions. You can create additional named subsystems as
needed using Siebel Server Manager.

For a discussion of named subsystems for Siebel EAI, see Chapter 2, “EAIl Transports and Interfaces
Overview.” For more information on named subsystems, see the Siebel System Administration Guide.

General Information on How to Send a
Message

The following steps demonstrate how to send information from a Siebel application to another Web-
based application using the EAlI HTTP Transport.

1 Create an integration object in Siebel Tools based on a given business object.
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2 Refine the integration object created in Step 1 to specify just those business components and
fields that you want to exchange with the external application.

NOTE: For details about integration objects, see the Integration Platform Technologies: Siebel
Enterprise Application Integration guide.

3 Create a workflow process, using Business Process Administration, to send this information to an
external system as shown in the following figure:

E&l Siekel _|  EAlIEML _| EAIHTTF
Aclapter Y Corwverter " Transpor

Start End

a  Create the following process properties in the Process Property applet:

Name Data Type In/0ut Value
Account Message Integration In/Out -
Object

Account XML Binary In/Out -

Error Code String In/Out -

Error Message String In/Out -

Object Id String In/Out Row Id of an account
Siebel Operation Object Id String In/Out -

b Set up the first step of the workflow after Start to use the EAI Siebel Adapter with the Query
method to query the information from the Siebel Database, using the following input and output

arguments:
Property Property Data
Input Arguments Type Value Name Type
Output Integration Object Literal Sample - -
Account
Object Id Process Property - Object Id String
Output
Property Name Type Value Argument
Account Message Output - Siebel
Argument Message
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C  Set up the second step to use the EAlI XML Converter with the IntObjHierToXMLDoc method to
convert the data extracted from the Siebel Database to XML format, using the following input
and output arguments:

Input Property Property

Arguments Type Value Name Data Type

Siebel Process - Account Integration

Message Property Message Object

Property Name Type Value Output Argument

Account XML Output - XML Document
Argument

d  Set up the third step to use the EAI HTTP Transport with the Send method to send the information
to the external system, using the following input arguments:

Property Property

Input Arguments Type Name Data Type

Message Text Process - Account XML String
Property

Request Method Literal POST

Request URL Template Literal http:// - =

$web_address$/
$request_param$

Output Property
Property Name Type Value Argument Data Type
Account XML Output Argument - Message Text -

e Save the workflow and run it from the Workflow Simulator.
4 Specify how this workflow will be invoked using one of the following methods:
m Configure the RunTime Events to trigger the workflow.

m Create a button on the appropriate view in the Siebel application to call this workflow
process.

Use workflow policies on the opportunity business object to trigger the workflow process.
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Using the EAlI HTTP Transport for
Inbound Integration

The EAI HTTP Transport uses the Siebel Web Engine (SWE) to provide inbound messaging from an
application that uses HTTP.

To use the EAI HTTP Transport for inbound integration, you must perform certain tasks that are not
required when using the EAI HTTP Transport for outbound integration. First, you must be running the
Siebel Web Engine (SWE) in order to use the EAl HTTP Transport. In turn, SWE requires that the
Siebel Web Server, Siebel Gateway Name Server, and Siebel Server be installed, configured, and up
and running.

NOTE: Type http://Web_Server_Name URL on any machine that already has connectivity to the Web
server to check the connectivity between the URL (for EAl HTTP Transport) issuing machine and SWE.
This URL brings up the Home page of the Web server confirming the connectivity between SWE and
the URL issuing machines.

Specifying HTTP Parameters for Inbound Integration

The EAI HTTP Transport is built into SWE. To use it, you first need to set certain configuration
parameters for the virtual directory on the Web server. Your Siebel application installation includes
a configuration file called eapps.cfg in the \bin subdirectory of your installation directory. This file is
on the Web server side of your configuration, as opposed to on the Siebel Server side of your
installation. You should review the configuration file to make sure that the parameters are set
properly. Use named subsystems to dispatch to a workflow as described in the section “Using Named
Subsystems for Transport Parameters” on page 13 in Chapter 2, “EAIl Transports and Interfaces
Overview.”

To configure the SWE to run the EAI HTTP Transport for inbound integration
1 Open your eapps.cfg file in a text editor.

2 Look for the section [/eai_lang]. Where Jang is the three-letter language code for the language
you are using, such as enu for U.S. English.

3 Add the EnableExtServiceOnly configuration parameter or set it as follows, if it already exists, to
enable the HTTP inbound transport. This example shown is for use with UNIX in an English
environment.

[/eai_enu]
ConnectString = Connect String
EnableExtServiceOnly = TRUE

For the virtual directory, you need to set the ConnectString parameter. The syntax for the
ConnectString is:
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ConnectString = siebel[. transport][.-encryption][.-compression]://SiebelServer
:SCBPort/ EnterpriseName/ XXXObjMgr_ lang

Where:

transport = TCPIP or http.

encryption = none or mscrypto.

compression = none or zlib.

SiebelServer = the name of your Siebel Server.

SCBPort = Listening port number for the SCBroker component (default is 2321).
EnterpriseName = the name of your Siebel Enterprise Server.

XXXObgMgr_lang = the type of Object Manager for the Siebel Business Application you are
installing and the language code used for this installation.

The following example shows the connect string using TCP/IP, with no encryption, no
compression, and the server name and default port. In addition, you need to point to the Siebel
Object Manager specific to the Siebel Business Application you are installing.

In the example connect string, the Siebel Business Application installed is Siebel Sales, and the
Siebel Object Manager is called EAIObjMgr.

ConnectString = siebel.TCPIP.None.None://serverl:2321/siebel 77/EAIObjMgr_enu

4 Save and close the configuration file.

Setting Configuration Parameters for Siebel Server

You must also set certain configuration parameters for whatever Siebel Server you are using. The
server component you are running must be a Client Application Manager component. Set this in the
configuration file for the server component of your choice, or use named subsystems.

Calling EAI HTTP Transport Over a Network

The EAI HTTP Transport can be used in two modes:
B Session mode
Il Sessionless mode

The following sections explain the use of these two modes.

Viewing the Session Mode Between HTTP Requests

This mode uses HTTP Session Cookie to retain the session information between the HTTP requests.
The session mode can be viewed when a sequence of calls is supported from an HTTP application into
the EAlI HTTP Transport.
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To view the session mode from an HTTP application into an EAI HTTP Transport

1 Log in to the Siebel application. If successful, an HTTP session cookie gets returned in HTTP set-
cookie header.

2 Submit one or more requests.

Each request is intended as a call to a Siebel business service. Requests must contain the session
cookie from Step 1 in the HTTP cookie header.

3  Log off. The request must contain the session cookie from Step 1 in the HTTP cookie header. The
cookie refers to the session to be closed.

The Session cookie is passed to the caller after a successful login request as in Step 1. The caller
then should use that cookie for subsequent data requests in Step 2 and the log off request in
Step 3.

NOTE: For session mode inbound HTTP requests, the expiration date of the cookie sent to the client
application will not be set as it is expected that this cookie will be used to send multiple requests
within the same session.

Login Examples for the HTTP Protocol

HTTP protocol requests can be represented as URLs for HTTP GET, and as a combination of URL and
request body for HTTP POST. The following sections explain in detail how each of the session mode
calls is configured.

Login HTTP Request Example 1
In this example, if the call completes successfully, it will return a session cookie.

Using HTTP GET

URL = http://webserver/path/
start.swe?SWEExtSource=source&SWEExtCmd=ExecutelLogin&UserName=username&Password=pa
ssword

Using HTTP POST

URL = http://webserver/path/start.swe

HTTP Body =
SWEExtSource=source&SWEExtCmd=ExecutelLogin&UserName=username&Password=password

Table 14 presents each of the Login HTTP Request variables for session mode.

Table 14. Session Mode Variables

Variable Description

webserver URL of the Web server that has Siebel Web Engine installed, such as
WWW. myserver.com.

path Virtual path on the server referring to specific SWE configuration. This value should
be eai.
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Table 14. Session Mode Variables

Variable Description

source If you are not using named subsystems, this is the name of the Business Service
Source as specified in [HTTP Services] section in the .cfg file that describes the
Business Service call.

username Siebel user name for the Siebel Object Manager login.

password Password for the login user name above.

Example Login URL

http://www.myserver.com/eai/
start._swe?SWEExtSource=SiebelQuery&SWEExtCmd=ExecutelLogin&UserName=userl&Password=
loginl23

Login HTTP Request Example 2

In this example, for the call to complete successfully, it must include the session cookie from the
login.

Using HTTP GET
URL = http://webserver/path/start.swe?SWEExtData=data text

Using HTTP POST
URL = http://webserver/path/start.swe

HTTP Body = data text

where data text is the business service input data. Most of the time, this is the text of an XML
document that on the server side is converted to a PropertySet and passed to the business
service.

Example Request URL

http://www_myserver.com/eai/start._swe?SWEExtData=<?xml version="1.0" encoding="UTF-
8"?><SiebelMessage Messageld="" MessageType="Integration Object” IntObjectName=""Sample
Account'>

<ListofSampleAccount>
<Account>
<Name>A. K. Parker Distribution</Name>
<ListOfContact>
<Contact>

<FirstName>Stan</FirstName>
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<LastName>Graner</LastName>
</Contact>
</ListOfContact>
</Account>
</ListofSampleAccount>
</SiebelMessage>

To use this URL, you change the WebServer address www.myserver.com to the actual server URL you
will be using. Data that is sent as part of the URL should be Unicode-encoded before being URL-
encoded. POST requests can send the data without URL encoding and should include the Content-
Type HTTP header. The Content-Type should specify the charset of the incoming data as in Content-
Type=text/xml ;charset="UTF-8".

NOTE: For XML messages being received by way of the Inbound HTTP Transport, only a Unicode
(UTF-8 or UTF-16) format (with accordant encoding XML-processing header attribute and encoded
XML data) is allowed. No I1SO or Windows code pages are accepted.

Logoff HTTP Request
This request must include the session cookie from Login.

Using HTTP GET
URL = http://webserver/path/start.swe?SWEExtCmd=Logoff

NOTE: HTTP GET should always be used for the Logoff HTTP Request.

Example Logoff URL
http://www.myserver.com/eai/start.swe?SWEExtCmd=Logoff

EAI HTTP Transport in Sessionless Mode

Using the EAI HTTP Transport in sessionless mode allows you to use one URL to perform Login,
Request, and Logoff in a single HTTP request. This mode does not use session cookies because there
is no login session between the HTTP requests. The disadvantage of this mode is the overhead
incurred by the Siebel Object Manager needing to log in with every request.

Example of URLs Used for the HTTP Inbound Transport

In this example, the URL describes the parameters for the HTTP Inbound Transport call over HTTP.

88 Transports and Interfaces: Siebel Enterprise Application Integration
Version 7.8, Rev. A



ransport = Using the EAlI HTTP Transport for Inbound Integration

Using HTTP GET

URL = http://webserver/path/
start.swe?SWEExtSource=source&SWEExtCmd=Execute&UserName=username&Password=passwor
A8SWEExtData=data text

NOTE: Unlike session mode, the SWEExtCmd is Execute, not ExecutelLogin.

Using HTTP POST
URL = http://webserver/path/start.swe

HTTP Body =
SWEExtSource=source&SWEExtCmd=Execute&UserName=username&Password=passwora&SWEExtDa
ta=data text

NOTE: When using the sessionless mode with the POST method, the XML data text must be URL-
encoded to prevent any errors.

Table 15 presents each of the variables for sessionless mode.

Table 15. Sessionless Mode Variables

Variable Description

webserver URL of the Web server that has Siebel Web Engine installed, such as
WWW. myServer.com.

path Default is eai. Virtual path on the server referring to specific SWE configuration.

source If you are not using named subsystems, this is the name of the Business Service
Source as specified in [HTTP Services] section in the .cfg file that describes the
Business Service call.

username Siebel user name for the Siebel Object Manager login.
password Password for the login user name.
data text Business service input data. Most of the time, this is the text of an XML document

that on the server side is converted to a PropertySet and passed to the business
service. For more information on how to pass Properties and PropertySet to
Business Services, see the Siebel Business Process Designer Administration
Guide.

Example Sessionless Mode URL
NOTE: This sample URL should be entered as a single line of text. The URL is presented here on
separate lines for clarity.

http://www.myserver.com/eai/start.swe?SWEExtSource=SiebelQuery&
SWEExtCmd=Execute&UserName=userl&Password=1oginl23

&SWEExtData=<?xml version=""1.0" encoding="UTF-8"?><SiebelMessage Messageld=""
MessageType=""Integration Object” IntObjectName=""Sample Account'">

<ListofSampleAccount>
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<Account>
<Name>A. K. Parker Distribution</Name>
<ListOfContact>
<Contact>
<FirstName>Stan</FirstName>
<LastName>Graner</LastName>
</Contact>
</ListOfContact>
</Account>
</ListofSampleAccount>
</SiebelMessage>
To use this URL you will:

B Change the WebServer address, www.myserver.com, to your actual Web server URL.

B Verify that the SWEExtSource argument has a corresponding section in your eai.cfg file in the
[HTTP Services] section.

B Change the Username and Password arguments to a valid system user, such as “SADMIN/
SADMIN.”

EAI HTTP Transport for Inbound
Messages

To use the EAI Transport, you complete two steps:

B Set up the business service for use in the workflow.
B Create the workflow.

Both steps are explained in this section.

This scenario assumes incoming XML. Your business requirements dictate if and how you need to
adapt these steps to fit your needs.

To set up the business service
1 Start Siebel Tools, connecting to the server.

2 Find the business service named Workflow Process Manager.
3 Copy this record and rename the copy EAITEST.
4

Access the Business Service User Props window and add a new record:
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a2 Enter ProcessName in the Name column.

b Enter EAITEST in the Value column, as shown in the following illustration.

| ' | Mame | Changed | Praject | Cache | Class
| > & EAITEST v Account v CESWEngine
|| Wil wieb Prowy Service Wi - el Integration CEEWTService
|| web Collab Service ireb Collaboration v CSSwebCollabService
| el Engine HTTP TXM SWE C555erviceSweHttpTan
|| el Engine Interface SWE v CE5ServiceSWEIFace
4

ser Props

| ' | Mame Changed | Walue Inactive | Comments
|T & Process Mame v i EAITEST :

Compile a new .srf file and copy it to the SIEBSRVR_ROOT\Object directory.
Restart the Siebel Server.

Verify that the EAl Object Manager has started.

To create the new workflow process to receive messages
Log in to the Siebel client as an administrator connected to the server.

From the Site Map choose Administration - Business Process > Workflow Processes.

Create a new workflow process as shown below and give it a unique name, such as EAITEST.

Incoming >hil UpdateSiabel

4 Select the Process Properties tab and add the following properties:

Default

Data Type String Description

IncomingXML  Binary <Value> In/Out By creating the IncomingXML process
property, anything that is sent as data
will be placed in this variable. This
allows you to then perform a given
action on that data. If the POST method
was used, the data sent in the Body will
be stored in this property. If the GET
method was used, the data sent in the
URL will be stored in this property.

Account Hierarchy - In/Out This is hierarchy format of the incoming
Message XML.
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Default
Name Data Type String In/Out Description
<Value> Binary - In/Out Used to get the XML string that has
been read or converted.
Content-Type  text/html - Out It indicates the content type of the

response body. If you want to see the
response in the same Web page then
you need to set this parameter to text/
html.

5 Set up the first step of the workflow after Start to use the EAl XML Converter with the XML
Document to Integration Object Hierarchy method. This step converts the message, using the
following input and output arguments.

Property Property
Input Arguments Type Value Name Data Type
XML Document Process - IncomingXML Hierarchy
Property

Property Name Type Output Argument

Account message Output Argument - Siebel Message

6 Set up the second step to use the EAI Siebel Adapter with the Insert or the Update method and
the following input and output argument to update the Siebel Database.

Input Arguments Type Value Property Name Property Data Type
Siebel Message Process Property - Account Message Hierarchy

Property Name Type Value Output Argument
<Value> Literal <h1l>Update Completed</h1> -

NOTE: The HTTP response for inbound requests is determined by looking at the <Value> portion
of the output property set. HTTP response headers can be set by setting properties on the output
property set.

7/ Save your workflow process and test it using the Workflow Simulator.

92 Transports and Interfaces: Siebel Enterprise Application Integration
Version 7.8, Rev. A



ansport = Handling EAlI HTTP Transport Business Service Errors

Handling EAlI HTTP Transport Business
Service Errors

A business service that is called by the EAI HTTP Transport might return an error when standard HTTP
headers are used to send error information back to the caller. Each of the headers has a sequence
number at the end to support the return of multiple errors. The text of each error message is
captured in the Siebel-Error-Message header, and the Siebel error symbol is set in the Siebel-Error-
Symbol header as shown below.

Siebel-Error-Message-1: Error: error message text

Siebel-Error-Symbol-1: ERR_SYMBOL

Siebel-Error-Message-n:
Siebel-Error-Symbol-n:

Inbound HTTP also returns HTTP Error 500 (Internal Server Error) to indicate that there was an error
from a business service. The error headers should then be examined for additional error information.

NOTE: To troubleshoot an Inbound HTTP request, run the Siebel Workflow Simulator or Business
Service Simulator.

Processing and Sending Outbound XML
Documents

This section explains how to use Siebel Tools and the Siebel application to set up the EAI HTTP
Transport to process and send outbound XML documents. When you want to send XML messages
based on Siebel integration objects to an external system across Internet-support protocols, you use
the EAI HTTP Transport business service.

Controlling the Behavior of EAlI HTTP Transports
You can specify the parameters that control the behavior of transports in the following order:

B Specifying Parameters as Business Service User Properties on page 93.
B Specifying Parameters as Subsystem Parameters on page 94.

B About Parameters as Run-Time Properties on page 95.
|

About Parameters in Parameter Templates on page 95.

Specifying Parameters as Business Service User Properties
You specify parameters as business service user properties in Siebel Tools. These parameters go into
effect when you have compiled the .srf file. When using this method, keep the following in mind:

Transports and Interfaces: Siebel Enterprise Application Integration 93
Version 7.8, Rev. A



EAIl HTTP Transport & Processing and Sending Outbound XML

B These parameters stay in effect as long as you continue to use the same .srf file and do not
recompile it with a newer specification for the business service parameters.

B If you define the same parameter as a subsystem parameter or as a run-time property, the
subsystem parameter or run-time property overrides any values you have defined in Siebel Tools
and compiled into the .srf file.

Specifying Parameters as Subsystem Parameters
You can specify parameters on either the client side or the server side, depending on whether you
use the client or server version.

To specify the parameters on the Siebel Dedicated Web Client
1 Using a text editor, create the following section in the proper .cfg file, such as siebel.cfg.

2 Add a [HTTPSubSys] section in the configuration file.
3 Add Name=Value pairs for each parameter, as follows:

HTTPRequestURLTemplate="http://www.anyURL.com"
HTTPRequestMethod=""GET"

Save the file and exit the text editor.

5 In the workflow process, specify HTTPSubSys in the Connection Subsystem parameter value.

To specify the parameters on the Siebel Web Client

1 Start any Siebel Business Application and navigate to Site Map > Administration - Server
Configuration > Enterprises.

2 In the top list applet, select the Enterprise Server that you want to configure.
3 In the middle applet, click the Profile Configuration tab.
Click New to create a new component profile and set the following parameters:
a  Profile = HTTP_test
b  Alias = HTTP_test
C  Subsystem Type = HTTPSubSys

5 In the Profile Parameters list applet (the bottom applet), specify the parameters required for the
type of operations the subsystem will need to support:

a HTTPRequestURLTemplate = "http://www.anyURL.com"
b HTTPRequestMethod = "GET"

Then, in the workflow process on the Siebel Web Client, you will specify the Connection Subsystem
input argument to the HTTP Transport, and the value will be the named subsystem that you created.
For the case above, it will be HTTP_test. You can run the workflow process in Simulator using the
Siebel Web Client.
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About Parameters as Run-Time Properties

You specify HTTP parameters as run-time properties by passing them as values in an input property
set to the EAI HTTP Transport business service. You can pass the values to the business service by
way of a workflow or through a program that calls the EAlI HTTP Transport business service directly.

NOTE: Subsystem parameters take precedence over run-time parameters.

About Parameters in Parameter Templates

Parameter templates allow you more flexibility in specifying parameters. You can use variables to
specify certain elements of a given parameter value. The following example shows how to specify a
variable for a login password, rather than hard-coding a password into the parameter.

HTTPLoginURLTemplate = http://www.srvr.com/login?Username=ronw&Password=$PW0$
where
PWD = 421ax7

The business service, EAl HTTP Transport in this case, receives the parameter template. The token,
shown above as $PWDS$, indicates that the business service should look for a parameter called PWD
from a user property or run-time parameter. Dollar signs ($) delimit the token in the template
definition. The token specifies the actual password variable. The token is case-sensitive—Pwd is
different from PWD or pwd.

The token must be defined as either a business service user property or as a run-time parameter in
the input property set. For example, you could specify the HTTPLoginURLTemplate as a user property
of the business service, and username and password as run-time properties. Any logins that specify
the template will always use the same template, but different users can specify unique user names
and passwords at run time.

Sending and Receiving Messages with
the EAlI HTTP Transport

You can use the EAI HTTP Transport to send and receive messages. The following procedure
illustrates how you can use EAIl HTTP Transport with the SendReceive method to query employee
information from the Siebel Database, send it out, echo it using the Workflow Utilities ECHO service,
and send it back to the workflow to write the response back to a file.

To create a workflow process to send and receive messages

1 Create a named subsystem HTTPsendreceive_conn for subsystem HTTPSubSys using the
following lines:

HTTPLoginMethod=GET

HTTPLoginURLTemplate="http://smthpal2.siebel.com:16007/eai_enu/
start.swe?SWEExtCmd=ExecutelLogin&SWEExtSource=MyEcho&UserName=SADMIN&Password=db2”

HTTPLogoffMethod=GET
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HTTPLogoffURLTemplate="http://smthpal2.siebel .com:16007/eai_enu/
start.swe?SWEExtCmd=Logoff"

HTTPRequestMethod=POST
HTTPRequestURLTemplate="http://smthpal2.siebel.com:16007/eai_enu/start.swe"

2 Create a named subsystem MyEchoSubsys for subsystem EAlTransportDataHandlingSubsys
using the following lines:

DispatchService="Workflow Utilities”
DispatchMethod=ECHO

3 In your eai.cfg file, add the following line in the [HTTP Services] section:

MyEcho = MyEchoSubsys

4 Log in to the Siebel client as an administrator connected to the server.
5  From the Site Map choose Administration - Business Process > Workflow Processes.

6 Create a new workflow process as shown below.

Start Set | ] Caonvert to | Send and | ] Wirite ta
a Employes AL Recaive File

7 Select the Process Properties tab and add the following properties.

Default

Data Type String
Employee Message Hierarchy In/Out -
Employee XML Binary In/Out -
Error Code String In/Out -
Error Message String In/Out -
Object Id String In/Out 1-548
Response Binary In/Out -
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8 Retrieve employee message using the EAIl Siebel Adapter with the Query method to query the
information from the database using the following input and output arguments.

Property Property
Input Arguments | Type Value Name Data Type
Output Integration Literal Sample - =
Object Name Employee
Object Id Process Property - Object Id Sting
Property Name Type Value Output Argument
Employee Message Output Argument - Siebel Message

9 Convert the message to XML using the EAl XML Converter with the Integration Object Hierarchy
to XML Document method and the following input and output arguments to convert the message.

Property Property
Input Arguments Type Value Name Data Type
Siebel Message Process Property - Employee Hierarchy
Message

Property Name Type Value Output Argument

Employee XML Output Argument = XML Document

10 Send and receive the converted XML message using the EAl HTTP Transport with the Send and
Receive Response method and the following input and output arguments.

Property Property

Input Arguments | Type Value Name Data Type
Message Text Process - Employee String

Property XML
Connection Literal HTTPsendreceive conn - -
Subsystem
Property Name Type Value Output Argument
Response Output Argument - Message Text
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11 Write the message to the file using the EAI File Transport with the Send method and the following
input arguments.

Input Property Property
Arguments Type Name Data Type
Message Text Process Property - Response Binary

File Name Literal C:\SendRec.txt - -

12 Save your workflow process and test it using the Workflow Simulator.

Examples Using HTTP Request

This section provides you with a couple of examples of using the EAlI HTTP Transport in two modes—
Session and Sessionless. This is to help in understanding how to use the EAlI HTTP Transport in your
business.

Controlling Login Sessions with Session Mode
The session mode allows control over login sessions. In this mode you log in first and open a session.
Any message can be exchanged without having to log in again until you explicitly log off.

The following example shows parameters for Login, Request, and Logoff in a session mode HTTP
request. Session cookies are required in a case such as this.

NOTE: You enter each of the following URLs as a continuous line of code.

B The following URL logs in to a server with passed parameters for username and password:

HTTPLoginURLTemplate = *‘http://$ServerPath$/
start.swe?SWEExtSource=$Source$&SWEExtCmd=ExecuteLogin&User
Name=$Username$&Password=$Password$"

B The following URL passes a query string as the SWEExtData value along with the GET request:

HTTPRequestURLTemplate = "http://$ServerPath$/start.swe?SWEExtData=<Prop>somedata</
Prop>
HTTPRequestMethod="GET”""

B The following URL logs off from the server:
HTTPLogoffURLTemplate = "http://$ServerPath$/start.swe?SWEExtCmd=Logoff""
ServerPath = "siebell/eai”
Username = "pdavis"
Password = "1234abcd"

Source = "testdoc"
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In the preceding example, the ServerPath variable value of siebell/eai is substituted for the token
$ServerPath$. The Source variable value of testdoc is substituted for the $Source$ token, the
Username variable value of pdavis for the token $Username$, and the Password variable value of
1234abcd for the $Password$ token.

Any XML document represented by the entry for SWEExtData can be put into the body. This would
change the sample code so that the HTTPRequestURLTemplate would read as:

HTTPRequestURLTemplate = "http://$ServerPath$/start.swe?

Sending Requests in Sessionless Mode

The following example includes a Request Method, a Request, and a Login for a sessionless mode
request. In this example, the request is simply passed to the secure server using the POST
command. Unlike the Session Mode example, this request sends data in the body of the request. This
request does not require cookies.

HTTPRequestMethod = ""POST"

HTTPRequestURL Template = "‘https://accounts.mypartner.com/server/login_asp"
HTTPRequestBodyTemplate = "Acct=ABCIntl&User=%Username$&pwd=$Passwords$"
Username = "acctuser"

Password = '"123456789abcdefg"

Accessing a URL Protected by Basic Authentication

You can use basic authentication with the EAl HTTP Transport to send messages. The format to use
in the URL to be able to access a URL protected by basic authentication with HTTP Outbound is:

http://username: passworddhost/ rest of the URL
For example, "http://Administrator:manage@169.254.85.21:5555/.""

NOTE: For outbound HTTP requests only server-side authentication is supported.

Creating Custom Headers for the EAI
HTTP Transport Service

Custom headers can be created when sending a request through the EAlI HTTP Transport service
using a script or a workflow process.

To create custom headers for the EAI HTTP Transport service
B Create a new input property in the input to the HTTP transport.

The name of the property needs to have a prefix of HDR, followed by the desired name of the
http header. For example:
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HDR . CustomHttpHeader

httpInPS.SetProperty("'"HDR.CustomHttpHeader", "MyValue™);
httpSvc. InvokeMethod('SendReceive™, httpln, httpOut);

A custom HTTP header with a name of "CustomHttpHeader", and a value of "MyValue" is the result.

About Sending and Receiving Messages
through HTTP

To send and receive messages through HTTP, you need to set up a workflow with the SendReceive
method.

The Receive part of that method receives the response in an output argument of that method. You
can then use the response to perform an upsert using an integration object and EAI Siebel Adapter,
or display the response to your user. In this scenario, none of your quote integration design uses the
eai.cfg or the SWE. You are performing an outbound HTTP call and waiting for a response
synchronously.

You can then communicate the response to the user by displaying the returned error message in a
browser alert or use the new User Interact step of the Workflow Process to refresh the view and show
any new updates to fields to the user. The User Interact step can run synchronously or
asynchronously, in the local Object Manager or on the server.

About Transport Headers and HTTP
Response Headers

This section describes how transport headers and HTTP response headers work with HTTP Transport
(outbound) to form a cookie handling system. HTTP Transport handles the cookie it receives from the
server by storing and then creating a valid request transport header that it sends back to the server
as a part of the request.

By exposing all the HTTP response headers as a part of output property set, you will be able to handle
the response accordingly. You can have all the HTTP response headers, as well as HTTP Status code,
as part of the output property set.

Transport headers are preserved across various connections and are a part of the transport service
and not the HTTP connection.

Transport headers have the following features:
B Every connection has its own transport header.
B The transport header will separately store each cookie sent by the server during a connection.

For example, each name, domain, value pair, along with path, and other attributes (if present)
are stored as a separate cookie in the transport header.
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B Each cookie in the transport header has a distinct name.

Two cookies with the same name cannot be present in the transport header at the same time.
The second cookie will overwrite the first one. Therefore, since the transport header is
implemented as a CSSMapStringToPtr class, each cookie is hashed in the transport header based
on its name.

B The transport header classifies cookies into two categories:
m  Type HTTP Version 1 and above.
m  Preliminary Netscape cookie spec type.

B  When a ToString function is called on the transport header, it scans through the header and
collects all the cookies in the header and creates a request transport header (based on the cookie
category).

The transport header is cleared when the connection is terminated.

During SendReceive, the HTTP response has HTTP headers associated with it. Expose those
response HTTP headers as properties of the output property set.

All these HTTP header properties are distinguished from other properties by appending the prefix
HDR. in front of the property (header) name.

B Also, HTTP Status code for the HTTP request sent by way of EAl HTTP Transport is exposed as a
property in the output property set. The property is called StatusCode.

EAI HTTP Transport Method Arguments

EAI HTTP Transport methods take the arguments presented in Table 16.
B A box (H) in the “S” column means the parameter is required for session mode.

B A box in the “SL” column means the parameter is required for sessionless mode.

Table 16. EAI HTTP Transport Send and SendReceive Arguments

Display

Parameter Name S SL Description

<Value> User-Defined Input and Output data passed as a
Message string. This is the value stored in the
Text Value field of the property set, either

input or output. If you specify the
HTTPRequestBodyTemplate, the
<Value> parameter is ignored and the
HTTPRequestBodyTemplate parameter
is used instead.

HTTPRequestURLTemplate Request URL | B | Template for the request URL, which is
Template the address to which the data is sent
or from which a response is
requested.
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Table 16. EAI HTTP Transport Send and SendReceive Arguments

Display

Parameter Name Description

HTTPRequestMethod Request | | HTTP method to use with the data
Method request, such as Post and Get.

HTTPRequestBodyTemplate Request HTTP Body to use with the POST
Body method. This overrides any body
Template specified in the Value field of the input

property set.

HTTPLoginURLTemplate Login URL | Template for the URL used for the

Template login operation. This operation is

separate from the request operation
and assumes communication mode is
session mode. If there is a separate
login, one or more request and
response messages are expected.

HTTPLoginMethod Login Method | B HTTP method to be used for logging
in. If no Login Method is specified, this
parameter defaults to the
HTTPRequestMethod value.

HTTPLoginBodyTemplate Login Body | Specifies the HTTP request body that
Template should be used when
HTTPLoginURLMethod is POST. By
putting login information into the
HTTP body (as opposed to putting it
into the URL) for sending, this method
provides stronger security than
sending the login information in the
URL. Generally, the login parameters
in a login query are specified in the
body of the request that uses the
POST method. This is required for
session mode only if the
HTTPLoginMethod parameter is set to

POST.
HTTPLogoffURLTemplate Log Off URL | Template for the URL that is used for
Template the logoff operation. This operation is

separate from the request operation
and assumes that the mode of
communication is session mode. If
set, the logoff operation will be
completed. Otherwise, logoff is
skipped. The purpose of the logoff
operation is to end a session that was
started with the corresponding login.

102 Transports and Interfaces: Siebel Enterprise Application Integration
Version 7.8, Rev. A



I HTTP Transport & EAl HTTP Transport Method Arguments

Table 16. EAI HTTP Transport Send and SendReceive Arguments

Display
Parameter Name Description
HTTPLogoffMethod Log Off Defaults is HTTPLoginMethod. HTTP
Method method to be used for logging off.
HTTPAccept HTTP Accept Default is text/*. The explicit value for
the Accept: header to override the
default. Specifies the MIME types
accepted by the sender.
HTTPContentType HTTP Default is application/xxx-form-
Content Type urlencoded. The explicit value for the
Content-Type: header to override the
default. Specifies the type of data sent
in the body of the request.
HTTPUserAgent HTTP User Default is Mozilla/4.0. The explicit
Agent value for the User-Agent: header to
override the default. Specifies the
name/version of the client program.
HTTPMaxIldleSeconds Max Idle Maximum number of seconds to allow
Seconds connections to be idle. After the
elapsed max idle time, the connection
is invalidated and restarted.
HTTPAIllowCaching Allow Default is N. By default, the responses
Caching for specific URL addresses are not

cached by the EAI HTTP Transport. Set
this flag to Y to enable caching.

Note that this can lead to undesirable
side effects, as old data from earlier
requests can be exposed from the
cache buffer.
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Table 16. EAI HTTP Transport Send and SendReceive Arguments

Display
Parameter Name S SL Description

HTTPAIllowPersistentCookies Allow Default is N. A session cookie is used
Persistent to tie requests and logoff operations
Cookies to the user session started at the
login, when communicating with any
session-cookie-based system. Leaving
this flag set to N leaves the
persistence of cookies in the control of
the EAI HTTP transport, which is the
default behavior.

All session cookies persist in memory
only as long as the current session.
Session cookies are not written to
disk.

If you want to use persistent cookies—
that is, if persistence between logins
is required and you want cookies
written to disk and then set the
parameter to Y.

HTTPIsSecureConn Is Secure Default is N. If set to N then the
Connection security mode defaults to whatever
the URL specifies, either HTTP or
HTTPS.

Setting this parameter to Y enables
the Secure flag for SSL
communications; thus, it forces the
use of secure mode.

If you choose to use SSL encryption,
you must establish valid certificates
and SSL capabilities on both the client
and server.

Using the HTTPS: designation in an
URL, by default enables the Secure
flag and specifies clear text
unencrypted communications.

HTTPNoAutoRedirect No Auto Default is N. This means auto-redirect
Redirect is enabled. Setting this parameterto Y
disables auto-redirection of messages
to other URLs.
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Table 16. EAI HTTP Transport Send and SendReceive Arguments

Display
Parameter Name S SL Description
HTTPSleepTime Sleep Time Default is 120000 milliseconds. The
timeout interval on login, send, and
logoff requests in milliseconds.
HTTPImplicitCharsetDetection | Implicit Default is False. This is implicit
Character character set detection for incoming
Set data and should not be set to True for
Detection self-describing documents like XML. If

set to True, this overrides the
CharSetConversion parameter.
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This chapter discusses the EAl DLL and EAI File Transports and includes the following topics:
B “About EAI DLL Transport” on page 107
B “About the EAI File Transport” on page 109

About EAI DLL Transport

You use the EAI DLL Transport when you want to call a function that exists in an external DLL. You
must know the exported function in the DLL that you want to invoke. You specify the EAIl DLL
Transport as one of the business services in your workflow.

NOTE: The EAIl DLL Transport only accepts String type as input or output to the external DLL. The
external function also must return String type.

Configuring the EAI DLL Transport
The EAI DLL Transport supports sending messages with the following methods:
B Send

B Send and Receive Response

About EAI DLL Transport Parameters

Use the Send or Send and Receive Response methods as needed when you want to pass data from
the Siebel Database to an external system. These methods require an input property set. In addition
to the common parameters described in Chapter 2, “EAIl Transports and Interfaces Overview,” the EAI
DLL Transport takes the parameters presented in Table 17.

Table 17. EAI DLL Transport Parameters

Argument Description

DLLName Name of the (request/response) DLL.

ExternalFunction Function in the DLL to invoke.

Return Value The return value from the function called. This value is an output
property.
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To call a function in an external DLL
1 Create a workflow process.

NOTE: For details on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

2 Set the first business service, after the Start, to use the EAl DLL Transport. Usually, this object
is named Send.

3 Double-click to set the input properties for the EAl DLL Transport.
4 Select a method, either Send, or Send and Receive Response.

5 Select the input arguments that you want to use from the list, as presented in Table 17 on
page 107.

6 Enter any output arguments required and save your work.

Creating a DLL to Call a Function in an External DLL

Following procedure illustrates how to create a DLL to use the EAl DLL Transport business service to
call a function in an external DLL.

Starting in release 7.5.3, it is not necessary for the DLL to release the memory either on Microsoft
Windows or UNIX. The DLL transport business service will release the memory. If the DLL does a
memory deallocation, it will most likely crash. The basic assumption is that the DLL must do the
memory allocation with a C-style malloc only. Any other type of allocation will not be handled
properly and may even lead to crashes.

To make a DLL
1 Open a VC++ project (Open > New).

2 Select a Win32 Dynamic Link Library and give the name of the project.
3 In the next dialog box, select the option Simple dll project.

Following files are created by default:

® Project.cpp

m  StdAfx.h

m  StdAfx.cpp

4 Make the following changes in the StdAfx.h and Main.cpp files and check the results in the
process simulator.

StdAfx.h
struct XMLDataBuf
{
int nLength;
void* pData;
}:
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extern "C" int __declspec(dllexport) TestEAl(const XMLDataBuf* Value, XMLDataBuf*
pReply);

Main.cpp

#include "stdafx.h"

#include <string.h>

#include <stdio.h>

#include <io.h>

BOOL APIENTRY DIIMain( HANDLE hModule,
DWORD ul_reason_for_call,
LPVOID IpReserved

)
{
return TRUE;
}
extern "C" int __declspec(dllexport) TestEAl(const XMLDataBuf* Value, XMLDataBuf*
pReply)
{
FILE *p;
p = fopen(c:\\test._txt","w");
fprintf(p, before test");
fprintf(p,"%s After Test",Value->pData);
//strcpy(s,"Hello World™);
fclose(p);
return O;
}

About the EAI File Transport

The EAI File Transport helps move data between a Siebel application and an external file.

NOTE: The EAI File Transport is different from EAl XML Read from File. The EAl XML Read from File
uses a Siebel Message in Hierarchical format as the output property. When reading in data, the EAI
File Transport uses a process property with Data Type of Binary as the output property by default; if
CharsetConversion is set, it uses a string output property instead.

Configuring the EAI File Transport

The EAI File Transport supports two transport modes: Sending Messages and Receiving Messages.
Each supports the following methods:

B Send B  Receive
B Send and Receive Response B Receive and Execute Service
B Receive, Execute, Send Response
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Using the EAI File Transport Methods

You create a workflow to use the EAI File Transport, defining and refining the workflow as needed to
meet your unique business requirements.

To create a workflow using the EAI File Transport
1 Create a workflow process in the Siebel application.

NOTE: For details on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

2 Set up a step in the workflow to use the EAI File Transport. Usually, this object is named Send.

3 Double-click to set the input properties for the EAI File Transport.

4 Select a method that fits your business needs.

5 Select the input arguments that you want to use from the list of arguments. The full list is
presented in Table 18 on page 111.

6 Enter any output arguments required and save your work.

Generating Unique Filenames

When using the EAI File Transport, you can have the system generate unique file names for you, as
needed. One way is to specify the directory name only. The other way is to include $$ in the filename.

NOTE: If a directory is not specified when using the EAl XML Write to File, EAl XML Read from File,
or the EAI File Transport business service, the FileName input argument defaults to the directory
where the Siebel application is running.

Directory Only. To generate the unique file name, only enter the directory name. For example,
instead of specifying the filename as d:\data\recordl.xml, just specify d:\data. For every call of the
Workflow Process, a unique name is generated in the directory. To find out the file name generated,
specify FileName as an output argument for the File Transport Workflow Step.

Using $$. For generating filenames based on the $$ wildcard, specify the filename in the form
d:\data\record$$.xml. At run time, Siebel application replaces the $$ with a unique row-id—for
example, d:\data\record3-149.xml.

NOTE: The file name generated by using $3$ is not returned as the output filename property.
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EAI File Transport Parameters

In addition to the common parameters presented in Chapter 2, “EAl Transports and Interfaces
Overview,” the EAI File Transport takes the parameters presented in Table 18. These parameters can
be specified as service method arguments, subsystem parameters, or user properties.

Table 18. EAI File Transport Parameters
Display Name Argument Description

Append To File AppendToFile Default is False. A value of True means that if
the file exists, the method appends the
message to the existing file. A value of False
specifies that the method should overwrite any
existing file.

Delete File after DeleteFile Default is False. A value of True means that an
Receive attempt is made to delete the file after
receiving it. If permissions prevent deletion, no
error is given, but the information is traced.

File Name FileName The name of the file to be received by the file
transport.

For the Send method, if a file name is not
provided, a random name is used for the output
file. You must specify an explicit path for file
name. You can also use $$ as the wildcard
symbol in the file name. For example, if you
specify a file name of “file$$.xml,” then Siebel
creates files like filel1-134.xml, fileA25.xml,
and file242_12B.xml.

For the Receive method, a specific file name
must be provided. The use of wildcards such as
$3$ is not allowed. The source file is deleted
upon receiving if set to True. If set to False (the
default), the source file is not deleted.

Response File RespFileName Name of the file containing the response when
Name using the SendReceive Method.
Sleep Time FileSleepTime The timeout interval on receive calls, in

milliseconds.

This specifies the maximum amount of time
that the service waits for a response. Default is
20000 milliseconds.
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The Siebel OLE DB Provider conforms to Microsoft’s OLE DB data access specifications and provides
a unidirectional method for retrieving data from the Siebel Database and viewing it in any supported
OLE DB-enabled application.

This chapter includes the following topics:

B “About Microsoft OLE DB” on page 113

B “About the Siebel OLE DB Provider” on page 113

“About the Software Architecture for the Siebel OLE DB Provider” on page 114
“Installing the Siebel OLE DB Provider” on page 115

“Connecting Siebel Data Using OLE DB Consumers” on page 120

“How Scripts and Custom Applications Affect Your Data” on page 127

“Troubleshooting OLE DB” on page 138

About Microsoft OLE DB

Microsoft’s OLE DB provides applications, compilers, and other database components access to
Microsoft and third-party data stores. OLE DB defines interfaces for accessing and manipulating
every type of data. These interfaces are used both by data consuming applications and data
providing applications.

An OLE DB Consumer is any application that can access OLE DB Providers and display the data as
embedded objects, which retain their original format and links to the application that created them.
OLE DB Consumers are also known as external OLE DB-enabled applications.

About the Siebel OLE DB Provider

Siebel OLE DB Provider is a set of interfaces that allow you to access the Siebel business object layer.
Using Siebel OLE DB Provider technology, you can build ad hoc queries, use third-party business
analysis tools, and build Web applications that access business-critical information from Siebel
Systems. Access to this information is essential for providing excellent customer service and making
intelligent business decisions.

OLE DB consumers can access data stored in the Siebel Database by referring to Siebel objects such
as Contact or Account, without having to perform mapping tasks between the Siebel Data Model and
the external application. Siebel OLE DB Provider is integrated with Siebel Tools, allowing
management and configuration of the Siebel business components that are exposed to the client
application as OLE DB tables.
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Provider

Most third-party business intelligence tools provide powerful Web-based ad hoc query tools that let
you access, navigate, and explore relational data to make key business decisions in real time. This
insight helps companies improve target marketing efforts and forge closer, more responsive,
relationships with customers.

For example, your job might require forecasting sales opportunities. Using a third-party query and
reporting tool such as Seagate’s Crystal Reports, you could retrieve opportunities from Siebel
Systems’ operational data store using Siebel OLE DB Provider. You could even create a
heterogeneous query across multiple data stores to get the level of detail required to make better
business decisions.

As another example, you could determine the success of your Web marketing campaign by evaluating
the number of hits your Web site received last month, last week—even today—and contrast that
information with the number of products (or services) purchased.

You might also have a portal where customers can look up outstanding orders, and service requests.
Using Siebel OLE DB Provider invoked from an ASP file on a Windows Server, the Siebel System
Administrator could expose the orders and service requests, and the Web Developer could create a
Web-based query which would:

B Gather information on orders and service requests from the Siebel application

B Populate a customized view of outstanding information related to the customer

About the Software Architecture for the
Siebel OLE DB Provider

The Siebel OLE DB Provider is a read-only object that exposes Siebel business components as virtual
OLE DB tables. You can connect to the Siebel OLE DB Provider by way of external OLE DB-enabled

applications—for example, from OLE DB Consumers including Microsoft Excel and Microsoft Access—
and view data dynamically, as it is queried from your Siebel Database, within pivot tables, charts, or
other appropriate data controls.

Using Siebel Tools, you define Siebel OLE DB rowsets to be queried against. These rowsets are an
extension to the integration objects available within Siebel Tools. Siebel OLE DB Provider must be
installed on the system that executes the queries. This does not mean that a Siebel client or the
Enterprise Server must be running on this same system, but that they be accessible on the network.
You can use Siebel OLE DB Provider to use your Siebel data in two ways: either through the use of
existing OLE DB consumers, such as Microsoft Excel and Access, or through applications and scripts
you write. With either method, Siebel OLE DB Provider works in the following scenarios:

B Windows Client. You can query Siebel OLE DB rowsets using third party business intelligence
tools such as Microsoft Office or Cognos.

NOTE: Siebel OLE DB Provider must be installed on the Windows Client to gain access to the
defined OLE DB rowsets.
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B Windows Server. Using a third-party business intelligence tool such as Seagate’s Crystal
Reports or Cognos allows for the distribution of Siebel OLE DB rowsets through their query and
reporting interface. You can add predefined queries or reports to the Siebel client Reports Menu
using the Siebel Tools Reports Administrator.

NOTE: Siebel OLE DB Provider must be installed on the I1S system in order to gain access to the
defined OLE DB rowsets.

B Siebel Web Client, Mobile Web Client, and Dedicated Web Client. As noted previously,
using a third-party business intelligence tool installed on Windows Server is used to output to
these clients.

Figure 1 illustrates the architecture of the Siebel OLE DB Provider.

0 H@-— O

Siebel Weh Client Siebel Mobile Web Client S0L Server
OLE DB Consumer loads OLE DB OLE DB Consumer loads OLE DB SQL Semwer isthe OLE DB Siebel Dedicated
Provider DLLs fram the local Siebel Prowider DLLs from the local Siebel Consumer and loads the OLE DB Weh Client

Installation. The OLE DB Provider DLLs  Installation. The OLE DB Provider DLLs F'_m\rid_el DLLs, which communicates running QUEI’}-‘.-’AHEWZEI’
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Figure 1. OLE DB Providers and Consumers of Siebel Data

Installing the Siebel OLE DB Provider

You can install the Siebel OLE DB Provider standalone from the Siebel Server CD-ROM. By selecting
the custom EAI installation, you can install the OLE DB Provider as a stand-alone client.

Siebel OLE DB Provider must be installed on the same system where the OLE DB Consumer has been
installed. The DB Consumer can be installed on either the Siebel Server or one of the Siebel Web
Clients.
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To use Siebel OLE DB Provider with Microsoft SQL, the full version of Microsoft SQL Server must be
installed and operational. To create an Active Server Page (ASP) application, the Siebel OLE DB
Provider and Microsoft 11S must be installed and operational.

The OLE DB Consumer used depends on how the Siebel OLE DB Provider is accessed:

B  When accessing the Siebel OLE DB Provider from ASP pages (this includes access from the client
application Internet Explorer or other Web browser), IIS is the OLE DB Consumer.

B When accessing the Siebel OLE DB Provider from SQL Server (this includes access from the client
application Query Analyzer), SQL Server is the OLE DB Consumer.

B When accessing the Siebel OLE DB Provider from Excel or Access, Excel or Access is the OLE DB
Consumer.

The Siebel OLE DB Provider is installed as a default interface within the Siebel Mobile Client and the
Siebel Server applications. You can also install this on different systems using the custom EAI install
from Siebel Server. The Siebel OLE DB Provider supports the following OLE DB and ActiveX Data
Object (ADO) foundation versions:

B Microsoft OLE DB
B Microsoft ADO

The required base-level operating systems validated for the use of Siebel Systems products contain
the necessary foundation versions of OLE DB and ADO to support the Siebel OLE DB Provider. See
the System Requirements and Supported Platforms on Siebel SupportWeb for further information.

This section covers the following topics:
B Configuring and Testing the Siebel OLE DB Provider on page 116
Multiple Language Considerations for the Siebel OLE DB Provider on page 118

B About Primary and Foreign Key Relationships on page 119
B Viewing Siebel OLE DB Provider Events on page 119
B Viewing Siebel OLE DB Information on page 120

Configuring and Testing the Siebel OLE DB Provider

You configure and test Siebel OLE DB Provider using the siebel.udl file that is installed in the
siebeN\bin\language directory. The siebel.udl file appears this way:

[oledb]
; Everything after this line is an OLE DB initstring
Provider=SiebelOLEDB.Provider.1;Persist Security Info=False;
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Table 19 presents the necessary connection properties.

Table 19. Siebel OLE DB Provider Connection Properties

Property Description

Data Source Name | The connection string as explained in Using Siebel Tools.

In the .cfg file, make sure the DataSource property in the [Siebel] section
is set for the local client using Local, Sample, or Server—for example, set this
property to Sample for the sample database.

User ID Your Siebel user ID.

Password Your Siebel password.

When you have entered these values, test the connection to the data source by clicking the Test

Connection button on the Microsoft Data Link Properties dialog box. If the connection is valid, you
receive a confirmation. If you receive a successful connection confirmation, you can use the same
data source name with any OLE DB-enabled application to connect to the Siebel OLE DB Provider.

About the Siebel OLE DB Provider in the Server Connected Mode

In the server connected mode Siebel OLE DB Provider uses the Siebel Web client to communicate
with the rest of the Siebel environment. In this mode, the Data Source name defines the connect
string that is used by the Siebel Web client to connect with the Siebel Gateway. A sample Excel query
that uses Siebel OLE DB provider in Server mode follows:

QueryType=0LEDB
Version=1

Connection=Provider=SiebelOLEDB.Provider.1;Password=SADMIN;

Persist Security Info=True;User ID=SADMIN;

DataSource=Gateway machine name,name of the Enterprise,name of the Object
Manager, name of the Siebel Server;

CommandType=Default
CommandText=select * from Contact where "Job Title"=Manager

NOTE: There should be no blank lines between commands such as QueryType, Version, and
CommandText. Connection information should be in one continuous line.

Transports and Interfaces: Siebel Enterprise Application Integration 117
Version 7.8, Rev. A



Using Siebel OLE DB Provider M Installing the Siebel OLE DB

About the Siebel OLE DB Provider Local WIN32 Siebel Client Mode

In the local client mode, the Siebel Business Object Manager allows the Siebel OLE DB Provider to
connect to the Siebel application residing on the same machine. In the local client mode, the Data
Source name defines a path to the Siebel configuration file. Table 20 below defines the syntax.

Table 20. Data Source Syntax

String Database

c:\....\siebel.cfg Uses the default database
c:\....\siebel.cfg,Local Uses the local database regardless of the default setting
c:\....\siebel.cfg,ServerDataSrc Uses the server database regardless of the default setting

CAUTION: When you install using the Siebel EAlI Connectors installation option, the Siebel OLE DB
Provider can only be used in the Server Connected Mode. The Local Client Mode is not available.

A sample Excel query that uses Siebel OLE DB Provider in the local client mode follows:

QueryType=0LEDB
Version=1

Connection=Provider=SiebelOLEDB.Provider.1;Password=SADMIN;
User ID=SADMIN;Data Source=c:\Program Files\SiebelApp\bin\siebel._.cfg, lang=ENU

CommandType=Default
CommandText=select * from Contact where "Job Title"=Manager

Multiple Language Considerations for the Siebel OLE DB
Provider

Siebel OLE DB Provider supports multilingual operation. During installation, Siebel OLE DB Provider
sets the language in which it was installed as the default language. However, you can install
additional languages later, with each newly installed language becoming the new default. In order to
use a nondefault language, you need to pass the Siebel OLE DB Provider a language parameter.

NOTE: The language you choose pertains only to the messages displayed. The text that is retrieved
will be in the language in which it was stored.

The following example illustrates this situation.

B Siebel OLE DB Provider is installed with Japanese language support. The default language is
specified as JPN. In that case, the connect string for the Siebel OLE DB Provider is:

siebel://SiebelServer:2321/siebel/SCCObjMgr_JPN

B An additional language, English, is installed and becomes the default language. To use the
Japanese language, the connect string for the Siebel OLE DB Provider would be:

siebel://SiebelServer:2321/siebel/SCCObjMgr, lang=JPN
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About Primary and Foreign Key Relationships

Siebel OLE DB Provider supports Primary and Foreign Keys for creating links between Siebel business
components in a Siebel business object. With Siebel OLE DB Provider, you will be able to determine
the relationships between business objects. Different OLE DB consumers may use this feature in
different ways. For example, Microsoft Access shows Primary and Foreign Keys in a tree pane. You
can use this information to build queries that use relationships between business objects.

NOTE: A Primary Key is a set of fields where there is more than one available key field that can
establish a relationship, but only one of the keys is chosen by the DBA to be the Primary Key. A
Foreign Key is a field whose values are keys in another relationship.

To enable primary and foreign key support
1 Access the Windows Registry and expand HKEY_CLASSES_ROOT.

2 Expand the key CLSID.
3  Expand and highlight the key {84C9F452-1ECC-11d3-9D36-0080C7AAC8AT7}.
The default value should be Siebel OLEDB Provider.
Highlight the key Parameters.
5 Right-click to select New > DWORD Value.
a  Set the Name of the new value to EnablePkFk.
b Set the value in the Value Data field to 1.

6 Select File > Exit to close the Windows Registry and save your changes.

Viewing Siebel OLE DB Provider Events

After you have initiated an OLE DB client to connect to Siebel OLE DB Provider, you can use the
Windows Event Viewer to review the events associated with Siebel OLE DB Provider and troubleshoot
as needed.

To view Siebel OLE DB Provider events
1 Start the Event Viewer.

2 Select the Application Log.
3 Look for events with a source of Siebel OLE DB Provider.

There should be two information events:

m  The first event identifies Siebel OLE DB Provider DLL, ssceolpr.dll and the executable that
loaded the DLL.

m The second event identifies the connection string used.
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Viewing Siebel OLE DB Information

You can verify proper installation and troubleshoot problems with connecting to, or running queries
with, Siebel OLE DB Provider and a Siebel data source.

To view Siebel OLE DB information
1 Using Windows Explorer, right-click on each of the following OLE DB Provider DLLs.

m bin\ssceolpr.dll

m  bin\ssceolwr.dll

E bin\language\ssceolrs.dll
Where:

language is the Siebel code for the Language Pack you are installing for this server, such as
enu for U.S. English.

2 Select Properties from the pop-up menu.
Select the Version tab in the Properties dialog.
4 Verify that the fields have the appropriate values.

NOTE: You can also view this information within Siebel Tools and any COM-related development
tool, such as the Object Browser in Microsoft Visual Studio.

About Siebel OLE DB and Multivalue Fields

Siebel allows you to create rowsets that contain multivalue fields (MVFs). However, when the rowset
is issued in an OLE DB consumer such as MS Excel, only the first child record in the Siebel MVF field
will be returned.

For instance, if you create a rowset based on the Opportunity BC and you add the Product MVF to
the rowset, when you use the rowset in MS Excel only one record will display for each opportunity.
The Product field or column will contain only the first product in the Multivalue fields list of products
for the opportunity.

Connecting Siebel Data Using OLE DB
Consumers

You can use existing OLE DB Consumers to connect to a Siebel OLE DB rowset that you create using
Siebel OLE DB Rowset wizard. This wizard helps you create an integration object that interfaces to
Siebel business objects. For example, if you want to display data about accounts in Microsoft Access
to take advantage of its graphical reporting tools, you specify the Account business object when
creating Siebel OLE DB rowset. The wizard creates an integration object that, in effect, translates
data from the Siebel business object format into data in the OLE DB rowset format.

Siebel OLE DB Provider for Siebel EAl supports four preconfigured applications as OLE DB
Consumers:
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B Microsoft Excel

B Microsoft SQL Server

B Microsoft Access
NOTE: Microsoft Access XP is not supported as a Siebel OLE DB Provider.

This section explains how to use the Siebel OLE DB Provider with these applications. After you have
installed Siebel OLE DB provider library files and created your OLE DB rowsets within Siebel Tools,
you are ready to use Siebel data within the framework.

NOTE: Siebel OLE DB Provider allows you to retrieve information from the Siebel Database on a
read-only basis. You can review the data and incorporate it into spreadsheets, databases, and Web
pages as needed. You cannot make changes to the data or affect the Siebel Database in any way
with Siebel OLE DB Provider.

Creating and Modifying Siebel OLE DB Rowsets

This section covers creating and modifying Siebel OLE DB rowsets.

The Siebel OLE DB Rowset object is exposed as a Siebel integration object in Siebel Tools. You create
the OLE DB integration object using the OLE DB Rowset wizard.

To create the Siebel OLE DB Rowset object in Siebel Tools
1 Start Siebel Tools.

2 Lock the project from which you will be creating the OLE DB rowset.
3  Choose File > New Object to display the New Object Wizards dialog box.
a  Select the EAI tab.
b  Select the OLE DB Rowset icon and click OK.
4 Select the items from the drop-down lists to define your rowset as follows:
a  Choose the locked project from which you will be creating the OLE DB rowset.

b Choose the Siebel business object that represents the data you want as the basis of your OLE
DB rowset.

The wizard displays the business components that are used by this business object.
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C Choose the business component you want to use to populate your OLE DB rowset with data.

The system automatically generates a unique name for your OLE DB rowset by concatenating
the business object name and the business component name and adding a unique number
(starting with 1), such as Account_Contact_1. You can change this name as needed.

NOTE: Siebel Tools limits this field to a maximum of 75 characters. If the combination of the
business object and the business component names is more than 75 characters, the name

will be truncated, starting from the right. Again, you can change this name as needed. It is
recommended that you use the following: Business Object Business Component_Unique

Identifier

d Choose the Visibility Type for the rowset.

NOTE: You can limit the data users are allowed to see based on their Siebel-defined
responsibility and visibility privileges. Visibility levels can be set for each rowset.

5 Click Next to select the fields you want to include in your OLE DB table. You can select one or
more fields by using the following standard techniques:

m To select a single field, click on a field name, then click the right arrow button to move the
field name to the scrolling field on the right.

m  To select multiple fields, click on a field name, hold down the Ctrl key on your keyboard and
click on another field name.

Repeat this process to select any number of field names. Alternatively, you can click on a field
name, then hold down the Shift key on your keyboard and click on another field name farther
down the list. This selects all the field names between and including your two selections.

6 Rearrange the order of the field names, if necessary, by clicking the up and down arrow buttons
to move a selected field name in one direction or another.

NOTE: Rearranging the field names at this point in the process can make it easier to view the
data in a more meaningful order when you access the OLE DB table from another application.

7 Click Next.

The OLE DB Wizard displays the OLE DB Rowset. This page allows you to review and confirm your
selections.

m To change one or more of your selections, click Back to return to the previous page of the
wizard.

8 If you are satisfied with your choices, click Finish.
The OLE DB wizard creates the OLE DB integration object.
9 Recompile the .srf file.

Siebel OLE DB Provider retrieves integration object information from the .srf file.
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m  Select Tools > Compile (or press F7).

You can now access the Siebel OLE DB integration object using any external OLE DB-enabled
applications.

NOTE: Integration objects are created slightly differently by the OLE DB Rowset wizard than by
any other integration object wizard. In other chapters of this guide, you read that integration
objects provide the interface between external data objects and the Siebel property set format.
The OLE DB Provider integration objects you create convert data between Siebel Business Object
Interfaces and OLE DB rowsets.

To modify a Siebel OLE DB rowset object in Siebel Tools
1 Lock the project from which the OLE DB rowset was originally created.

Access the list of integration objects and highlight the OLE DB rowset you want on the Integration
Objects list.

3 Right-click on the OLE DB rowset you want to modify.
4 Select Edit OLE DB Rowset from the pop-up menu.

The Edit OLE DB Rowset wizard appears, displaying the details on the rowset. This first page is
read only, but it can be changed using visibility rules.

5 Click Next and select the fields you want to include in your OLE DB table and deselect others that
you want to remove.

6 Rearrange the order of the field names, if necessary, by clicking on the up and down arrow
buttons.

7 Click Next to get to the finish page to review and confirm your selections.

m To change one or more of your selections, click Back to return to the previous page of the
wizard.

8 If you are satisfied with your choices, click Finish.
The OLE DB wizard modifies and saves the OLE DB integration object.
9 Recompile the .srf file.
Siebel OLE DB Provider retrieves the integration object information from the .srf file.

You can now access the Siebel OLE DB integration object using any external OLE DB-enabled
applications.

Viewing Siebel OLE DB Rowsets in Microsoft Office
Applications

This section discusses a variety of ways to view information using Microsoft Office applications.
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Business analysts find the Siebel OLE DB Provider support useful for analyzing account data and
other information stored in the Siebel Database and incorporating that data in an Excel spreadsheet.
To use Siebel OLE DB Provider from Excel, you create an external query that connects to Siebel OLE
DB Provider.

To view Siebel data in Microsoft Excel
1 Open Microsoft Excel.

2 Choose File > New to open a new spreadsheet.

3 Create a query using Notepad or any text editor. If you want to use a different data source than
the one defined in the .cfg file you can do so here.

4 Enter the connect string, and any other information.
5 Save your work.

The following example connects to Siebel OLE DB Provider and sends a command to retrieve all
records from the Contact virtual table where the position is equal to Manager. You can store any
query in a *_rqy file and execute the query at a later time.

The properties identify the contents of the file as an OLE DB type query and provide the connection
parameters and query text. The properties QueryType, Version, Connection, CommandType and
CommandText are required. The structure defined is mandatory and cannot be changed.

Table 21 shows the required properties for an Excel query file.

Table 21. Excel Query Properties

QueryType OLEDB.

Version 1.

CommandType Default.

QueryText Set to the text of the query to be executed by the Siebel OLE DB
Provider.

Connection Several parameters, each separated by a semicolon:

B Provider. Set to the Siebel OLE DB Provider COM component,
SiebelOLEDB.Provider.1.

B Data Source. Set to the Siebel OLE DB Provider connection string.

User ID and Password are optional. If not set, OLE DB Provider
prompts for them.

For example:
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QueryType=0LEDB
Version=1

Connection=Provider=SiebelOLEDB.Provider.1;Password=db2;
User ID=SADMIN;Data Source=siebel://10.24.20.5/siebel/sseobjmgr;

CommandType=Default

CommandText=select "City" from Contact Contact_1 where "Bill To City"="Menlo Park"

NOTE: You should not have any blank lines between each commands such as QueryType and
CommandText. Connection information should be on one continuous line.

You can use Microsoft Access to create ad hoc reports. Using the Access Data Access Page Designer’s
drag-and-drop capabilities, you can create Web pages by selecting, dragging, and dropping Siebel
OLE DB tables onto the Access form. The underlying OLE DB infrastructure writes the necessary
information, and the newly created Web page accesses the Siebel virtual table data transparently.

To view Siebel data in Microsoft Access
1 Open Microsoft Access.

2 Choose File > New.

3 On the New dialog box, select the Data Access Page and click OK.
The new Data Access Page dialog box displays.

4 Select Design View and click OK.

The Data Link Properties dialog box displays.

Select the Provider tab.

Select Siebel OLE DB Provider from the picklist and click Next.

On the next page, fill in the parameters, including the Data Source and User name properties.

0o N o O

Click OK to save the changes.
The Siebel OLE DB Provider login dialog appears.
9 Provide the password and click OK.

You are presented with the designer and the Field List dialog box displaying the available
integration objects.

10 Design and save this Web page.

Access this Page View to review the results of the query from the OLE DB Provider.
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Viewing Siebel Data Using Microsoft SQL Server Distributed Queries

In Microsoft SQL Server version 7.0, distributed queries enable SQL Server users to access data
outside a SQL Server-based server, within either other servers running SQL Server or other data
sources that expose an OLE DB interface. OLE DB provides a way to uniformly access tabular data
from heterogeneous data sources.

A distributed query for the purpose of this document is any SELECT, INSERT, UPDATE, or DELETE
statement that references tables and rowsets from one or more external OLE DB data sources.

A remote table is a table that is stored in an OLE DB data source and is external to the server running
SQL Server executing the query. A distributed query accesses one or more remote tables.

Siebel OLE DB provider may be used as one of the data sources in the SQL 7.0 distributed query.

SELECT * FROM
OPENROWSET("SiebelOLEDB.Provider.1", " ConnectString" ;" Userld" ;" Password" ,Siebel OLE
DB Provider query text)

For example:

SELECT * from OPENROWSET("SiebelOLE DB.Provider.1",
"somelhost,siebel ,objmgr,w_name~;

"SADMIN® ; "SADMIN™,

SELECT "First Name, "Last Name"™ from Contact Contact_1 where ("Job Title" =
"Manager')

NOTE: For more information about Microsoft SQL Server distributed queries, please refer to
Microsoft SQL Server 7.0 documentation.

Database administrators (DBAs) find the OLE DB support in Siebel EAIl useful for checking data
integrity in Siebel applications and database-related tasks. With Siebel OLE DB Provider, table, row,
and field information are displayed in the Microsoft SQL Analyzer for review and action.

To view Siebel data in SQL Analyzer
1 Start the Microsoft SQL Server Query Analyzer tool.

2 Connect to an SQL Server on which the Siebel OLE DB Provider has been installed.
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3 Enter the SQL Server query text in the query window, as shown in the following illustration.
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[BELHGDEVD3B WINGK (5.0) sa (64) [master |0:m00:00  [Drows [nS Colls g

| ‘Connections: 1 v

4 Enter a connect string similar to this (providing your actual ID, password, selection criteria, and
SO on):

SELECT * from OPENROWSET("SiebelOLEDB.Provider.1","siebel://10.1.55.16/siebel/
sseobjmgr/blitzlab32";

"SADMIN®; "db2*",

"select "Address ID","Created By","Bill To First Name"™ from test table_ 1 where
"Bill To City"="Menlo Park"")

How Scripts and Custom Applications
Affect Your Data

Siebel OLE DB Provider for Siebel EAIl supports:
B Visual Basic (VB), C**, VBScript, and Javascript
B Active Server Pages (ASP)

This section explains how to use the Siebel OLE DB Provider with these technologies. After you have
installed Siebel OLE DB provider library files and created your OLE DB rowsets as integration objects
within Siebel Tools, you are ready to use Siebel data within the support framework.

NOTE: Siebel OLE DB Provider allows you to retrieve information as needed from the Siebel data
repository on a read-only basis. You can review the data and incorporate it into spreadsheets,
databases, and Web pages, as needed, but you cannot make changes to the data and affect the
Siebel data repository in any way using Siebel OLE DB Provider connection.

This section covers these topics:
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B Writing an OLE DB Consumer
B Retrieving Siebel Data Using VB and ASP on page 130

Writing an OLE DB Consumer

You can write your own OLE DB consumer or access Siebel OLE DB Provider programmatically using
standard programming languages, such as C+ and Visual Basic, or using scripting languages, such
as VBScript and JavaScript.

This section describes the objects and object interfaces provided by OLE DB to facilitate access to
Siebel OLE DB Provider and other OLE DB providers. This is a brief summary of the OLE DB interfaces.
It is intended to identify the support available from the Siebel OLE DB Provider. You can find more
information on the OLE DB interfaces from reference documentation published by Microsoft and
others.

OLE DB Object Support in Siebel OLE DB Provider

The following list summarizes the OLE DB version 2.1 objects that are supported by the current
version of Siebel OLE DB Provider:

B DataSource
B Session

B Command
|

Rowset

About Siebel OLE DB DataSource Object

You can use any OLE DB-compliant products to access Siebel objects. These products include
Microsoft Excel, Microsoft Access, and others. These applications are referred to as consumers. You
must create the DataSource object by defining the object in an OLE DB consumer. During the creation
process, you provide the properties and parameters required for the DataSource object to connect
to the Siebel environment. The consumer then uses the DataSource object to create one or more
Session objects.

The following DataSource object OLE DB interfaces are supported in the current version of Siebel
OLE DB Provider:

B IDBCreateSession
B IDBInitialize

B IDBProperties
B IPersist
|

ISupportErrorinfo
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You must specify DataSource properties to successfully initialize and authorize the connection to the
Siebel environment, as shown in Table 22.

Table 22. OLE DB DataSource Properties

Property ID Description

DBPROP_AUTH_USERID A Siebel user name.

DBPROP_AUTH_PASSWORD The password assigned to the Siebel user.

DBPROP_INIT_DATASOURCE The connect string or the path to the local configuration file.

DBPROP_INIT_PROMPT Default is DBPROMPT_NOPROMPT. Specifies the prompt mode
supported for data source initialization. This provider supports
every prompting mode.

About Siebel OLE DB Session Object

The DataSource object creates and uses the Session object to create one or more Rowset objects.
The following Session object OLE DB interfaces are supported in the current version of Siebel OLE
DB Provider:

B IDBCreateCommand
B IGetDataSource
10penRowset
ISessionProperties

IDBSchemaRowset

ISupportErrorinfo

About Siebel OLE DB Command Object

The OLE DB Command object supports and provides a subset of SQL commands that you can use to
query the Siebel business objects supported by Siebel OLE DB Provider. The OLE DB consumer
creates the Command object by executing IDBCreateCommand:CreateCommand. Multiple
commands can be created and executed during a single session. Siebel OLE DB Provider supports
the following OLE DB interfaces on the Command object:

B IAccessor

B ICommand
ICommandWithParameters
ICommandProperties
ICommandText

IColumnsinfo

IConvertType
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B ISupportErrorinfo

About Siebel OLE DB Provider Command Syntax

Siebel OLE DB Provider Command object supports a subset of SQL, which allows OLE DB consumers
to issue simple query statements against one virtual table.

The following query is an example of the type of statement you can execute:

SELECT "First Name®", "Last Name*
FROM Contact
WHERE "Job Title"™ = Manager;

The general syntax of Siebel OLE DB Provider Command language is as follows:
B Required terms are delimited by square brackets ([ ]).
B Optional terms are delimited by angle brackets (< =).

SELECT [ column/list of columns/* ]

FROM [ table_name ]

<WHERE> [ column = value ] <AND> [ column=value ]
<ORDER BY> [ column ];

NOTE: The current Command language does not support the JOIN construct. A command can be
issued against only one virtual table.

About Siebel OLE DB Rowset Object

The Session object creates the Rowset. The consumer can also call ICommand:Execute to create a
Rowset. The data in the Rowset object is displayed in tabular format. The following Rowset object
OLE DB interfaces are supported in the current version of Siebel OLE DB Provider:

B lAccessor

B IColumnsinfo
IConvertType
IRowset

IRowsetInfo

ISupportErrorinfo

Retrieving Siebel Data Using VB and ASP

You can view Siebel data using Visual Basic. Programmers writing custom VB programs and scripts
that need to access data in the Siebel repository find the Siebel OLE DB Provider support useful for
such tasks.
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To view Siebel data using Visual Basic

1
2

Start Microsoft Visual Basic.

Enter code similar to the following example (providing your actual 1D, password, selection
criteria, and so on):

"This program will connect to the Siebel OLE DB Provider, retrieve data and save
“the records in a file with tab separated fields. Other tools can then be used to
"further process the data.

Dim Fso, File

"Setup program parameters.

ProviderString = ""SiebelOLEDB.Provider.1"

DataSourceString = "siebel://MyGateway/MyEnterprise/MyObjMgr/MyServer"*
UserldString = "MyUserld"

PasswordString = "MyPassword"

OutFileString = "output.txt"

"Build the connection string.

ConnectString = "Provider=" & ProviderString & '";User ld=" & UserldString &
"";Password="" & PasswordString & '';Data Source=" & DataSourceString & ";"

"Ask the user if they are ready to establish a connection and retrieve the data.

Message = ""Ready to connect using" & Chr(13) & Chr(10) & ConnectString & Chr(13) &
Chr(10) & "Do you want to continue?"

Continue = MsgBox(Message, vbYesNo, ""Ready to Connect')

If Continue = vbYes Then
"Create the output file for storing the data.
Set Fso = CreateObject("Scripting.FileSystemObject')

Set File = Fso.OpenTextFile(OutFileString, 2, True)

"Establish a connection.

Set Connection = CreateObject(*'ADODB.Connection')
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Connection.Open ConnectString

"Execute a query to create a record set.
"Retrieve all accounts involved in any electrical related business.

QueryString = "Select * from Account_Account_1 where "Line of Business” =
"Electrical*""

Set RecordSet = Connection.Execute(QueryString)

"I there is any data then write a header record with column names.

1T Not RecordSet.EOF Then

First = True

For Each Field in RecordSet.Fields

"Write each field within double quotes and a tab separator between them.

IT First Then
File Write """
First = False
Else
File.Write """ & Chr(9) & """
End IFf
File_Write Field.Name
Next

File.WriteLine

End If

"Keep track of the number of records.

RecordCount = 0

Do Whille Not RecordSet.EOF

132

First = True
For Each Field in RecordSet.Fields

"Write each field within double quotes and a tab separator between them.
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If First Then

File Write """
First = False
Else
File.Write """ & Chr(9) & """
End IFf
File_Write Field.Value
Next
File.WriteLine """
RecordCount = RecordCount + 1

RecordSet.MoveNext

Loop

"Clean up local variables.
RecordSet.Close
Connection.Close

Set RecordSet = nothing
Set Connection = nothing
File.Close

Set File = nothing

Set Fso = nothing

"Notify the user of the number of records retrieved and stored.

Message = "'Successfully retrieved and stored " & RecordCount & " records in " &
OutFileString

MsgBox Message, vbOkOnly, '‘Data Retrieved"
End If

Programmers, Webmasters, and others who need to display data from the Siebel Database in a Web
page or portal find Siebel Systems’ OLE DB Provider support useful for such tasks.
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To view Siebel data using ASP

1 Create an HTML page to display a form for gathering user input with the following HTML:

134

<html>

<head>

<TITLE>Request Account Information</TITLE>

</head>

<body>

<FONT FACE="Verdana, Arial, Helvetica'>

<br><P ALIGN=left><FONT SIZE=4>Request Account Information.</FONT></P>
<HR ALIGN=center NOSHADE SIZE=4>

<form action=""test04.asp" method="POST">

<P ALIGN=left>Please enter your User 1D, password and account id to access your
account information.</P>

<TABLE CELLPADDING=4>

<TR>

<TD>User 1d:</TD>

<TD><input type="TEXT" name="Userld"></TD>

</TR>

<TR>

<TD>Password:</TD>

<TD><input type="PASSWORD" name="'Password'></TD>
</TR>

<TR>

<TD>Account 1d:</TD>

<TD><input type="TEXT" name="Accountld"><br></TD>
</TR>

</TABLE>

<br>

<input type="submit" value="Submit'>

</form>

</FONT>
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</BODY>

</html>

2 Create an Active Server Page (ASP) file that retrieves the input parameters, connects to the
Siebel OLE DB Provider and builds the output to be sent back and displayed in the browser.

Use the following HTML code:
<HTML>
<HEAD>
<TITLE>Account Information</TITLE>
</HEAD>
<BODY>
<FONT FACE="Verdana, Arial, Helvetica" SI1ZE=2>
<I-- Display the time the request was processed -->
Your request has been processed at
<%Response.Write time%>.<br><br>
<I-- Get the form input data -->
<%
Userld = Request._Form("Userld™)
Password = Request.Form(*'Password')
Accountld = Request.Form(*'Accountld™)
"Connect to Siebel and retrieve the account information as an OLE DB Rowset.

Set Connection = Server.CreateObject(""ADODB.Connection™)

ConnectString = "Provider=SiebelOLEDB.Provider.1l;User 1d=" + Userld +
"";Password=" + Password + '';Data Source=siebel://MyGateway/MyEnterprise/
MyObjMgr/MyServer ;"'

Connection.Open ConnectString

IT Len(Accountld) = O Then

Query = "Select * from Account"
Else

Query = "Select * from Account where Id = *" + Accountld + """
End IF

Set RecordSet = Connection.Execute(Query)
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IT Not RecordSet.EOF Then
%>
This is your current account information.
<br><br>
<l-- Build a table to display the data -->
<TABLE CELLPADDING=4>
<!-- BEGIN column header row -->
<TR>
<%For Each Field in RecordSet.Fields%>
<TH><FONT SI1ZE=2><%Response.Write Field.Name%></FONT></TH>
<WNexth>
</TR>
<%Do While Not RecordSet.EOF%>
<TR>
<%For Each Field in RecordSet.Fields%>
<TD><FONT SI1ZE=2><%Response._Write Field.Value%></FONT></TD>
<WNexth>
</TR>
<%
RecordSet.MoveNext
Loop
%>
</TABLE>
<
End If
' Clean up variables.
RecordSet.Close
Connection.Close
Set RecordSet = nothing

Set Connection = nothing
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%>

</FONT>
</BODY>
</HTML>

The form created by the HTML page prompts the user for input, as shown in Figure 2.

#} Request Account Information - Microsoft Internet Explorer =100
J File Edit “iew Favorites Tools Help |

J 4mEack ~ = - @ ﬁ ‘ @Search @Favnrltes @Hlstory | %v é E - @ g El

JL\nks & Jnddressl ;1 Test4. htm) j @an

Request Account Information.

Please enter your user id, password and account id to access your account information.

User Id: |
Password: |
Account Id: |

Submit

El
‘@ Done ’_ ’_| My Computer &

Figure 2. Sample HTML User Input Page

The output is shown in Figure 3.

2} Account Information - Microsoft Internet Explorer

J Flle Edit Wisw Favorites Tools  Help |J-"\ddTBSS &) http:jjdbrownel{Cortent ftesto4, asp 'l PGo ‘
J GBack - = - (D ) ‘ {Qsearch  [GFavorites  {#History ||%. = -

Your request has been processed at 5:48:56 PM.

This is your current account information,

Main Fax Main Phone

Id Industry Line of Business Location Number Number Name

10- single-family housing Single-farmily SL-FIMDLAY - (419% 427- .

9LBZM  construction housing construc 001033070 o055 4 B C Construction

10- nonresidential MNonresidential SL-ORLANDO- (407) 523-  Advance Quality

aLB3D construction construction, n o01047419 2439 Construct

10- sporting goods & bicycle Sporting goods and  SL-CHATTANOOGA- (423} 892-

GLBKW  shops bicycle sho 001042253 7774 &ll smeriean arms

10- SL-Kreuzebra-

SLBUD carpentry work Carpentry work, nsk 219501146 Bernward Kruse N
&1 pone [ [ [&E Local intranet v

Figure 3. Sample HTML Output
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Troubleshooting OLE DB

This section describes common connection problems when using OLE DB. Consult the Windows Event
Log to view the details on other OLE DB and Siebel OLE DB Provider errors.

Error
Initialization of the data source failed with following error:

Check the database server or contact your database administrator. Make sure the external database
is available, and then try the operation again. If you see this message again, create a new data
source to connect to the database.

Cause
You have selected an invalid .cfg file in your Connection string or the .cfg file you have selected has
not been updated to support OLE DB.

Sample Problem Code

QueryType=0LEDB

Version=1

Connection=Provider=SiebelOLEDB.Provider.1;Persist Security Info;Data
Source="c:\siebel\client\bin\enu\uagnet.cfg,ServerDataSrc";
CommandType=Default

CommandText= select * from LabRowset

Solution
Check to make sure you have set the Security Info parameter in your connection string.

Error
The query did not run or the database table could not be opened and you received the following error:

Check the database server or contact your database administrator. Make sure the external database
is available and has not been moved or reorganized, then try the operation again.

Cause
The database name in your .cfg file is not set correctly or the name of the table in your query is
incorrect.

Sample Problem Code

QueryType=0LEDB

Version=1

Connection=Provider=Siebel OLEDB Provider.1l;Persist Security Info=True;Data
Source="c:\siebel\client\bin\enu\siebel .cfg,ServerDataSrc";
CommandType=Default

CommandText= select * from LabRowset
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Resolution

Check to make sure that the Provider parameter is set correctly and also that the table used for
the CommandText is a valid table.

Error

SQL Query Analyzer error message. The following error is generated in the SQL Query Analyzer when
the Object Manager on the Server is not initialized:

Server: Msg 7399, Level 16, State 1, Line 1
OLE DB provider "SiebelOLEDB.Provider.1" reported an error. Provider caused a server
fault in an external process.

Cause
This error typically occurs when Object Manager is not initialized or may be related to SQL Server
caching of the OLEDB datasource or to the servers not being successfully restarted.

Sample Problem Code
n/a

Resolution
Restart the servers.

Error
Test connection failed because of an error in initializing provider. 0x80040e73

Cause
Failure to set the DataSource property in the [Siebel] section correctly generates this error when
testing the connection. You also get an entry in Windows Event Log regarding this failure.

Sample Problem Code
n/a

Resolution

Check your connection in the Siebel.UDL file and test it by providing the correct username and
password. Also in the .cfg file, make sure the DataSource property in the [Siebel] section is set to
the correct data source—for example, set to Sample for Sample database.

Problem
Receiving “Could not process object select * from GPTest2” error message
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Description
If you did not make the custom OLE DB available to the Siebel Server Object Manager, you see the
following error when you run the query:

Server: Msg 7357, Level 16, State 2, Line 1. Could not process object "select * from
GPTest2"

Sample Problem Code
n/a

Solution
Make sure that you have copied the latest .srf to the Server\objects directory and have restarted
the server. These actions make the custom OLE DB available to the Siebel Server Object Manager.

Problem

Provider "SiebelOLEDB.Provider.1 supplied inconsistent metadata for a column. Metadata
information was changed at execution time"

Description
The length of the columns in the two applications does not match.

Sample Problem Code
n/a

Solution
When SQL Server reports inconsistent metadata, the user can modify the field length in the rowset
definition in Siebel Tools.

Problem
Unable to query SODP using MSSQL Query Analyzer

Description

When a connection is established with one type of connection string and then another connection is
attempted with a different type of connection string, it fails on the second connection attempt, and
generates the following error message:

Error message with MSSQL: OLE DB provider "siebelOLEDB.Provider.1"reported an error.
Provider caused a server fault in an external process.

Sample Problem Code
n/a
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Solution
Restart the MS SQL Server.
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This chapter discusses the Microsoft BizTalk Server and includes the following topics:
“About Microsoft BizTalk Server” on page 143

“Siebel BizTalk Interface Architecture” on page 145

“Preparing to Use the Siebel BizTalk Adapter” on page 148

“Connecting to BizTalk Using EAl MSMQ Transport” on page 154

“Connecting to BizTalk Using COM and AIC” on page 162

“Connecting to BizTalk Using HTTP” on page 176

About Microsoft BizTalk Server

Siebel Business Applications provide technology for data integration between Siebel applications and
Microsoft BizTalk Server. This allows diverse external and internal applications to communicate with
Siebel applications using proven transports, regardless of the original data format. This section
discusses the Siebel BizTalk Server interface, presenting details on architecture and related
components, including transports and message formats.

Microsoft BizTalk Server provides a translation gateway that can read and write XML, positional or
delimited flat files, and both formats of Electronic Data Exchange (EDI): United Nations/Electronic
Data Interchange for Administration, Commerce and Transport (EDIFACT) and ANSI X12. BizTalk
Server provides a resource for the secure and reliable delivery and transformation of business
documents regardless of source, data format, or communication protocol in use.

Siebel BizTalk Server Adapter

With Siebel Business Applications support for Microsoft BizTalk Server, you can share Siebel data with
external and internal contemporary and legacy systems by generating and exchanging XML
documents through BizTalk Server, without having to create a custom solution or write custom code.
This allows for interaction between business processes within a single organization, partners in e-
commerce communities, and automated procurement arrangements. The Siebel interface for BizTalk
Server provides the following features and functionality.

B Generation and Transformation of XML Documents. To convert your schema into a trading
partner’s schema (and their schema to yours) using Microsoft’s BizTalk Mapper GUI tool. BizTalk
Mapper generates W3C-standard Extensible Stylesheet Language Transformation-based maps to
perform the translation between trading partners’ schema. This allows you to create and edit DTD
schema and XDR and convert them to a partner's schema format.
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B XML Support. To simplify B2B and internal systems data exchange, document exchanges made
through the Siebel BizTalk interface are in W3C-standard XML. Document transformation is in
W3C-standard XSLT.

XML messages are the key substrate of application integration. Siebel applications can exchange
XML messages with other application systems through Microsoft’s BizTalk Server over standard
protocols and transports. The interface between Siebel applications and BizTalk Server supports
both the Siebel application as the message sender and the Siebel application as the message
receiver.

The Siebel BizTalk interface provides a comprehensive mechanism for interacting with Siebel APIs
in order to both get (extract) and put (insert or update) information. On an outbound request
from the Siebel client, the Siebel application converts the external interface object into XML and
sends it to its destination. On an inbound transaction from an external system, the Siebel
application receives an XML message, which is then validated against the appropriate Siebel
integration object.

NOTE: For more information on Siebel applications and XML, see the XML Reference: Siebel
Enterprise Application Integration guide.

B  Support for Multiple Transports and Protocols. To allow for different options when sending
and receiving data through BizTalk Server. The Siebel BizTalk adapter supports Hypertext
Transfer Protocol (HTTP), Microsoft Message Queuing (MSMQ), Application Integration
Component (AIC), Component Object Model (COM), and File.

Where to Get More Information

Table 23 shows other sources of information on associated technologies.

Table 23. Other Information Sources

EAIl HTTP Transport Chapter 7, “EAl HTTP Transport” in this book
eScripts Using Siebel Tools
ActiveX Using Siebel Tools

Microsoft BizTalk Server (BTS) Microsoft BizTalk Server documentation. (Available with BizTalk
or download from http://www.microsoft.com.)

Siebel Installation Siebel Installation Guide for the operating system you are using

Siebel Integration Objects Integration Platform Technologies: Siebel Enterprise Application
Integration

Siebel Workflow Siebel Business Process Designer Administration Guide

XML (Siebel-specific) XML Reference: Siebel Enterprise Application Integration
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Siebel BizTalk Interface Architecture

Communication between Siebel applications and Microsoft’s BizTalk Server is based on the Siebel
Enterprise Application Integration (Siebel EAIl) framework. The BizTalk Server provides the
technology for application integration and data transformation. As illustrated in Figure 4, when you
use Microsoft’s BizTalk Server to exchange documents, the Siebel application constructs an XML
document that is sent to BizTalk for data transformation and subsequently sent on to your trading
partners. Your trading partners then communicate back to you in a similar manner.

Siebel eAl
— ERP
BizTalk Server Connector
®ML Cornverter 'E
(]
- Partner
Integrstion = ﬁ v
Ohiects = SIS
i ¥ Transport %
- BizTalk Server
Business Services
EAl Ziebel Legacy
Adapter i Systems
[N
b 4

Businezz Ziehel
Ohjects Databaze

Figure 4. Siebel BizTalk Interface Architecture

As shown in Figure 4, interfacing between a Siebel application and BizTalk Server is a three-step
process:

1 First, expose any Siebel integration object to BizTalk Server using the Schema Generator Wizard
in Siebel Tools.

2 Next, import the schema into BizTalk to create document specifications.

Finally, exchange integration messages over any O/S, using the appropriate choice from the
supported transports, using BizTalk Server for mapping and message transfer.

Schema Generation Support

Siebel Tools provides the functionality to generate schema in the Document Type Definition (DTD)
format and Microsoft’s XML-Data Reduced (XDR) format. You import the generated schema into
BizTalk for further processing. Here is what is involved:
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Schema Wizard. You use the Schema Generator Wizard in Siebel Tools to generate DTD or XDR
Siebel integration objects. The exposed integration objects are imported into BizTalk and stored on
WebDAYV as BizTalk document specifications.

Data Mapping. The document specifications created in BizTalk are used to map between the Siebel-
published schema and partner applications’ schema using the Microsoft GUI tool, BizTalk Mapper.
Maps are stored on WebDAV in XSLT format.

Exchanging Integration Messages

Siebel’s BizTalk interface supports the following message formats and transport protocols:

Message Data Format. Both inbound and outbound messages use XML. BizTalk Server performs
any data translation, if required, using XSLT.

Transport Protocol. Siebel applications and Microsoft BizTalk Server exchange inbound and
outbound messages using the following transports:

B For Heterogeneous environments, the Siebel application and BizTalk communicate using:
m  File (read and write)
m HTTP (Hypertext Transfer Protocol)
B For Windows-only environments, the Siebel application and BizTalk communicate using:
m COM (Component Object Model)
AIC (Application Integration Component)

|

m  File (read and write)

m  HTTP (Hypertext Transfer Protocol)
|

Message Queuing (MSMQ)

Inbound and Outbound Interfacing
As the receiver, the Siebel application can receive inbound messages using MSMQ, File, Siebel’s AIC

component, or HTTP.

As the sender, the Siebel application sends outbound XML documents by means of MSMQ, File, HTTP,
or the BizTalk Server COM Interchange Interface.

Figure 5 illustrates the inbound and outbound processes.

BizTal k Third Party

SISES Server Application

Interface

BizT alk Server

Supportad Protocol Supportad Protocol

Figure 5. Siebel Application and BizTalk Inbound and Outbound Interfacing
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B Asynchronous Messaging. The Siebel client sends an outbound message without waiting for
an acknowledgment. It is free to process other events.

B Synchronous Messaging. The Siebel client sends an outbound message and expects a reply
within a given timeframe. After the return message has been received, the Siebel application
resumes processing of any events that were waiting to proceed.

Understanding Siebel BizTalk Server Adapter Through
Scenarios

Siebel BizTalk adapter allows administrating, managing, and executing document exchange with
various applications, without programming. There are many business scenarios where BizTalk Server
can be used to integrate a Siebel application with other applications—including another Siebel
application implementation—both internally and externally from an organization. In this
communication process, you configure a Siebel application to be the sender, the receiver, or both.
For example, if IBM’s WebSphere Commerce Suite (WCS) sends information to a Siebel application
to generate an order, the request will be in the form of an XML document that the Siebel application
can understand because BizTalk Server acts as a communications bridge by mapping the data
appropriately for both systems.

Suppose your partner needs to get an order to you. They initially send it as an ANSI X12 EDI
document using WCS to BizTalk Server. BizTalk takes this XML document and converts it into an XML
document for a Siebel application and sends it over HTTPS to the Siebel application. After the
document has been accepted by the Siebel application, a workflow is triggered that processes the
order and sends a response as an XML document back to BizTalk. There, BizTalk remaps the
document from XML to EDI and ships it off to WCS, which, upon receiving it, performs the necessary
actions.

In another scenario, say you need to get the same set information to a number of different trading
partners. In order to accomplish such a Siebel application-to-multiple applications connection, you
would first create a Distribution List using BizTalk Server's Management Desk. This allows a single
document to be sent to multiple recipients, with personalized processing for each recipient. Each
recipient can have its own channel, which defines recipient specific business rules, format, and
transport protocols.

Here is how this would work. The Siebel application submits an XML document to BizTalk Server over
HTTPS. BizTalk sends the business document to multiple recipients by invoking the channel
associated with the distribution list. BizTalk server then uses the properties of each of the messaging
ports within that distribution list to send the message to the destinations over the protocol specified
in the corresponding ports.

There are also times when two Siebel applications need to exchange data. Because no external
system is involved, typically no data transformation is required. Typically, this might be used for
distributing information from a central repository to other global systems for exchanging of sales
opportunities.
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The first Siebel application sends a message to the second Siebel application to pass along sales
opportunities. A new opportunity is created in the first Siebel application and is assigned to a partner.
This new opportunity is sent using Siebel EAI to the second Siebel application. The second Siebel
application receives the message and adds the new opportunity. Finally, the Product Catalog is
updated in real time. The product information is added or changed on the Siebel application and the
changed product information would then be sent to the Siebel application.

In one last scenario, the Siebel application sends an order in XML format to the IT group’s BizTalk
Server over the HTTP protocol (or by calling BizTalk Server Interchange COM interface). The IT
group’s BizTalk Server sends the order to SAP by first converting the XML order into an SAP IDOC
and sending it by means of HTTP (or any other protocol as defined in BizTalk Port specifications) to
SAP. SAP creates the order in SAP R/3 and sends back an Order Status in IDOC format to the IT
group’s BizTalk Server. The IT group’s BizTalk Server converts the SAP IDOC into an XML Order Status
document and the BizTalk Server sends the document by means of HTTP or AIC to the Siebel
application, where the corresponding order is updated with the new order status.

Preparing to Use the Siebel BizTalk
Adapter

This section explains how to set up and configure your servers for Siebel Business Applications to
communicate with BizTalk. Use the setup here as a guideline, but your setup should reflect decisions
for using BizTalk that were made at your organization.

Also, this section explains how to use integration objects with BizTalk so that you can communicate
bidirectionally (send and receive messages) with your trading partners. A key step is to create the
schema for the integration objects you will be using. Much of the actual communication, however,
happens outside of Siebel applications, through the various BizTalk applications.

If you need specific information on how to use the applications that are included in Microsoft’s BizTalk
Server—which include BizTalk Mapper, BizTalk Editor, BizTalk Messaging Manager, and others—refer
to the BizTalk Server documentation and help system. (The help system for BizTalk is also available
from Microsoft’s Web site.)
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Installing Software and Creating BizTalk Doc Specs for Siebel
Integration Objects

Use the following checklist as a guideline to install software and create BizTalk doc specification for
Siebel integration objects.

Checklist

a Set up BizTalk Server and each Siebel client that will be
communicating with BizTalk (a one-time operation).

For details, see “Installing and Configuring Software for Servers and
Clients” on page 149.

a Generate the DTD or XDR schema for the integration objects you want
to use and import them to BizTalk Server, where they become BizTalk
document specifications, BizTalk’s proprietary XDR hybrid format (one
time for each integration object).

For details, see “Siebel Integration Objects” on page 150 and “About
Siebel Data Types Mappings in BizTalk” on page 153.

Installing and Configuring Software for Servers and
Clients

Before you can establish a relationship with your trading partners though BizTalk, or set up an
application-to-application connection, you need to set up and configure servers and clients.

You should have multiple-machine configuration—Siebel Server, BizTalk Server, and Siebel clients.
However, your setup may be different and your configuration may vary from the suggested setup.

The components required for BizTalk integration are installed when you install Siebel EAl Connectors
(as part of a Custom Installation). The default configuration is the Siebel Database and Siebel
Gateway installed on the Siebel Server machine. Your deployment, however, might have a different
configuration.

CAUTION: The Siebel BizTalk interface files are not installed automatically when you do a Typical or
Compact installation. You must install BizTalk files as a Custom installation by selecting Custom
Installation, then EAI Connectors, and then the Siebel Connector for Microsoft BizTalk Server option.

NOTE: For the Siebel Server in a UNIX environment, you must install the EAl Connectors again
separately in a Microsoft Windows environment. There is no UNIX version of BizTalk Server. One
possibility is to install on the same machine with the BizTalk Server. Note that the EAl Connectors
installation is not shipped on the UNIX CD, only on the Windows CD. For information on the supported
UNIX and Windows platforms, see System Requirements and Supported Platforms on Siebel
SupportWeb.
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Install on your
preferred platform:

Microsoft BizTalk
Server 2000 and 2002
requirements:

Microsoft
Windows NT or
Windows 2000

1 Microsoft
Windows NT, 1 BizTalk Server B Microsoft
Windows 2000 1 Microsoft Windows Internet
Server, or Explorer

2000 Server, or

Windows 2000 Windows 2000 B Siebel Mobile

Advanced Server

Advanced Server Web Client
0 .
- UNIX.OS' AlX or 1 Windows 2000 B Siebel Tools
Solaris
. 1 SQL Server or SQL
B Microsoft Internet Server 2000

Information Server
. 1 Microsoft Visio
W Siebel Server 2000

®  Siebel Web Engine 1 Microsoft Internet

(SWE) Explorer
B Siebel Gateway Name

Server
B SQL Server (Siebel

DB)

M Siebel EAIl Transports

Siebel Integration Objects

Before you can exchange documents with any of your trading partners or with any other application
using BizTalk Server, you need to expose the appropriate Siebel integration objects to BizTalk; this
is done by creating integration object schema which you then import into BizTalk.

Siebel integration objects are published using the Schema Generator Wizard—a component of Siebel
Tools. You need to create a new document definition using the Schema Wizard to expose any of the
Siebel integration object formats for use with BizTalk.

NOTE: For instructions on how to create and modify Siebel integration objects, see the Integration
Platform Technologies: Siebel Enterprise Application Integration guide.
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You export either DTD or XDR schema. These exported files are imported into BizTalk where they are
converted into document specifications. BizTalk Server adds BizTalk-specific XML tags that convert
the standard XDR format to BizTalk’s document specification format. Figure 6 depicts how the Siebel
integration objects are exposed to BizTalk Server.

Siebel eal
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Objscts Generatar Expert Ineq ration
o Fil Object
Irnport 1o
BzTalk
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i

Figure 6. Exposing Siebel Integration Objects to BizTalk Server

Document specifications are stored in the WebDAYV BizTalk Repository and are available to any client
that can connect to WebDAYV. You can retrieve stored document specifications from WebDAV and
create maps to perform data transformations from within BizTalk Mapper. BizTalk maps, which are
XSLT (Extensible Stylesheet Language)-based, are also stored in WebDAV.

NOTE: To use the Siebel BizTalk Server interface, you need to have integration objects defined for
each trading partner. You can either use existing integration objects for this purpose, or you can
create new ones depending upon your business requirements.

Exposing Integration Objects to BizTalk

Use the following checklist as a guideline for how to expose integration objects to BizTalk.

Checklist

a Generate an DTD or XDR schema for each integration object you want to expose to BizTalk
(repeat for each integration object you need).

For details, see “To generate a new DTD or XDR schema” on page 152.

a Import the generated schema for the integration object into BizTalk Server, where they are
converted to document specifications.

For details, see “To import schema into BizTalk Server to save it as a BizTalk document
specification” on page 153.
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To generate a new DTD or XDR schema
1 Start Siebel Tools.

2 Select Integration Object in the Objects Explorer window as shown in the following figure.
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H-w] Web Template
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3 Select the integration object that you want to expose and click the Generate Schema button at
the top of the window as shown in the following figure.

Synchranize | Generate Schema —|7 Click the

Generate
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|| SAPIDOC Wizard - Get IDOC List [BF SAP Design SAP BAPT Output IDOCT! DUtton after
L SAP IDOC Wizard - Get 100OC Metada SAP Design SAP BAPT Input EDI_IDv you Select
|__li SAP IDOC Wizard - Get IDOC Metada SAP Design SAP BAPT Output EDI_IDv
|| SAPIDOC Wfizard - Get IDOC Segrer SAP Design SAP BAPT Input EDI_SE the
|| 5AP IDOC Wizsrd - Get IDOC Segmer SAP Design SAP BAPT Output EDI_SE integration
SAP IDOC Wizard - Get 1D0OC Segmer SAP Design SAP BAPT Input EDI_SE -
: SAP IDOC Wizsrd - Get IDOC Segmer SAP Design SAP BAPT Output EDI_SE ObJeCt
|| SAPIDOC Wfizard - Get IDOC Struct SAP Design SAP BAPT Input IDOCT
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|| SAPIDOC Wfizard - Get RFC Table En SAP Design SAP BAPI Input TABLE_
|| SAPIDOC Wizard - Get RFC Table En SAP Design SAP BAPT Output TRELE_
|| 5aP 1DOC Wizard - Get Record Struct SAP Design SAP BAPT Input DOC F
|| SAPIDOC Wizard - Get Record Struct SAP Design SAP BAPT Output IDOC F
|| SAPRFC - Execute ABAP (BAPI Inpu SAP Design SAP BAPT Input RFC_AE
|| SAPRFC - Execute ABAP (BAPI Outp SAP Design SAP BAPT Output RFC_AE
L] sap iiizards - Get Field Info (BAPI In SAP Design SAP BAPI Input DDIF_F
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|| SAP Wizards - Get Field Info (BART On SAP Design SAP BAPT Output DODIF F
JRERH Sample Account EAI Test Siebel Business Object Accoun
| &= Sample Account LTV EAI Test Siebel Business Object Accoun
| Sample Contact EAI Test Siebel Business Object Contact
|| sample Emplayes EAI Test Siebel Business Object Employ
[> [Sample Order : EAI Test Siahel Business Object Crder £
|| sample Quote

EAI Test Siebel Business Obiject Quote
L Select an integration object; here
“SampleOrder” is selected
The Generate Schema Wizard appears.
4 Perform the following in the Generate Schema Wizard:
a  Select EAl XML XDR Generator from the Business Service drop-down list.

b  Select EAI Siebel Message Envelope Service from the Envelope drop-down list.
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Cc Browse to a file location and type a file name to generate the schema, for example,
ListOfSiebelOrder.xml, and click Save.

5 Click Finish to complete the process.

A file (for example, ListOfSiebelOrder.xml.) has now been created in the file location you
specified.

6 Copy the newly generated schema from the Siebel client machine to the BizTalk Server machine.

To import schema into BizTalk Server to save it as a BizTalk document specification
Open the BizTalk Server Schema Editor on the BizTalk Server machine.

Choose Tools = Import.

Select XDR Schema and click OK.

A W N PR

Browse to the location where you stored the XDR Schema and click Open.

The columns of the integration object display in the BizTalk Server Editor, samples of which are
shown in the next figure.
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5 Choose File > Store to WebDav.
6 Give the file a name (such as Siebel Orders).
7 Click Save.

NOTE: The XDR schema is now saved in the BizTalk Documentation Specification format on
WebDav.

About Siebel Data Types Mappings in BizTalk
Standard Siebel applications come with predefined data types, which are mapped to XDR-specific
data types.
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Table 24 presents data types for the Siebel Field object type and the current corresponding mapping
to XDR data types.

Table 24. Siebel Data Type Mappings in BizTalk

DTYPE_TEXT string
DTYPE_BOOL char (1)
DTYPE_CURRENCY number
DTYPE_DATE string
DTYPE_DATETIME string
DTYPE_TIME string
DTYPE_ID string
DTYPE_INTEGER int
DTYPE_NOTE string
DTYPE_NUMBER number
DTYPE_PHONE number

Connecting to BizTalk Using EAlI MSMQ
Transport

This section describes how to set up and use the EAl MSMQ Transport to send and receive messages
to and from the BizTalk Server.

The BizTalk Server Adapter uses the EAl MSMQ Transport to exchange messages with the BizTalk
Server over MSMQ. See Chapter 4, “EAl MSMQ Transport,” for specific details about that transport.

The following sections show examples of how MSMQ can be used with BizTalk.

Using EAl MSMQ Transport for Outbound Messaging

This section describes how to use the Siebel BizTalk interface to send an XML document to BizTalk
Server using the EAl MSMQ Transport.

Checklist

a Set up the EAl MSMQ Transport and set up queue to send messages.

For details, see “Configuring EAl MSMQ Transport for Various Send and Receive Scenarios” on
page 32.
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a Set up the organization, port, and channel (collectively known as BizTalk configuration
objects) for use with the EAl MSMQ Transport.

For details, see “Setting Up an MSMQ Queue for Sending Messages.”

a Create the workflow to process outbound documents from Siebel applications using EAI
MSMQ Transport.

For details, see “Sending Outbound Messages with EAl MSMQ Transport” on page 34.

Setting Up an MSMQ Queue for Sending Messages

Set up an MSMQ transactional queue to receive messages from the Siebel application. You should
name the queue an easy-to-identify name, such as fromSiebel. For details, see Chapter 4, “EAl MSMQ
Transport” and the Microsoft MSMQ documentation.

To set up BizTalk configuration objects for MSMQ Outbound
1 On the BizTalk Server machine, access the BizTalk Messaging Manager.

2 Set up your home organization as Siebel and set up applications for the home organization.
NOTE: For each BizTalk-specific step, see Microsoft BizTalk Server documentation for the details.

3 Create a new organization and name it appropriately. For example, if your trading partner is
Oracle, enter Oracle.

4 Create a document definition for the previously created document specification from WebDAV
and name it, for example, Siebel Order. See To import schema into BizTalk Server to save it as a
BizTalk document specification on page 153.

5 Create a messaging port to your trading partner.
a In the Destination Organization window, select an organization, such as Oracle.
b Click Browse under Primary Transport.
C Select the appropriate transport for your trading partner.
d Complete the remaining pages as needed and click Finish to complete.
6 Create a new channel for the port created Step 5.
a  Create a new channel From an Application such as, Siebel To Oracle Channel.
b Click Next.
Select the appropriate inbound document definition, such as Siebel Order.

d Select the appropriate outbound document definition for your trading partner, such as Oracle
Order.

e Select an appropriate map, if necessary.

T Complete other pages as required and select Finish to complete.
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7 Create a Message Queuing Receive Function in the BizTalk Server Administration (for example,
Siebel MSMQ Receive) to specify the queue (for example, fromSiebel) that the receive function
polls. This queue is the same queue that Siebel uses to send the message using EAl MSMQ
Transport.

To create the Siebel workflow for MSMQ Outbound
1 From the Site Map choose Administration - Business Process > Workflow Processes.

2 Create a new workflow process as shown below to send a message to BizTalk.

EAI MSKC
Convett to | Transport |
Start et Order WL (Send Order Encl
to BizTalk)

NOTE: For information on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

3  Set up the process properties for your workflow as follows:

Name Data Type Value

OrderMessage Hierarchy -

<Value> String -

Object Id String record # for an order

4 Set up the first step after Start to use the EAI Siebel Adapter with the Query method to query
the order from Siebel Database, using the following input and output arguments:

Property Process

Input Arguments Type Value Name Property Type
Output Integration Literal Sample Order - -

Object Name

Object Id Process Property - Object Id String
Property Name Type Value Output Argument

OrderMessage Output Argument - Siebel Message
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5 Set up the second step to use the EAlI XML Converter with the Integration Object Hierarchy to
XML Document method and the following input and output arguments to convert the order object
to an XML document:

Property Data

Input Arguments Type Value Property Name Type

XML Character Encoding Literal UTF-16 - -

Siebel Message Process - Order Message Hierarchy
Property

Property Name Type Value Output Argument

<Value> Output Argument - XML Document

6 Set up the last step to use EAlI MSMQ Transport with the Send method and the following input

arguments:
Process
Property Property

Input Arguments Name Type
MsmqgPhysicalQueueName Literal private$\name of - -

the queue
MsmqgQueueMachineName Literal Machine Name - -

that owns the

MSMQ queue
LargeMessageSupport Literal False - -
Message Text Process - <Value> String

Property

NOTE: XML documents must be sent in UTF-16 format for BizTalk Server to parse. In order for
message queuing to work properly with BizTalk, you should disable large message support as
shown above.

7 Save your workflow process and test it using Workflow Simulator.

NOTE: For details on setting up and using Siebel EAl MSMQ Transport, see Chapter 4, “EAl MSMQ
Transport.”
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Using EAlI MSMQ Transport for Inbound Messages

This section describes how to use the Siebel BizTalk interface to receive an XML document from
BizTalk Server sent over MSMQ Transport.

Checklist

a Set up Siebel EAlI MSMQ Transport and set up queue to receive messages, if you have not
already done so.

For details, see “Configuring EAl MSMQ Transport for Various Send and Receive Scenarios” on
page 32.

a Set up the organization, port, and channel (collectively known as BizTalk configuration
objects) for use with MSMQ Transport.

For details, see “Setting Up an MSMQ Queue for Receiving Messages.”

Q Create the workflow to process inbound documents from Siebel using MSMQ transport.

For details, see “Receiving Messages from MSMQ” on page 41.

Setting Up an MSMQ Queue for Receiving Messages

Set up an MSMQ transactional queue to receive messages from the Siebel application. You should
name the queue an easy-to-identify name, such as toSiebel. See Chapter 4, “EAl MSMQ Transport”
and the Microsoft MSMQ documentation for details.

To set up BizTalk configuration objects for MSMQ Inbound
1 On the BizTalk Server machine, access the BizTalk Messaging Manager.

2 Set up your home organization as Siebel and set up applications for the home organization.
NOTE: For each BizTalk-specific step, see Microsoft BizTalk Server documentation for the details.

3 Create a new organization and name it as is appropriate. For example, if your trading partner is
Oracle, enter Oracle.

4 Create a document definition for previously created document specification from WebDAV and
name it, for example, Siebel Order. See To import schema into BizTalk Server to save it as a BizTalk
document specification on page 153.

5 Set up a new BizTalk Server port to send the document to the Siebel application (for example,
Siebel Sales) with the Primary Transport of Message Queuing.

a Using BizTalk Messaging Manager, create a new port named Siebel MSMQ BTS.
b Specify the primary transport type to be Message Queuing.

c  Specify the address to point to the queue on which you will be sending the message to, such as
DIRECT=0S: machine\ToSiebel. Refer to the BizTalk documentation for queue supported format
names.

d Save your work.
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6 Create a new channel for the port created in Step 5.

a

b

f

Create a new channel “From an Organization” such as Oracle To Siebel MSMQ Channel.Click
Next.

Select the appropriate inbound document definition, such as Oracle Order.

Select the appropriate outbound document definition for your trading partner, such as Siebel
Order.

Select an appropriate map, if necessary.

If required, configure the Advanced properties in the final Channel Configuration page to provide
authentication information.

Complete other pages as required and select Finish to complete.

7 Configure a File Receive Function from BizTalk Server Administration to poll a file location and
deliver to the channel configured in Step 6.

NOTE: This example uses File transport to receive documents from trading partners for the sake
of illustration. In your actual business situations, a trading partner can deliver messages to a
Siebel application over any supported transport.

a

b

d

Open BizTalk Server Administration, expand Microsoft BizTalk Server, and expand the server
group to which you want to add the File receive function.

Select Receive Functions.

Choose Action > New > File Receive Function and provide the information.

2 Name. The name of the File receive function, such as Oracle to Siebel MSMQ.
1 Comment. Add a brief description (optional).

1 Server. Server on which the receive function runs.

1 Polling Location. Enter c:\MSMQ.

NOTE: This is the location where your trading partner delivers the XML documents for the
Siebel applications so the channel can pick it up from there and send it to Siebel application
for processing.

1 File Types To Poll For. Type the extension of the files that BizTalk Server receives. In
this case, type *.xml.

Click the Advanced tab and enter a Channel Name, such as Oracle to Siebel MSMQ Channel.

8 Click OK to finish.

To create the Siebel workflow for MSMQ Inbound
1 From the Site Map choose Administration - Business Process > Workflow Processes.
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2 Create a new workflow process as shown below to receive a message.

El Conwert
MShA0d n Transcad - SML to n Insert ar
Sl Transport 7l e Service Tl Siebel "l Update
[Recaire] heszage

NOTE: For information on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

3 Set up the process properties for your workflow as follows:

Name Data Type Value
OrderMessage Hierarchy -
<Value> String -
Object Id String -

4 Set up the first step after Start to use the EAlI MSMQ Transport business service with the Receive
method and the following input and output arguments:

Property Property

Input Arguments Type Value Name Data Type
Message Text Process - <Value> String
Property

MsmqgPhysicalQueueName Literal private$\name of - -

the queue
MsmqgQueueMachineName Literal Machine Name - -

that owns the

MSMQ queue
LargeMessageSupport Literal False - =
IgnoreCorrelationld Literal True - -
Property Name Type Value Output Argument
<Value> Output Argument - Message Text

NOTE: Large Message Support must be disabled and Ignore Correlation Id must be set to True
for Siebel applications to pick up messages from BizTalk. Correlation Id must be ignored because
BizTalk always populates the information on the sent messages. The messages with Correlation
Id are considered response messages by Siebel applications. For details on setting up and using
the Siebel EAl MSMQ Transport, see Chapter 4, “EAl MSMQ Transport.”
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5 Set up the next step to use the Transcode Service business service to convert the incoming data
to UTF-8 format.

NOTE: XML documents are sent in UTF-16 format from BizTalk Server to Siebel applications. In
order for the XML Converter to correctly process, the incoming document must be converted to
UTF-8 format through the Transcode Service.

Property Property

Input Arguments Type Value Name Data Type

Conversion Mode - EncodingToEndcoding - -

Source Encoding - UTF-16 - -

Target Encoding - UTF-8 - -

<Value> Process - - <Value>
Property

Property Name Type Value Output Argument

<Value> Output Argument <Value>

6 Set up the third step to use the EAlI XML Converter with the XML Document to Integration Object
Hierarchy method using the following input and output arguments. This step converts the XML
document to a Siebel object.

Property

Input Arguments Type Value Name Property Data Type

XML Document Process Property - <Value>

Property Name Type Output Argument

OrderMessage Output Argument - Siebel Message

7 Set up the last step to use the EAI Siebel Adapter with the Insert or Update method to update
the Siebel Database, using the following input argument.

Property
Input Arguments Type Value Property Name Data Type
Siebel Message Process Property - Siebel Message Hierarchy

8 Save your workflow process and test it using the Workflow Simulator.

NOTE: For information on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.
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Connecting to BizTalk Using COM and
AlC

This section describes how to set up and use the COM Outbound Transport to send messages to
BizTalk Server, and how to use the AIC Inbound Transport to receive messages from BizTalk.

Siebel COM Outbound Transport

This section describes how to set up and use the COM Outbound Transport to send messages to
BizTalk Server.

Setting Up the COM Outbound Transport

To use the Siebel application to send documents to BizTalk over COM, you first need to install the
BizTalk Server Interchange Application COM* package from the BizTalk machine to the Siebel client.
This is a one-time operation.

Checklist

a Complete prerequisites (for setting up BizTalk Server and Siebel clients and generating
schema from integration objects).

For details, see “Preparing to Use the Siebel BizTalk Adapter” on page 148.

a Install the Interchange Application COM+ package onto the Siebel client machine from the
BizTalk Server machine (one time operation).

For details, see “To establish a COM+ remote communication link with BizTalk” on page 162.

To establish a COM* remote communication link with BizTalk
1 On the BizTalk machine, choose Start > Programs > Administrative Tools > Component Services.

2 In the tree pane, click Component Services, expand Computers and then under Computers,
expand My Computer.

3 Expand COM+ Applications and select BizTalk Server Interchange Application.

4 Right-click and, from the pop-up menu that appears, select Export.

5 On the Welcome to COM Application Export Wizard, click Next.

6 Enter the name of the export application to be created, such as Biztalklnterchange. Use the
Browse button as needed.

7 In the Export As area, select the Application proxy radio button and click Next.

On the final page, click Finish.

You should now have two files, named as you specified in Step 6 above. One should have the
extension .MSI, and one should have the extension .cab, such as Biztalkinterchange.MSI and
BizTalkInterchange.MSl.cab.
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9 Copy these files to the Siebel client machine and then, on the Siebel client machine, run the
*.MSI file to install the remote client for BizTalk Server.

Repeat the steps above for each Siebel client that will need to communicate with BizTalk Server.

Using the COM Outbound Transport to Send Messages to BizTalk

This section explains how to use the COM outbound transport to send messages from Siebel
applications to a trading partner or external application through BizTalk Server. COM Outbound
Transport is implemented as a business service, so you could potentially use this service as you
would use any other business service, such as calling it from the Siebel Business Process Designer.

You would run the workflow as fits your needs, using any of the usual mechanisms for running
workflows in Siebel applications: Workflow Process, eScripting, and so on.

Checklist

a Set up the Siebel COM Outbound Transport.

For details, see “Setting Up the COM Outbound Transport” on page 162.

a Create configuration objects in BizTalk, by setting up new organizations, ports, and channels
(once for each trading partner).

For details, see “To set up BizTalk configuration objects” on page 164, and “COM Outbound
Transport Parameters” on page 163.

Q Create a new workflow in the Siebel application to convert data in the Siebel application and
send the data as messages to BizTalk.

For details, see “To create the Siebel workflow for COM Outbound” on page 165.

COM Outbound Transport Parameters

When defining the workflow for COM Outbound transport to BizTalk, you can optionally choose from
a number of parameters. These parameters correspond with the BizTalk Server IInterchange
Submit() and SubmitSync() parameters.
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Table 25 presents the outbound parameters.

Table 25. COM Outbound Parameters

Parameter Type Description

<Value> String The document instance submitted.

DocumentName String The name of the BizTalkDocument object associated with the
instance of the document being submitted.

SourceQualifier String The qualifier of the source organization and indicates how
the Source is to be interpreted.

Source String The value of the qualifier of the source organization.

DestinationQualifier String The qualifier of the destination organization, it indicates how
the DestinationlD parameter is to be interpreted.

DestinationlD String The value of the qualifier of the destination organization.

Channel String Contains the name of the BizTalkChannel object that is
executed for this document.

FileName String Specifies a fully qualified path that contains the document to
be submitted, rather than submitting the document directly
as a string.

Envelope String Contains the name of the envelope specification to use to

break the interchange into documents.

NOTE: For more details on these parameters, see your Microsoft BizTalk Server documentation.

To set up BizTalk configuration objects

1 On the BizTalk Server machine, access the BizTalk Messaging Manager.

NOTE: For details on each BizTalk-specific step, see the Microsoft BizTalk Server documentation

and help system.

Set up your home organization as Siebel and then set up applications for the home organization.

Create a new organization and name it appropriately, such as Oracle.

NOTE: Throughout this chapter, many steps are illustrated with the use of an example. This
example uses Oracle, but your actual business requirements dictate the name you give to the
actual destination organizations that you set up for your trading partners.

4 Create a document definition for the previously created document specification in WebDAV and
name it, such as Siebel Order. See “To import schema into BizTalk Server to save it as a BizTalk
document specification” on page 153.

5 Create a messaging port to your trading partner.

a In the Destination Organization window, select an organization, such as Oracle.
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b  Click Browse under Primary Transport.
Cc Select the appropriate transport for your trading partner.
d Complete the remaining pages as needed and click Finish to complete.
6 Create a new channel for the port created in Step 5.
a Create a new channel “From an Application” such as Siebel To Oracle Channel.Click Next.
b  Select the appropriate inbound document definition, such as Siebel Order.

C Select the appropriate outbound document definition for your trading partner, such as Oracle
Order.

d Select an appropriate map, if necessary.

e Complete other pages as required and select Finish to complete.

To create the Siebel workflow for COM Outbound
1 From the Site Map choose Administration - Business Process > Workflow Processes.

2 Create a new workflow process as shown below to send a message to BizTalk.

Send Order
Start Get Order CEER D »| toBizTalk | End
¥ML
over COM

NOTE: For information on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

3 Set up the process properties for your workflow as follows:

Name Data Type Value

OrderMessage Hierarchy -

<Value> String =

Object Id String record # for an order
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4 Set up the first step after Start to use the EAI Siebel Adapter with the Query method to query
the order from Siebel Database, using the following input and output arguments:

Property Process

Input Arguments Type Name Property Type
Output Integration Literal Sample - -
Object Name Order
Object Id Process - Object Id String

Property
Property Name Type Value Output Argument
OrderMessage Output Argument - Siebel Message

5 Set up the second step to use the EAlI XML Converter with the Integration Object Hierarchy to
XML Document method and the following input and output arguments to convert the order object
to an XML document.

Property Data

Input Arguments Type Value Property Name Type
Siebel Message Process Property - Order Message Hierarchy
Property Name Type Value Output Argument
<Value> Output Argument - XML Document
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6 Set up the last step to use the EAI BTS COM Transport with the Send or the SendReceive method
and the following input arguments.

NOTE: You may require asynchronous or synchronous communication, using Send and
SendReceive respectively, depending on your unique situation.

Input Property Property

Arguments Type Name Data Type

<Value> Process - <Value> String
Property

Channel Literal Siebel to Oracle Channel (The - -

channel you created in “To set up
BizTalk configuration objects” on
page 164.)

NOTE: Optionally, you can set any one of the other available input parameters in the pick list,
such as Destination, DocumentName, and so on. For the full list of these parameters and their
meanings, refer to Table 25 on page 164.

7 Make other modifications to your workflow as your situation requires and save the workflow.

Siebel AIC Inbound Transport

This section describes how to set up and use the AIC Inbound Transport to receive messages from
BizTalk.

Setting up the AIC Inbound Transport
AIC can be run either on the Siebel Server machine or on the BizTalk Server machine. Generally, AIC
is run on the BizTalk Server machine.

NOTE: AIC (Application Integration Components) and ActiveX Data Controls must both be installed
on the same machine, regardless of your configuration setup.

This section explains how to set up the AIC Inbound Transport on either BizTalk Server with 11S 5.0
installed or a Siebel Server machine and covers these topic areas:

B “Setting Up AIC Inbound Transport to Run Locally on BizTalk Server” on page 168

B “Setting Up the AIC Inbound Transport to Run Remotely on the Siebel Server” on page 170
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Setting Up AIC Inbound Transport to Run Locally on BizTalk Server
This section explains how to set up the required components for running the AIC Inbound Transport
on the BizTalk Server machine.

Checklist

a Install the necessary Siebel EAl ActiveX Data Controls and Siebel Application Integration
Components on the BizTalk Server machine (one-time operation).

For details, see “To install Siebel ActiveX Data Controls and AIC on the BizTalk Server machine”
on page 168.

a Register the Siebel AIC on the BizTalk Server machine (one-time operation).

For details, see “To register AIC as a COM+ Server Application on the BizTalk Server machine”
on page 168.

a Copy the required Siebel Active Server Pages (ASP) to the BizTalk Server machine.

For details, see “To configure BizTalk Server Messaging Manager with new ASP files” on
page 172.

a Make sure that the Siebel application has the capability to run workflows—BizTalk Server
sends named workflows to Siebel application expecting the Siebel application to be able to
execute them.

For details, see “To configure Siebel Server to run workflows” on page 173.

To install Siebel ActiveX Data Controls and AIC on the BizTalk Server machine

1 On the BizTalk machine, insert the Siebel Enterprise Server Installation CD and choose Custom
Install.

Deselect other options so that only the EAI Connectors are installed.

Follow online prompts to complete the remaining pages and click Finish to install the Siebel EAI
ActiveX Data Controls for BizTalk on the BizTalk Server machine.

To register AIC as a COM+ Server Application on the BizTalk Server machine

From the Start menu, select Programs > Administrative Tools > Component Services.

In the tree pane, click Component Services, and expand Computers. Under Computers, expand
My Computer, and then click on COM+ Applications.

3 On the Action menu, click New > Application.
4 On the Welcome to COM+ Application Install Wizard dialog box, click Next.
5 On the next page, select Create an Empty Application.

B Enter the name for the new application to be created, such as Siebel BizTalk Interface for AIC
Transport or Siebel BizTalk HTTP Adapter for the HTTP Inbound Transport.Select the
Activation Type of “Server application” and click Next.
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6 On the next screen, select the Application Identity of “Interactive user - the current logged on
user” and click Next and then Finish.

You should now have a new COM* application (which you named in Step 5), as shown in the
following sample figure.

window  Help |_|5’|£||
wlle 2 Em>xEE2 DR E

COM+ Applications 4 object(s)

nent Services

Tputers COM+ QT COM+ Utilities iSiebel BizTalk: System
My Computer Dead Let. . {.Adapter [ Application
423 COM+ applications
-- COM+ QT Dead Letter Queue Listener Here iS the
- COM+ Ltilities +
-- Siebel BizTalk Adapter COM. .
- System Application appll_catlon
[l Distributed Transaction Coordinator you just
fiewer (Local) created.

s (Local)

[
7 Expand this newly created COM* Server Application by double-clicking on it.
You see folders appear where the COM™* applications were.
8 Click the Components folder and choose Action > New > Component.
The Welcome to COM Component Install Wizard appears.
9 On the Welcome to COM Component Install Wizard, click Next.
a  Select Install new component or components and click Next.
b On the next page, click Add.

C Browse to the SIEBSRVR _ROOT\eaiconn\bts\aic directory and select the AIC component,
sscaeiba.dll.

You should see BizTalk.SiebelBizTalkAIC component registered and you should be able to see
the AIC interfaces and methods.

Or, for the HTTP Inbound Transport, browse to the c:\AIC directory (the directory where you
originally copied your .dll from the Siebel Server machine) and select the AIC component,
sscaeibh.dll.

You should see the Siebel.BizTalkHTTPAIC component registered and you should be able to
see the AIC interfaces and methods.

NOTE: COM+ application functionality is available only with Windows 2000.
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Setting Up the AIC Inbound Transport to Run Remotely on the Siebel
Server

This section explains how to set up the required components for running the AIC Inbound Transport
remotely on the Siebel Server machine.

Checklist

Q

Copy required BizTalk Dynamic Link Library (DLL) and Type Library (TLB) files from the
BizTalk Server to the Siebel Server.

For details, see “To copy BizTalk Server DLL and Type Library files to the Siebel Server” on
page 170.

Register the Siebel BizTalk AIC as a COM+ Server Application on the Siebel Server machine.

For details, see “To register AIC as a COM+ package remote communication” on page 171.

Create a COM+ communications link between the Siebel machine and the BizTalk Server
machine.

For details, see “To create a COM+ package remote communication on the Siebel machine” on
page 171.

Copy the required Siebel Active Server Pages (ASP) to the BizTalk Server machine.

For details, see “To configure BizTalk Server Messaging Manager with new ASP files” on
page 172.

Make sure that the Siebel application has the capability to run workflows—BizTalk Server
sends named workflows to Siebel application expecting the Siebel application to be able to
execute them.For details, see “To configure Siebel Server to run workflows” on page 173.

To

copy BizTalk Server DLL and Type Library files to the Siebel Server

Copy dependency shared DLLs stored in “%Program Files%\Common Files\Microsoft
Shared\Enterprise Servers\Commerce” from BizTalk (Commerce server shared DLL) to the Siebel
Server machine:

pipecomlib.tlb
pipecompps.dll
mscsresource.dll

mscscore.dll

2 Open a DOS command prompt window. On the Siebel Server machine:

170

Register the DLLs.
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m Register the type library by using the regsvr32 and regtlb utilities, respectively, as shown in
the following illustration.

- :
[\ WINNT, System32 co Enter the commands

one at a time, as
shown, and press
Enter. As each file is
registered, additional
information displays
in the DOS window.

C=Jregsvrd? pipecompps.dll
C=>regsvrl? mscsresource.dll
C=>regsvrd? mscscore.dll
C=>regtlh pipeconplib_tlb

NOTE: The regtlb utility ships with BizTalk Server and is available in the Microsoft BizTalk
Server\Setup directory.

To register AIC as a COM+ package remote communication
B Register AIC as a COM+ Server Application on the Siebel Server machine.

The steps to register AIC are the same as described above in the previous section, “To register
AIC as a COM+ Server Application on the BizTalk Server machine” on page 168.

NOTE: Siebel AIC (Application Integration Components) and ADC (ActiveX Data Controls) are
installed as a part of the Siebel Server or the EAl Connectors installation.

To create a COM+ package remote communication on the Siebel machine
Here you create a COM+ package for the remote communication on the Siebel machine and run on
the BizTalk Server machine as Application Proxy.

1 On the Siebel machine, go to the Start menu. Select Programs > Administrative Tools >
Component Services.
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00

In the tree pane, click Component Services, and expand Computers. Under Computers, expand
My Computer, and then expand COM+ Applications. Click Siebel BizTalk Adapter (the COM+
Application you created previously—you may have given it a different name). A sample tree pane
is shown in the following illustration.

Tree I

[ Console Rook
E@ Cormponent Services
= Computers
E@ My Computer
=L COM+ Applications
-- ZOM+ QC Dead Lekker Queue Liskener
-4 COM+ Utilities
Fp Eta  Highlight the COM+
%% System Application application you
[ Distributed Transaction Coordinator created previously.
[]--% Event Viewer (Local)

[+ 5y Services (Local)

On the Action menu, click Export.

On the Welcome to COM Application Export Wizard dialog, click Next.

Enter the name of the export installation package to be created.

In the Export As area, select the Application proxy radio button and click Next.
Click Next to finish the wizard. You should see a Thank you page. Click Finish.

You should now have two files, named as you specified in Step 5. The files will have two
extensions: .MSI and .cab.

Copy these files to the BizTalk Server machine.

Run the .MSI file to install the remote client for the Siebel AIC that is on the BizTalk Server
machine.

To configure BizTalk Server Messaging Manager with new ASP files

Copy the BizTalk_SiebelBizTalkAIC_1_post.asp page and the BizTalk_SiebelBizTalkAIC_1.asp
page,

from Siebel Machine:
SIEBSRVR_ROOT\eaiconn\bts\scripts
to BizTalk Machine:

BizTalk installation directory\NMessagingManager\pipeline
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To configure Siebel Server to run workflows

B  AppObjMgr_Lang is the Application Object Manager to which AIC connects through ADC to run
workflows on Siebel Server. Therefore, make sure that the Siebel Server Workflow component
group and the appropriate Siebel application AppObjMgr_Lang (for example, SCCObjMgr_enu,
for Siebel Call Center) components are installed and correctly configured.

The Siebel Application Integration Components receive documents from BizTalk Server and deliver
them to the Siebel workflow specified in the BizTalk Server channel configuration.

AIC also invokes the Siebel Workflow Engine to run the workflow on either the Siebel client or the
Siebel Server using ActiveX Data Controls.

NOTE: For details on enabling server components and connecting to the Application Object Manager
using ADC, see the Siebel Installation Guide for the operating system you are using and the Using
Siebel Tools guide.

Using the AIC Inbound Transport to Receive Messages from BizTalk
This section explains how to receive messages from BizTalk using the AIC Inbound transport.

NOTE: Microsoft BizTalk Server must be installed. In addition, the appropriate Siebel application

AppObjMgr_Lang (for example, SCCObjMgr_enu) component, Siebel Workflow, and Siebel Enterprise
Application Integration (EAl) must be enabled before following the procedure below. For more
information, see the Siebel Installation Guide for the operating system you are using.

Checklist

a Set up the Siebel AIC Inbound Transport.

For details, see “Setting up the AIC Inbound Transport” on page 167.

a Create the workflow to process inbound documents from BizTalk using AlC.

For details, see “To create a workflow to receive inbound XML documents over AIC from BizTalk”
on page 173.

a After you have created the workflow, you need to supply the workflow information to the
Siebel AIC Inbound transport—a pipeline component for BizTalk.

For details, see “To supply the workflow information for AIC Inbound” on page 175.

For AIC inbound connections, you define a workflow to process the inbound documents passed by
the BizTalk Server using the Siebel Application Integration Component (AIC). This workflow performs
the necessary steps to process the document, depending on the business requirements. For example,
it could read the document, perform conversions, update the database, call other business services
(such as the Siebel Adapter), and so on. This process gives you immense flexibility in the way an
inbound XML document is processed.

To create a workflow to receive inbound XML documents over AIC from BizTalk

1 From the Site Map choose Administration - Business Process > Workflow Processes.
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2 Set up the workflow process, as shown below, to receive and process XML document from AIC
and give it a name, such as Write XML Doc.

NOTE: For details on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

Start Convert to _ Write to
Property Set o [ratabaze

a  Create the following two new process properties for your workflow:

Name Data Type Default String
InputBizdoc String <Value>
SiebelMessage Hierarchy -

NOTE: AIC passes the XML Document received from BizTalk Server to the process property
with Default String set to <Value>. The same process property could be used to retrieve and
process the XML document. For example, write this process property to a file or update the
Siebel Database by calling EAIl Siebel Adapter.

b Convert to the property set using the EAl XML Converter with the XML Document to Integration
Object Hierarchy method and the following input and output arguments:

Input Argument Type Value Property
MessageText Process Property - InputBizdoc
Property Name Type Output Argument
SiebelMessage Output Argument Siebel Message

C  Write to the database using the EAI Siebel Adapter with the Upsert method and the following
input argument:

Name Type Property

Siebel Message Process Property Siebel Message

After you create the workflow, the workflow information must be supplied to the Siebel Application
Integration Component (see Step 1 in the “To supply the workflow information for AIC Inbound”
procedure). The Siebel AIC, which is a pipeline component, is implemented as a special kind of COM
object that the BizTalk Server state engine calls to deliver data to an application. Therefore, you need
to configure a BizTalk Server port and channel in BizTalk to include use of this Siebel AIC pipeline
component for application integration.
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After you have specified AIC as the primary transport for document interchange with Siebel
information, you need to supply BizTalk with configuration data specific to Siebel AIC. You do so by
creating a new channel (see Step 2 on page 175). For details, see Microsoft BizTalk Server
documentation.

This data is passed to the Siebel AIC component through the BizTalk Management Desk. One of the
configuration items that is passed to the Siebel AIC component is the name of the workflow you
defined within the Siebel application. AIC dynamically invokes the Siebel Workflow engine and passes
the XML document to the workflow specified in the channel AIC properties.

After Siebel AIC is implemented, the property sheet contains the properties specific to the Siebel AIC
implementation, one of which is Siebel Workflow Name.

You can optionally create maps using BizTalk Mapper if data transformation is required for the
documents received by Siebel application from the external application. For information on the
mapping capabilities of BizTalk, see Microsoft BizTalk Server online documentation.

To supply the workflow information for AIC Inbound
1 Run the BizTalk Server Messaging Manager on the BizTalk Server machine.

a Set up a Home Organization for Siebel applications, such as Siebel Sales.
b  Set up a Siebel Trading Partner to be the Destination Organization, such as Oracle.

C Create new document specification for the XDR document definition stored in WebDav.

d Set up a new BizTalk Server port to send the document to the Siebel application with the
Primary Transport of Application Integration Component—BizTalk SiebelBizTalkAlIC.Using
BizTalk Messaging Manager, create a new port named Siebel AIC BTS.

e Specify the primary transport type to be Application Integration Component.

T Specify the Component Name to be the AIC component name, BizTalk.ApplntegrationSiebel.

g Save your work.

BizTalk is now configured to deliver messages to Siebel BizTalk AIC.
2 Set up a new channel for the port created in Step d.
a  Configure the Advanced properties in the final Channel Configuration page.

b Provide the Siebel Workflow name to be invoked as previously defined in Step 2 of “To create a
workflow to receive inbound XML documents over AIC from BizTalk” on page 173.
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C Enter the user name, password, and connect string for the Active X Data Control to connect to
Siebel Server. For example:

host="siebel .tcpip.none.none://SiebelServer:2321/EnterpriseServer/
SCCObjMgr_enu” lang="ENU"

Where:
SiebelServer = the machine name where the Siebel Server is installed.

lang = the language of the Siebel Server. The default lang is ENU, but for other languages
you have to provide this value. Also note that the quotes shown in the example are required.

CAUTION: Make sure the connect string you type is using the correct format, including the
use of quotes. The correct connect string format is very important in order for ADC to
correctly connect to Siebel Server.

3 Configure a File Receive Function from BizTalk Server Administration to poll a file location and
deliver to the channel configured in Step 2.

NOTE: This example uses File Transport to receive documents from trading partners for the sake
of illustration. In your actual business situations, a trading partner can deliver messages to a
Siebel application over any supported transport.

a  Open BizTalk Server Administration, expand Microsoft BizTalk Server, and expand the server
group to which you want to add the File receive function.

b Select Receive Functions.
C Choose Action > New > File Receive Function and provide the information.
1 Name. The name of the File receive function, such as Oracle to Siebel AlC.
1 Comment. Add a brief description (optional).
1 Server. Server on which the receive function run.
1 Polling Location. Enter c:\AIC.

NOTE: This is the location where you copy the XML Instance you created earlier. The channel
can then pick it up from there and send it to the Siebel application.

1 File Types To Poll For. Type the extension of the files that BizTalk Server receives. In
this case, type *.xml.

d Click the Advanced tab and enter a Channel Name, such as AIC Oracle To Siebel Channel.

4 Click OK to finish.

Connecting to BizTalk Using HTTP

This section describes how to set up and use the HTTP Outbound Transport to send messages to
BizTalk Server and how to use HTTP to receive messages from BizTalk. Topics covered include:

B Siebel HTTP Outbound Transport

B How to Use EAI HTTP Transport to Receive Documents from BizTalk on page 181
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Siebel HTTP Outbound Transport

BizTalk Server uses the Microsoft Internet Information Server (11S) and Active Server Pages (ASP)
to receive documents over HTTP. The ASP file uses BizTalk Interchange Submit( ) and SubmitSync(
) methods to send documents to BizTalk Server.

Checklist

Q HTTP Outbound Transport requires a virtual directory. This directory needs to reside on the
11S to which Siebel outbound XML documents will be sent. Typically, this is on the same
machine as BizTalk Server.

For details, see “To create a virtual directory for HTTP Outbound” on page 177.

a Copy the sample ASP file to the virtual directory. You can modify the Active Server Page to
meet your business requirements. This section provides you with a sample ASP file to serve
as a general guideline.

For details, see “To copy the ASP files to the new HTTP Outbound directory” on page 177.

To create a virtual directory for HTTP Outbound
1 Create a new directory for the ASP file.

The directory should be on the Web Server where you would be sending your outbound XML
documents from the Siebel application. This is usually the BizTalk machine.

2 Create a new virtual directory on IS using the new directory you created. Name the directory,
for example, BizTalkReceive.

NOTE: The virtual directory can be on either the Siebel Server or the BizTalk Server. If the Internet
Information Server is on the Siebel Server machine, you need to register the BizTalk Server
Interchange Application to the Siebel Server. If I11S is on the BizTalk Server, you do not need to
register Interchange application, because it is already a part of the BizTalk Server installation. See
your Microsoft Internet Information Server (11S) documentation for details on setting up virtual
directories.

To copy the ASP files to the new HTTP Outbound directory
B Copy the ASP file SiebelBizTalkOutHTTP.asp from:

SIEBSRVR_ROOT\eaiconn\BTS\SCRIPTS
to the new directory you just created, for example:

c:\BizTalkReceive\
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Sending Messages to BizTalk Using the Siebel HTTP Outbound
Transport

This section explains how to use the Siebel BizTalk interface to send an XML document to BizTalk
Server over HTTP Outbound transport.

Checklist

a Set up the Siebel HTTP Outbound Transport.

For details, see “Siebel HTTP Outbound Transport” on page 177.

a Set up the organization, port, and channel (collectively known as BizTalk configuration
objects) for use with the HTTP Outbound Transport.

For details, see “To set up BizTalk configuration objects for HTTP Outbound,” below.

a Create the workflow to process outbound documents from Siebel using EAlI HTTP Transport.

For details, see “To create the Siebel workflow for HTTP Outbound” on page 179.

To set up BizTalk configuration objects for HTTP Outbound
1 On the BizTalk Server machine, access the BizTalk Messaging Manager.

2 Set up your home organization as Siebel and set up applications for the home organization.
NOTE: For each BizTalk-specific step, see Microsoft BizTalk Server documentation for the details.

3 Create a new organization and name it as is appropriate. For example, if your trading partner is
Oracle, enter Oracle.

4 Create a document definition for previously-created document specification from WebDAV and
name it, for example, Siebel Order. See “To import schema into BizTalk Server to save it as a BizTalk
document specification” on page 153.

5 Create a messaging port to your trading partner.

a  In the Destination Organization window select the organization, such as Oracle. Click Browse
under Primary Transport.

b  Select the appropriate transport for your trading partner.
c Complete the remaining pages as needed and click Finish to complete.
6 Create a new channel for the port created in Step 5.
Create a new channel “From an Application” such as Siebel To Oracle Channel.
Click Next.
Select the appropriate inbound document definition, such as Siebel Order.
Select appropriate outbound document definition for your trading partner, such as Oracle Order.

Select an appropriate map, if necessary.

- 0©0 O O T 9

Complete other pages as required and select Finish to complete.
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7 Modify SiebelBizTalkOutHTTP.asp to specify the Channel name you configured in Step 6.
a Search for sChannel in the file.
b Remove the comment designator from this statement:

sChannel = Channel Name you just created

To create the Siebel workflow for HTTP Outbound
1 From the Site Map choose Administration - Business Process > Workflow Processes.

2 Create a new workflow process as shown below to send a message to BizTalk.

Convert to Send Order to
e Gt Qrder T BizT alk
(HTTPPCST)

NOTE: For information on creating workflow processes, see the Siebel Business Process Designer
Administration Guide.

;

3 Set up the process properties for your workflow as follows:

Name Data Type Value

OrderMessage Hierarchy -

<Value> String =

Object Id String record # for an order

4 Set up the first step after Start to use the EAI Siebel Adapter with the Query method to query
the order from Siebel Database, using the following input and output arguments:

Property Process

Input Arguments Type Value Name Property Type
Output Integration Literal Sample Order - -

Object Name

Object Id Process Property - Object Id String
Property Name Type Value Output Argument

OrderMessage Output Argument - Siebel Message
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5 Set up the second step to use the EAlI XML Converter with the Integration Object Hierarchy to
XML Document method and the following input and output arguments to convert the order object

to XML document:

Input Arguments Type Value Property Name Property Data Type
Siebel Message Process - Order Message Hierarchy
Property
Property Name Type Value Output Argument
<Value> Output Argument - XML Document

Set up the last step to use the EAI HTTP Transport with the Sen
the following input arguments.

d or the SendReceive method and

Input Property Property

Arguments Type Value Name Data Type

Message Text Process - <Value> String
Property

Request Method Literal POST - -

Request URL Literal The URL to which the document - -

Template

will be posted—for example,

http://WebServer/virtual

directory name/

SiebelBizTalkOutHTTP.asp

where:

WebServer is the name of y
Web server and virtual

our

directory name is the virtual
directory you set up in “To create

a virtual directory for HTTP

Outbound” on page 177, such as

BizTalkReceive.

NOTE: You may require asynchronous or synchronous communication, using Send and

SendReceive respectively, depending on your unique situation

7/ Save your workflow process and test it using the Workflow Simulator.
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How to Use EAI HTTP Transport to Receive Documents
from BizTalk

This section describes how to set up and use EAl HTTP Transport for receiving documents from
BizTalk over HTTP.

NOTE: BizTalk Siebel HTTP Inbound Transport has been redesigned and implemented as an HTTP-
based Application Integration Component (AIC) for the Siebel 7.5 release. This new HTTP-based AIC
combines the functionality of the 7.0.x ASP application and the HTTP COM utility.

There are two high-level steps to this procedure:

B Configuring Siebel Server
B Setting Up HTTP-Based AIC to Run on BizTalk Server

Configuring Siebel Server

You need to set up EAI HTTP Transport for inbound processing in order to receive documents from
BizTalk over HTTP. There are three tasks involved with configuring the Siebel Server for Inbound
HTTP communication with BizTalk. These three steps include:

B Enabling the EAl Component group on the Siebel Server
B Setting up Siebel EAI
B Setting up the Siebel Web Engine

For details on each of these steps, see Chapter 7, “EAl HTTP Transport.”

Setting Up HTTP-Based AIC to Run on BizTalk Server

This section explains how to set up the required components for running the HTTP-based AIC
Inbound Transport on the BizTalk Server machine. Although the AIC can run either on the Siebel
Server machine or on the BizTalk Server machine, it is recommended that you run the AIC on the
BizTalk Server machine locally for ease of configuration. If you would like to run the AIC on the Siebel
Server, see “Setting Up the AIC Inbound Transport to Run Remotely on the Siebel Server” on page 170.

NOTE: The HTTP-based AIC does not require ActiveX Data Controls.

Checklist

a Copy the HTTP-based AIC Dynamic Link Library (DLL) from the Siebel Server machine to the
BizTalk Server machine.

For details, see “To copy HTTP-based AIC DLL from Siebel Server to BizTalk Server Machine.”
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a Register the Siebel AIC on the BizTalk Server machine (one-time operation).

For details, see “To register AIC as a COM+ Server Application on the BizTalk Server machine.”

a Copy the required Siebel HTTP AIC Active Server Pages (ASP) to the BizTalk Server machine.

For details, see “To copy the required Siebel HTTP AIC Active Server Pages (ASP) to the BizTalk
Server machine” on page 182.

To copy HTTP-based AIC DLL from Siebel Server to BizTalk Server Machine
B Copy the sscaeibh.dll file from SIEBSRVR_ROOT\eaiconn\bts\http\ on the Siebel Server to a
newly created directory, such as c¢:\AIC on the BizTalk Machine.

To copy the required Siebel HTTP AIC Active Server Pages (ASP) to the BizTalk
Server machine

B Copy the Siebel_BizTalkHTTPAIC_1_post.asp page and the Siebel_Biz TalkHTTPAIC_1.asp
page from Siebel Machine:

SIEBSRVR_ROOTN\eaiconn\bts\scripts

to BizTalk Machine:

BizTalk installation director)\MessagingManager\pipeline

Receiving Messages from BizTalk Using the HTTP Inbound Transport
This section explains how you use the BizTalk interface to receive XML documents using the Siebel
HTTP Inbound transport. The activities associated with the inbound communication from BizTalk
occur in the BizTalk Messaging Manager. For information on using this BizTalk application, consult the
Microsoft BizTalk Server documentation.

Checklist
a Set up the Siebel HTTP Inbound Transport.

For details, see “How to Use EAI HTTP Transport to Receive Documents from BizTalk” on page 181.

a Set up the EAI HTTP Transport Named Subsystem and the HTTP Receive function to receive
and process incoming XML documents.

For details, see “EAl HTTP Transport Named Subsystems” on page 81.

a Set up the organization, port, and channel (collectively known as BizTalk configuration objects)
for use with the HTTP Inbound Transport.

For details, see “To set up BizTalk configuration objects for HTTP inbound” below.

To set up BizTalk configuration objects for HTTP inbound
1 Run the BizTalk Server Messaging Manager on the BizTalk Server machine.

a  Set up a Home Organization for Siebel applications, such as Siebel Sales.
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b Set up a Siebel Trading Partner to be the Destination Organization, such as Oracle.
C Create new document specification for the XDR document definition stored in WebDav.

2 Set up a new BizTalk Server port to send the document to the Siebel application with the Primary
Transport of Application Integration Component, Siebel.BizTalkHTTPAIC.

a Using BizTalk Messaging Manager, create a new port named Siebel HTTP AIC Port.

b Specify the primary transport type to be Application Integration Component.

c  Specify the Component Name to be the AIC component name, Siebel.BizTalkHTTPAIC.
d Save your work.

When you have finished setting up this port, BizTalk is configured to deliver messages to Siebel
BizTalk AIC.

3 Set up a new channel for the port created in Step d, such as Siebel HTTP AIC Channel.

After you have specified HTTP AIC as the primary transport for document interchange with Siebel
information, you need to supply BizTalk with configuration data specific to Siebel HTTP AIC. You
do so by creating a new channel. For more information on setting up ports and channels, see
Microsoft BizTalk Server documentation.

This configuration data is passed to the Siebel HTTP AIC component through the BizTalk Server.
One of the configuration items that is passed to the Siebel HTTP AIC component is the name of
the HTTP Service you defined within Siebel application. HTTP AIC dynamically invokes the HTTP
Service within the Siebel application and passes the XML document to the HTTP Service through
the Siebel Web Engine.

You can optionally create maps using BizTalk Mapper if data transformation is required for the
documents received by the Siebel application from the external application. For information on
the mapping capabilities of BizTalk, see Microsoft BizTalk Server online documentation.

a Configure the Advanced properties in the final Channel Configuration page.
b Provide the input parameters as required by the EAl HTTP Transport:

Web Server is the server where SWE is running (format is defined as webserver:Port), Source
is the new HTTP Service you previously created, and the user name and password to connect
to the Siebel Server.

4 Configure a File Receive Function from BizTalk Server Administration to poll a file location and
deliver to the channel configured in Step 2.

NOTE: This example uses File Transport to receive documents from trading partners for the sake
of illustration. In your actual business situations, a trading partner can deliver messages to a
Siebel application over any supported transport.

a  Open BizTalk Server Administration, expand Microsoft BizTalk Server, and expand the server
group to which you want to add the File receive function.

b  Select Receive Functions.
Cc Choose Action > New > File Receive Function and provide the following information.

2 Name. The name of the File receive function, such as Siebel HTTP AIC.
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1 Comment. Add a brief description (optional).
1 Server. Server on which the receive function runs.
1 Polling Location. Enter c:\http.

NOTE: This is the location where your trading partner delivers the XML documents for the
Siebel application so the channel can pick it up from there and send it to the Siebel
application for processing.

1 File Types To Poll For. Type the extension of the files that BizTalk Server receives. In
this case, type *.xml.

d Click the Advanced tab and enter a Channel Name, such as Siebel HTTP AIC Channel.
5 Click OK to finish.

NOTE: If there are any errors while sending the document to the Siebel Server, they are written
to the Application Event log with details.
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This chapter discusses the integration of Java with the Siebel Application and includes the following
topics:

B “About Siebel Applications and Java” on page 185
“About the JDB Business Service API” on page 186

B “About the Siebel Code Generator” on page 187
B “About Running the Java Data Bean” on page 195
B “About the Siebel Resource Adapter” on page 201

About Siebel Applications and Java

Many enterprises, especially those involved in eBusiness, develop Java applications to meet a variety
of business requirements. Typically, these applications combine existing enterprise information
systems with new business functions to deliver services to a broad range of users. Siebel Systems
supports integration of its business services and business objects using the Siebel Java Data Bean.
The Siebel Java Data Bean can be used for interaction with various kinds of Siebel application
objects:

B Business objects and business components.
B Business services and property sets.
B Integration objects.

In all cases, the Java code acts as client-side proxy stub to the corresponding object on the Siebel
Server. It does not implement the functionality of the object in Java.

For ease of use, the Siebel Code Generator can be used to produce Java code based on the Siebel
Java Data Bean for any specific business service or integration object. This generated code has an
API specific to the chosen business service or integration object.

Additionally, Siebel applications support the J2EE Connector Architecture with the Siebel Resource
Adapter. The Siebel Resource Adapter supports the invocation of business services.

About the JDB Business Object API

The Java Data Bean provides an API to Siebel business objects and their business components. The
API is similar in function to the API provided for other platforms, such as COM and CORBA.

Example of the Business Object and Business Component Interface
Following is a code sample demonstrating use of the business object API. The sample shows how the
Java Data Bean might be used to search for a Contact with a particular login name.
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The first step in using the Siebel Java Data Bean is to log in to the Object Manager of the Siebel
Server. The first parameter, the connection string, specifies the protocol, server name, enterprise
name, and object manager name. Once logged into the Object Manager, the methods getBusObject
and getBusComp are used to obtain business objects and their business components.

The code sample activates fields to allow the query to retrieve data for the specific fields, specifies
the search criteria, and executes the query. If the query is successful, the first and last name of the
contact are printed to the standard output.

import com.siebel.data.*;

public class ObjectiInterfaceExample {
public static void main(String[] args) throws SiebelException {
String connectString =
"siebel://mymachine:2321/siebel/SCCObjMgr_enu™;

SiebelDataBean dataBean = new SiebelDataBean();

dataBean. login(connectString, "USER"™, "PWD", "enu™);
SiebelBusObject busObject = dataBean.getBusObject(''Contact');
SiebelBusComp busComp = busObject.getBusComp(*'Contact™);

busComp.setViewMode(3);
busComp.clearToQuery();
busComp.activateField(""First Name');
busComp.activateField("'Last Name');
busComp.activateField(*'1d™);
busComp.setSearchSpec(*’'Login Name', '"thomas');
busComp.executeQuery2(true, true);

if (busComp.firstRecord()) {
System.out.printin(*Contact ID: " + busComp.getFieldvalue('1d™));
System.out._printIn("First name: " + busComp.getFieldValue("'First Name™));
System.out.printIn(*Last name: " + busComp.getFieldvValue(''Last Name'));

}

busComp.release();
busObject._release();
dataBean.logoff();

}

If the query results in multiple records, the record set can be iterated as follows:

if (busComp.firstRecord()) {
// obtain the fields/values from this record
while (busComp.nextRecord()){
// obtain the fields/values from the next record

}
}

About the JDB Business Service API

Aside from the business object and business component API, the primary point of integration with
the Siebel application is by using business services.
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There are several ways to invoke a business service. The simplest way is using the Siebel Java Data
Bean directly, as shown in the following example. Alternatively, Siebel Tools provides a Code
Generator which creates, for any business service, Java classes that invoke the business service. The
generated code may invoke the business service either using the Siebel Java Data Bean or using the
Siebel Resource Adapter. The creation and use of generated code is described in the next section.
The Siebel Resource Adapter is part of the J2EE Connector Architecture, which is described in “About
the Siebel Resource Adapter” on page 201.

Following is an example of invoking a business service directly using the Siebel Java Data Bean.

import com.siebel._data.SiebelDataBean;
import com.siebel._data.SiebelException;
import com.siebel.data.SiebelPropertySet;
import com.siebel.data.SiebelService;

public class BasicDataBeanTest {

public static void main(String[] args) throws SiebelException {
SiebelDataBean dataBean = new SiebelDataBean();

dataBean._login('siebel ://mymachine:2321/siebel/SCCObjMgr_enu™, "USER', "‘PWD",
enu'™);

SiebelService businessService = dataBean.getService("Workflow Utilities");
SiebelPropertySet input = new SiebelPropertySet();

SiebelPropertySet output = new SiebelPropertySet();

input.setValue(*'Please echo this™);

businessService. invokeMethod("'Echo™, input, output);

System.out._printIn("Output: " + output.toString());

About the Siebel Code Generator

JavaBeans for invoking a particular business service can be generated using the Siebel Code
Generator. These JavaBeans provide a uniform mechanism for interacting with the Siebel application
from a Java or J2EE application. The JavaBean for a particular business service provides facilities for
creating inputs and invoking methods. The JavaBean representing a business service can be based
on either the Siebel Java Data Bean or on the Siebel JCA Resource Adapter.

For business services whose methods have integration objects as input or output, JavaBeans
representing the integration objects must be generated separately. These beans provide facilities for
creating the integration objects and setting their fields.

The business services most commonly used for integration are EAI Siebel Adapter and various ASI
business services based on the data sync service. The methods of these business services typically
have inputs and outputs that are property sets of a special type called integration objects. Siebel
Java integration provides special support for working with integration objects.
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Invoking the Siebel Code Generator

This section describes how to invoke the Siebel Code Generator to create JavaBeans for either a
Siebel business service or a Siebel integration object.

To invoke the Siebel Code Generator
1 Start Siebel Tools.

NOTE: For information on how to use Siebel Tools consult Using Siebel Tools.
2 Select Business Service (or Integration Object) from the Types tab on the Object Explorer.

NOTE: If Integration Object is not present, add it by checking Integration Object on the Object
Explorer tab of the Development Tools Options window opened by selecting View >Options.

3 Select the desired business service (or integration object), as shown in the following illustration
for an integration object.

On the right top corner of the Integration Object list, there is a set of three buttons. The following
illustration shows the Sample Account integration object highlighted.

Synchronize Generate Schema Generate Code
Name Changed | Project Base Object Type
: EAI Test Sizbel Business Objact
Sample Account LIV EATI Tast Sizbel Business Object
Sample Contact EATI Tast Siebel Business Object
Sample Employss EATI Tast Sizbel Business Object
Sample Internal Division EAT Test Siebel Business Object
Sample Order EATI Tast Sizbel Business Object
Sample Order from Ariba EAI Demo Siebel Business Object
Sample Quote EATI Tast Sizbel Business Object

Click Generate Code.
5 Complete the Code Generator wizard:
a  Leave the business service as is (there is only one available: the Siebel Code Generator).

b Select either Java(JDB) (Java Data Bean) or Java(JCA) (J2EE Connector Architecture/Siebel
Resource Adapter) for the Supported Language.

Cc Browse to select an existing folder as the output folder. Your Java code for the selected business
services or integration objects is stored in subdirectories there, as explained next.

d  Click Finish.

The code is generated and the wizard closes, returning you to the Business Service or
Integration Object form.

Code Generated for a Business Service

The code generated for a business service includes a class representing the business service itself
as well as classes representing inputs and outputs of its methods. These classes are described in
detail in this section.
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ASI business services based on the data sync service have integration objects as part of the input or
output of their methods. The JavaBeans representing these integration objects must be generated
separately from the business service.

The classes for a given business service reside in a package in one of the following:
m com.siebel.service.jdb.business service name or
m com.siebel.service.jca.business service name

Depending on whether the beans are based on the Java Data Bean or the Siebel JCA Resource
Adapter. For example, generated JDB code for the EAI Siebel Adapter resides in the package
com.siebel.service.jdb.eaisiebeladapter.

The Code Generator creates the standard Java directory structure reflecting the package structure.
As shown in Figure 7, a subfolder named com is created in the folder specified during the generation
process. Below the com folder is a folder named siebel containing a folder named service, containing
a folder named jdb (or jca), containing a folder named for the business service. This last folder
contains the classes for the business service. Each class is defined in its own file.

{1 22eE
El{:l O ) . .
S Csebel  fery business service genorated,
EH:I sErvice The folder holds several Java files.
-] jca
#-_] jdb

Figure 7. Directory Structure Created to Contain Java Code for Business Services

One Java class is generated to represent the business service itself. The name of the class is the
name of the business service with all special characters replaced by underscores (_) and
BusServAdapter appended to the end. For example, the class representing EAIl Siebel Adapter is
EAI_Siebel_AdapterBusServAdapter.

The Java class has one method for each method of the business service. Its name is the name of the
method with m prepended. For code based on the Java Data Bean, the class is a subclass of
com.siebel.integration.adapter.SiebelJDBAdapterBase. For code based on the Siebel Resource
Adapter, the class is a subclass of com.siebel.integration.adapter.SiebelJCAAdapterBase.
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Additionally, for each method of the business service defined in Siebel Tools, one Java class is created
for the method's input and one for the method's output. The name of the class is the name of the
method with Input or Output appended. The class encapsulates all input (or output) arguments for
the method. Each argument is represented as a field whose name is that of the argument with f
prepended. For each field, public set and get methods are provided Java methods for reading and
writing their values.

For example, the business service CC XML Converter, which has two methods, PropSetToXML and
XMLToPropSet, generates the following four classes:

B CC_XML_Converter BusServiceAdapter
B  PropSetToXMLInput

B  PropSetToXMLOutput

B XMLToPropSetinput

The first class, CC_XML_Converter BusServiceAdapter, represents the business service as a whole;
it has methods mPropSetToXML and mXMLToPropSet. The other three classes represent the input or
output parameters of the two methods. (Notice there is no class XMLToPropSetOutput because that
method has no outputs.) Those three classes each have methods to read and write the individual
parameters, as well as methods to convert to and from a com.siebel.data.SiebelPropertySet.
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About Methods of Java Classes Generated for a Business
Service

Table 26, Table 27, and Table 28 describe methods that are present in the generated Java code for every
business service. Generic names (for example, GenericService, GenericMethod) are substituted for the
actual names of the business service, methods, and arguments.

Table 26. Methods of the Java Class com.siebel.service.jdb.GenericServiceBusServAdapter
Generated for an Example Business Service, GenericService, Having the Business Service
Method GenericMethod

Method Description

GenericServiceBusServAdapter() Constructor that uses the default properties
file, siebel.properties.

GenericServiceBusServAdapter(SiebelDataBean) Constructor that reuses the resources of an
existing SiebelDataBean.

GenericServiceBusServAdapter(String) Constructor taking the name of the
properties file to use.

GenericServiceBusServAdapter(String, String, Constructor taking the username,

String) password, and connect string.

GenericServiceBusServAdapter(String, String, Constructor taking the username,

String, String) password, connect string, and language.

mGenericMethod(GenericMethodlnput) Invokes the specified business service
method.

Table 27. Methods of the Java Class com.siebel.service.jdb.GenericMethodInput Generated for an
Example Business Service Method, GenericMethod

Method Description

GenericMethodInput() Constructor.

GenericMethodlnput(SiebelPropertySet) Constructor that sets its fields from the given
property set.

fromPropertySet(SiebelPropertySet) Copies fields values from the given property set.

toPropertySet() Returns a SiebelPropertySet with the properties
and values corresponding to the fields of this
object.

getfGenericArgument() Returns the value of business service method
argument.

setfGenericArgument(String) Sets the value of a business service method
argument.
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Table 28. Methods of the Java class com.siebel.service.jdb.GenericMethodOutput Generated for an
Example Business Service Method, GenericMethod

Method Description

GenericMethodOutput() Constructor.

GenericMethodOutput(SiebelPropertySet) Constructor that sets its fields from the given
property set.

fromPropertySet(SiebelPropertySet) Copies fields values from the given property set.

toPropertySet() Returns a SiebelPropertySet with the properties
and values corresponding to the fields of this
object.

getfGenericArgument () Returns the value of business service method
argument.

setfGenericArgument () Sets the value of a business service method
argument.

About the Code Generated for an Integration Object

Integration objects are special kinds of property sets that are the input and output of business
services based on the data sync service. JavaBeans based on integration objects are designed to be
used with those business services or with the EAI Siebel Adapter and may be used to query, delete,
upsert, and synchronize information in the Siebel Server's database.

The integration object, and each of its components, has its own Java class, stored in the package
com.siebel.local.Integration Object Name. The class for the integration object has 10 appended to
the end, and the class for an integration component has IC appended. The Code Generator creates
the standard Java directory structure reflecting the package structure. In the selected folder, a
subfolder named com is created, containing a subfolder siebel, containing a subfolder local, which
contains one subfolder for each integration object that was generated. The Java files are stored in
the lowest directory. This structure is shown in Figure 8.

Elg Data ()
= 12EE
ED Cam
EH:l siebel One folder is created under local for
= [ each integration object that is
D sampleaccount generated. It contains all Java files
for that integration object.
) sampleemployes

Figure 8. Directory Structure Created of Java Code Generated for Integration Objects
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For example, the integration object Sample Account; which has five components Account, Account
Attachment, Account_Organization, Business Address, and Contact; generates the following six
classes:

Sample_AcccountlO
AccountlIC
Account_AttachmentIC

Account_OrganizationIC

Business_AddressIC
ContactIC

The first class, suffixed with 10, represents the entire integration object. It has methods to construct
the object, to read and write fields, to add integration object components, and to convert to and from
a SiebelPropertySet. The other five classes, suffixed with IC, represent the individual integration
object components and provide methods that are for constructing the component to read and write
fields and to convert to and from a SiebelPropertySet.

Methods of Java Classes Generated for an Integration Object
Table 29 describes methods that are present in the generated Java code for every integration object.

Table 29. Methods of the Java Class com.siebel.local.GenericIntObjlO Generated for an Example
Integration Object, GenericlntObj

Object Description

addfintObjInst(SiebelHierarchy) Adds an integration object component object to the
integration object.

clone Returns a copy of the integration object.

equals(Object) Determines whether integration object has the
same data as the integration object passed.

fromPropertySet(SiebelPropertySet) Copies the data from the given property set to the
integration object.

getfintObjectFormat Returns a String containing the format of the
integration object.

getfIntObjectName Returns the integration object name property.

getfintObjlInst Returns a Vector representation of the integration
object.

getfMessageld Returns the Messageld property of the integration
object.

getfMessageType Returns the MessageType property of the

integration object.
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Table 29. Methods of the Java Class com.siebel.local.GenericIntObjlO Generated for an Example
Integration Object, GenericlntObj

Object Description

getfOutputintObjectName Returns the OutputintObjectName property of the
integration object.

Generic_ObjectlO() Default constructor.

Generic_ObjectlO(SiebelPropertySet ps) Creates an integration object (and its hierarchy)
based on a property set.

setfIntObjectFormat Sets the IntObjectFormat property of the
integration object.

setfIntObjectName Sets the IntObjectName property of the integration
object.

setfMessageld Sets the Messageld property of the integration
object.

setfMessageType Sets the MessageType property of the integration
object.

setfOutputintObjectName Sets the OutputintObjectName property of the

integration object.

toPropertySet Returns a SiebelPropertySet representation of the
integration object.

Methods of Java Classes Generated for an Integration Object
Component

Table 30 describes methods that are present in the generated Java code for every integration object
component.

Table 30. Methods of the Java Class com.siebel.local.GenericintComplIC Generated for an Example
Integration Object, GenericlntComp Having Child Component GenericlntCompChild and
Field GenericField

Object Component Description

addfGenericIntCompChildIC(GenericintCompChildIC) | Adds to the integration object component
the given child integration object

component.
clone Returns a copy of the integration object.
equals(Object) Determines whether the integration object

component has the same data as the
passed integration object component.
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Table 30. Methods of the Java Class com.siebel.local.GenericIntCompIC Generated for an Example
Integration Object, GenericlntComp Having Child Component GenericlntCompChild and
Field GenericField

Object Component Description

fromPropertySet(SiebelPropertySet) Populates the integration object
component based upon the contents of a

property set.

getfGenericlntCompChildIC Returns a Vector containing all child
integration object components of type
ChildIntObjComp associated with the
integration object component.

getfGenericField() Returns the value of the field GenericField.

GenericlntCompIC() Default constructor.

GenericlntComplC(SiebelPropertySet) Creates an integration object component
from a property set.

setfGenericField(val) Sets the value of the field GenericField.

toPropertySet Returns a property set representation of

the integration object component.

About Running the Java Data Bean

Two Siebel .jar files are needed to compile and run a Java application that uses the Java Data Bean:
B Siebel.jar

B Siebelll_lang.jar (lang = the installed language pack; for example, SiebelJl_enu.jar for English
or Siebelll_jpn.jar for Japanese.)

These jar files are provided with the standard Siebel installation under the directory
INSTALLED_DIR\classes.

Documentation of individual classes is provided in the form of javadoc (Siebel_JavaDoc.jar), which
is installed when installation option Siebel Java Integrator (a component of the Siebel Tools or the
Siebel Server installer) is chosen. This .jar file contains the up-to-date javadoc for the Siebel Java
Data Bean, Siebel Resource Adapter, and dependent classes.

NOTE: The Siebel Data Bean is not thread-safe: simultaneous access by different threads is not
supported. This restriction applies to all objects obtained from the same instance of SiebelDataBean.
For example, if two instances of SiebelBusObj are obtained from the same SiebelDataBean, methods
on them are not invoked simultaneously by different threads.
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Connect String and Credentials for the SiebelDataBean

When using the SiebelDataBean directly, without any generated code, three arguments must be
passed to the login method. A fourth argument, language code, is optional.

B connect string

B Siebel username

B Siebel password

B language code (default is enu)

The connect string has the following form:
siebel ://SiebelServerName: SCBPort/ EnterpriseName/ XXXObjMgr_lang

For example,
siebel://mymachine:2321/mysiebelenterprise/SCCObjMgr_enu

When using generated code, by default, these parameters are taken from the file siebel.properties,
which must be in the classpath of the JVM. These properties are read from siebel.properties at the
time an instance of the generated business service class is created using the parameterless
constructor. They may be overridden by calling the methods setConnectString, setUserName,
setPassword, and setLanguage any time prior to calling initialize() or invoking a business service
method (such as mGenericMethod in Table 26). This is the behavior when the default (parameterless)
constructor of the generated Java class is used.

Alternatively, the generated class provides the following four constructors with arguments:
B One String argument: the name of the property file to be used.
B Three String arguments: the connect string, username, and password. No properties file is used.

B Four String arguments: the connect string, username, password, and language. No properties
file is used.

B SiebelDataBean argument: the SiebelDataBean passed should already have parameters assigned
and its login method executed.

Connection Parameters for the SiebelDataBean

Regardless of how the SiebelDataBean is invoked, certain parameters of the connection may be set
using the properties file. These are siebel.conmgr.txtimeout, siebel.conmgr.poolsize,
siebel.conmgr.sesstimeout, siebel.conmgr.retry, and siebel.conmgr.jce.

Other connection parameters may also be specified in the properties file, but they are used only in
conjunction with generated code (subclasses of
com.siebel.integration.adapter.SiebelJDBAdapterBase or SiebelJCAAdapterBase).
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The following table, Table 31, gives the details of these parameters.

Table 31. Properties in the siebel.properties File

Property Description

siebel.conmgr.txtimeout The number of milliseconds to wait after sending a request to
the Siebel Server. Must be a positive integer; other values
are ignored. The default is 600000 milliseconds (10
minutes).

siebel.conmgr.poolsize For each object manager process, a pool of open connections
is maintained and shared by all users of that process. This
parameter specifies the maximum number of connections
that will be stored in the pool. Its value must be a positive
integer less than 500; other values are ignored. The default
is 2.

siebel.conmgr.sesstimeout The number of seconds the Siebel Server will wait before
disconnecting an idle client session. Its value must be a
nonnegative integer. The default is 2700 seconds (45
minutes).

siebel.conmgr.jce Determines whether encryption of transmissions is done
using Java Cryptography Extension or RSA (if the connection
uses encryption). 1 indicates JCE; O indicates RSA. The
default is 0.

siebel.conmgr.retry The number of attempts to be made at establishing a
connection (opening a session) before giving up. Must be a
positive integer. The default is 3.

siebel.conmgr.virtualhosts A listing of virtual servers representing a group of like
servers that perform the same function, for example, call
center functions.

An incoming login for the call center Virtual Server will try
servers from the list in a round-robin fashion.

An example of such a list follows:

VirtualServeri=sidl:host:port,sid2:host:port...;Virt
valServer?=. ..

where:

Virtual Servers = an assigned list of real Siebel Servers
with host names and port numbers (of the local SCB).

siebel.connection.string The Siebel connect string. For information on the syntax of
the connect string, see the Siebel Object Interfaces
Reference guide.
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Table 31. Properties in the siebel.properties File

Property Description

siebel.loglevel The level of messages to be logged. Must be a positive
integer less than 6. Other values are ignored or throw an
exception. O causes only FATAL messages to be logged; 1
ERROR; 2 WARN; 3 INFO; 4 DETAIL; 5 DEBUG. The default
is 0.

NOTE: The siebel.loglevel parameter is used only in
conjunction with the generated code for the
SiebelJCAAdapterBase subclass.

siebel.logfile The name of a file to which logging should be directed.
Strings that cause a FileNotFoundException cause an error to
be logged and are ignored. The default is to print to the JVM’s
standard output.

NOTE: The siebel.logfile parameter is used only in
conjunction with generated code for the
SiebelJCAAdapterBase subclass.

siebel.user.name The Siebel username to be used for logging in to the Siebel
Object Manager.

siebel.user.password The Siebel password to be used for logging in to the Siebel
Object Manager.

siebel.user.language The language code indicating the natural language to be used
for messages and other strings. Default is enu.

siebel.jdb.classname The name of a subclass of com.siebel.data.SiebelDataBean
to use instead of SiebelDataBean. Strings that do not specify
a valid class or specify a class that is not a subclass of
SiebelDataBean cause an error log to be logged and
SiebelDataBean to be used instead.

Here is a sample siebel.properties file:

siebel .connection.string siebel:// 172.20.94.55:2321/siebel/EAIObjMgr_enu

siebel _user.name = Userl
siebel _user.password = password
siebel .user.language = enu
siebel _user._encrypted = false
siebel .conmgr.txtimeout = 3600

siebel .conmgr.poolsize =5

siebel _.conmgr.sesstimeout = 300000
siebel _.conmgr.retry =5
siebel _.conmgr.jce =1
siebel _loglevel =0
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Examples Using Generated Code for Integration Objects

The following code uses the code generation facilities provided in Siebel Tools. For more information
see “About the Siebel Code Generator” on page 187, for both business services and integration
objects. By using the code generation facilities, many of the complexities of the Siebel property sets
and business service interfaces have been abstracted, providing a standards-based JavaBean
interface.

The following is a code sample invoking the QueryByExample method of the Siebel Account business
service. In addition to the generated code for Siebel Account (resident in
com.siebel.service.jdb.siebelaccount), the sample uses the generated code for the integration object
Sample Account (resident in com.siebel.local.sampleaccount).

The code invokes the method QueryByExample of the ASI business service SiebelAccount. The
parameter to this method is formed from an instance of the integration object SampleAccount, which
serves as the example, essentially specifying a search criterion of all Accounts that start with the
letters Ai. The output integration object is converted to a Vector and iterated through to print the
names of matching Accounts.

import com.siebel.data.SiebelDataBean;

import com.siebel._data.SiebelException;

import com.siebel.service.jdb.siebelaccount.Siebel_AccountBusServAdapter;
import com.siebel_service.jdb.siebelaccount.QueryByExamplelnput;

import com.siebel_service.jdb.siebelaccount.QueryByExampleOutput;

import com.siebel._local.sampleaccount.Sample_AccountlO;

import com.siebel.local.sampleaccount.AccountliC;

public class JDBSiebelAccount {
public static void main(String[] args) throws SiebelException {
Siebel_AccountBusServAdapter svc = new Siebel_AccountBusServAdapter (*'USER™,
"PWD","siebel ://mymachine:2321/siebel/SCCObjMgr_enu,"enu');

// Create the example-accounts starting with "Ai":
AccountlIC acctlC = new AccountIC();

Sample_AccountlO acctlO = new Sample_Accountl0(Q);
acctlO.addfintObjInst(acctlIC);

acctilC.setfName("Ai*"");

QueryByExamplelnput gbeln = new QueryByExamplelnput();
gbeln_setfSiebelMessage(acctlO);

// Call QueryByExample
QueryByExampleOutput gbeOut = svc.mQueryByExample(gbeln);

acctlO = new Sample_AccountlO(gbeOut.getfSiebelMessage() .toPropertySet());
Vector ioc = acctlO.getfintObjInst();

// print the name of each account returned:
it (Mioc.isEmpty(Q)) {
for(int i=0; i < ioc.size(); i++) {
acctlC = (AccountlIC) ioc.get(i);
System.out.println(acctiC.getfName());
¥
¥
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The following example uses the generated code for the business service EAIl Siebel Adapter. An
instance is instantiated using the constructor that takes an instance of SiebelDataBean. The
QueryPage method is called; its output is actually a SampleAccount integration object, but the object
returned is not strongly typed and instead is used to construct a SampleAccount instance. The
generated code for SampleAccount is also needed for this example.

import com.siebel._data.SiebelDataBean;

import com.siebel._data.SiebelException;

import com.siebel.local.sampleaccount.AccountlIC;

import com.siebel.local.sampleaccount.Sample_AccountlO;

import com.siebel.service.jdb.eaisiebeladapter_EAl_Siebel_AdapterBusServAdapter;
import com.siebel.service.jdb.eaisiebeladapter.QueryPagelnput;

import com.siebel._service.jdb.eaisiebeladapter.QueryPageOutput;

public class DataBeanDemo {
public static void main(String[] args) throws SiebelException {

SiebelDataBean m_dataBean = new SiebelDataBean();

String conn = "siebel://mymachine:2321/siebel/SCCObjMgr_enu™;

m_dataBean.login(conn, '"USER', "PWD'", "enu');

// Construct the EAl Siebel Adapter, using the data bean

EAl_Siebel_AdapterBusServAdapter svc =

new EAl_Siebel_AdapterBusServAdapter(m_dataBean);

svc.initialize();

try {
// Set values of the arguments to the QueryPage method.
QueryPagelnput gplnput = new QueryPagelnput();
gplnput.setfPageSize(Integer.toString(10)); // Return 10 records.
gplnput.setfOutputintObjectName(*'Sample Account™);
gplnput.setfStartRowNum(Integer.toString(0)); // Start at record O.
QueryPageOutput gpOutput = svc.mQueryPage(gplnput);

// Construct the integration object using the QueryPage output
Sample_AccountlO acctlO =
new Sample_AccountlO(gpOutput.getfSiebelMessage() .toPropertySet());

// Convert the results to a vector for processing
Vector ioc = acctlO.getfintObjInst();

// Print name of each account
ifT (Yioc.isEmpty()) {
for (int i = 0; i < ioc.size(); i++) {
AccountlIC acctlC = ((AccountlIC) ioc.get(i));
System.out.println(acctiC.getfName());
}
}
} catch (SiebelException e) {}
finally {
m_dataBean.logoff();
}
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About the Siebel Resource Adapter

The Siebel Resource Adapter is for use within the J2EE Connector Architecture (JCA) by J2EE-based
applications (EJBs, JSPs, servlets) that are deployed on containers. JCA provides clients with a
standard interface to multiple enterprise information services such as the Siebel application.

The Siebel Resource Adapter implements system-level contracts that make able a standard J2EE
application server to perform services such as pooling connections and managing security. This is
referred to as operation within a managed environment. The J2EE Connection Architecture also
provides for operation in a non-managed environment, where the client need not be deployed in a
J2EE container, but instead uses the adapter directly. In this case, the client takes responsibility for
services such as managing security.

The Siebel Resource Adapter has transaction support level NoTransaction. This means that the Siebel
Resource Adapter does not support local or JTA transactions.

Using the Resource Adapter

When deploying the Siebel Resource Adapter in J2EE Application Server (BEA WebLogic or IBM
WebSphere), the necessary Siebel JAR files are included. The Siebel JAR files that need to be added
to the classpath are:

B Siebeldl.jar

B Siebelll_lang.jar (lang = the installed language pack; for example, SiebelJl_enu.jar for English
or SiebelJl_jpn.jar for Japanese.)

The resource adapter archive, or RAR file, may also be required for deployment. Refer to the
documentation of the J2EE application server for more information on deploying a JCA adapter on
the server.

The following sections contain code samples for both managed and non-managed environments.

About the Connect String and Credentials for the Java
Connector

The Java Connector Architecture allows for credentials to be supplied using either Container-
Managed Sign-on or Application-Managed Sign-On.

With Container-Managed Sign-On, the application server's container identifies the principal and
passes it to the JCA adapter in the form of a JAAS Subject. Application servers provide their own
system of users and roles; such a user must be mapped to Siebel user and password for the purpose
of the JCA adapter. Application servers allow the specification of such mappings. With Contain-
Managed Sign-On, the Siebel connect string and language must be specified in the deployment
descriptor of the adapter (ra.xml). If a Siebel username and password are present in the descriptor,
they will be used by the application server only to create an initial connection to the Siebel
application when the application server is started, which is not necessary.
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With Application-Managed Sign-On, the client application must provide the credentials and connect
string. This is done just as for the Java Data Bean, as described in “About Running the Java Data Bean”
on page 195, by either supplying them in siebel.properties or setting them programmatically using
setUserName, setPassword, setConnecString, and setLanguage. If any of these parameters are
supplied using Application-Managed Sign-On, then all four of them should be supplied in that
manner.

NOTE: Connection parameters beginning with siebel.conmgr are read from siebel.properties,
whether the adapter is being used in managed or non-managed mode.

Managed Code Sample Using the Siebel Resource Adapter

The following is a code sample using the Siebel Resource Adapter in a managed environment. The
sample is a servlet that makes a simple invocation to a business service using the generated JCA
code. (For more information on generating code, see “About the Siebel Code Generator” on page 187.)

The JCA ConnectionFactory is obtained through JNDI. Credentials are obtained at run time from the
JAAS Subject passed to the servlet. The connect string and language are obtained from the
deployment descriptor (ra.xml). Other connection parameters are obtained from the
siebel.properties file.

import javax.naming.>;

import java.io.*;

import javax.servlet.*;

import javax.servlet_http.*;

import com.siebel.integration.jca.cci.SiebelConnectionFactory;
import com.siebel.service.jca.eaifiletransport.*;

public class ManagedConnectionServlet extends HttpServlet {

public void doGet(HttpServletRequest request, HttpServletResponse response)
throws I0Exception,ServletException {
PrintWriter reply = response.getWriter();

try {
EAI_File_TransportBusServAdapter bs = new EAIl_File_TransportBusServAdapter();
InitialContext jndi = new InitialContext();
SiebelConnectionFactory scf = (SiebelConnectionFactory)jndi.lookup(*'siebelJCA™);
bs.setConnectionFactory(scf);

// Username and password obtained from JAAS Subject passed by server at runtime.
// Connect string and language obtained from deployment descriptor, ra.xml.

Receivelnput input = new Receivelnput();
input.setfCharSetConversion(*'UTF-8");
input.setfFileName('D:\\helloWorld.txt");
ReceiveOutput output = bs.mReceive(input);

reply.printin(output.getf Value_(Q));

catch (Exception e) {
reply.printIn("Exception:" + e.getMessage());
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Non-Managed Code Sample Using the Siebel Resource Adapter

The following is a code sample using the Siebel Resource Adapter in a non-managed environment.
The sample performs the same function as the Managed sample; it is a servlet that makes a simple
invocation to a business service using the generated JCA code. (For more information on generating
code, see “About the Siebel Code Generator” on page 187.)

The JCA ConnectionFactory is created directly. The username, password, connect string, and
language are obtained from siebel.properties or set programmatically. Other connection parameters
are obtained from the siebel.properties file.

import java.io.*;

import javax.servlet._*;

import javax.servlet_http.*;

import com.siebel.integration.jca.cci.notx.SiebelNoTxConnectionFactory;
import com.siebel._service.jca.eaifiletransport.*;

public class BookshelfNonManagedConnectionSample extends HttpServilet {
public void doGet(HttpServletRequest request, HttpServletResponse response)
throws 10Exception, ServletException {
PrintWriter reply = response.getWriter();

try {
EAI_File_TransportBusServAdapter bs = new
EAI_File_TransportBusServAdapter();

bs.setConnectionFactory(new SiebelNoTxConnectionFactory());

// Credentials, connect string, and language are read from siebel.properties,
// which must be in the classpath of the servlet.

// Alternatively, these may be set here programmatically:
//bs.setUserName(*"USER™);

//bs.setPassword(*'PWD'");
//bs_setConnectString(“'siebel://mymachine:2321/siebel/SCCObjMgr_enu™);

Receivelnput input = new Receivelnput();
input._setfCharSetConversion(*'UTF-8");
input.setfFileName("'D:\\helloWorld.txt");
ReceiveOutput output = bs.mReceive(input);

reply.printin(output.getf_Value_Q));

}

catch (Exception e) {
reply.printIn("'Exception:" + e.getMessage());
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